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Introduction to System Administrator

Overview

As System Administrator—whether school administrator, technical
coordinator, or other computer knowledgeable staff member—you will be
responsible for installing, setting up, and maintaining Win School®.

This guide provides descriptions and procedures for setting up and
maintaining Win School through a school year.

This section Describes
“Working with Win School” User roles and the difference between
on page 5 running Win School multi-user and single-

user

“Setting Up the Win School
Server” on page 8

For Win School multi-user, how to set up
one or more Win School servers

“Using the Win School Shell”
on page 31

The basics of using commands in the Shell

“Setting Up Win School” on
page 36

What to consider before working with Win
School, and what to set up before anyone
uses Win School

“Preparing for a New School
Year” on page 67

Some of the tasks to perform before the
school year begins

“Starting the New School
Year” on page 82

Some of the tasks to perform during the firs
few weeks of school

“Working Through the
School Year” on page 86

Some of the tasks required at various times
during the school year

“Ending Each Term” on
page 93

The work done at the end of each term,
including how to generate report cards

“Setting Up the Next School
Year” on page 101

Preparing for the next school year by
creating database for your next year and
starting to schedule your school

“Ending the School Year” on
page 131

Preparing year end and beginning to
prepare for the next year

“Managing Year Round
Schools” on page 141

Setting up and scheduling students and
teachers for year round schools
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This section Describes

“Troubleshooting Win Common problems and their solutions
School” on page 146

System Administrator Tasks

As System Administrator, you need to install, set up, and maintain

Win School at your school. While you don’t need to know every detail of
Win School, you do need to know which key procedures are required to run
Win School through the school year.

In many cases you will have to collaborate with other staff and delegate key
responsibilities to meet the needs of your school.

Some of the important tasks you will have to complete or be aware of are:

Getting Help

Setting up Win School according to the needs of your school.

Depending on the size of your school, you might need to consult with
other staff members. For example, you might need to collaborate with
your attendance clerk about the attendance codes your school uses.

Establishing a backup policy and ensuring it is followed.

Preparing Win School for the next school year which you do in the
middle of the current school year.

Installing updates promptly when your school receives them from
Chancery Software Ltd.

As well as this guide, consult:

The Win School Getting Started Guide and module-specific guides
Release Notes
Online Help

Chancery’s Technical Support website

2 Introduction to System Administrator e System Administrator Tasks
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Other Win School Guides

Use the individual Win School Guides for detailed information about
specific tasks.

To do this Refer to this Win School Guide

Set up for the first time System Administrator Guide
School Setup Guide

Understand the overall operations of Win | Getting Started Guide

School

Enter course, teacher, student, and Details Guide

resource information

Record and view health information Details Guide
Build school and student schedules Scheduler Guide
Report Cards Guide

System Administrator Guide

Enter and track attendance Attendance Guide
Classroom Attendance Guide
eClass Attendance Guide

Track marks and generate report cards Report Cards Guide
Marks Guide
eClass Grades Guide
View student, teacher, class, scheduling, Getting Started Guide,
and other information using Query Using Query section
Create custom reports Report Manager Guide
Import and export data Scanning and ASCII Transfer
Guide
Scan data Scanning and ASCII Transfer
Guide
Prepare for next year System Administrator Guide
Generate state or provincial reports State or Province reports guide

for your state or province

Extract Win School data as DBF tables Universal Access Guide
and generate reports using third-party District Extract Guide
reporting tools

Introduction to System Administrator e Getting Help 3



Win School System Administrator

Using Release Notes

As the software evolves, Chancery periodically releases new versions of
Win School. A new version comes with Release Notes that give useful
information on new features and changes to the software.

Getting Technical Support

Chancery’s support programs are available by subscription and include the
below services.

Technical Support solves problems and answers questions when
software doesn’t produce the expected results.

Monday to Friday, 5 am to 5 pm Pacific Time
phone: 1-800-688-9939

fax: 1-800-346-0643

email: techsupp @chancery.com

website: http://support.chancery.com

Web support Chancery’s website includes a searchable
knowledge base with frequently asked questions,
tips, and troubleshooting, as well as support
forums for users to share experience and
knowledge. Web tutorials are available on an
annual subscription basis.

Software updates releases of new versions with improved functions
and software fixes. Updates are provided free of
charge for 3 months from your date of purchase
and are included in the subscription to Chancery
Support Programs.

For more information on Technical Support Programs, call Chancery
Customer Service at 1-800-999-9931 extension 130.

Providing Feedback

To improve the quality of your documentation, we would like your
comments regarding this guide. Email comments to Chancery’s User
Education department at user_docs @chancery.com.

4 Introduction to System Administrator e Getting Technical Support
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Working with Win School

Overview

Before reading this section, read the Win School Getting Started Guide, to
learn the relationship between your data and Win School modules.

This chapter has 2 sections: the first section outlines how to divide and
delegate Win School responsibilities. Establishing user responsibilities
assists you when you are setting up Win School, because modules need to
be set up with degrees of access for each user. The second section describes
the differences between running Win School multi-user or single-user.

Clarifying Win School User Responsibilities

Before you install Win School, clarify the responsibilities of the users in
your school. The table outlines different types of Win School users.

User

Duties

Modules Used

Attendance Clerk

Enters student attendance into Win
School and calculates daily
attendance codes.

o Attendance
e Query (to look up student phone numbers)

o Scanning (if your school uses a scanner)

Report Cards Clerk

Manages mark information and
generates report cards.

e Report Cards

o Scanning (if your school has a scanner)
¢ Attendance

o Details/Course Details

e Report Manager (to install and generate a
custom Marks Verification Report)

Data Entry Clerk Performs general data entry. Usually | e Details — Student, Course, and Teacher
someone who enrolls students or Details (depending on data entry)
provides general support. )

o Query (to print custom templates)

Teacher / Tracks mark data. Will usually e Marks or eClass Grades (if your school

Mentor Teacher for | forward attendance data and student uses one or the other)

eClass Grades conduct information to the user

responsible for it.

e Query

Working with Win School e Overview 5
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User

Duties

Modules Used

Principal /
Vice-Principal

Manage entire school. Principals and
vice-principals usually have an
active role in scheduling the school,
tracking student conduct, and
generating policy.

Most principals and vice-principals
have access to all Win School
modules.

o Details — Student Details (to enter student
conduct information)

e Scheduler or Report Cards (depending on
which module your school uses for
scheduling)

e Query

Counselor

Works with students to decide
programming, ensures students meet
program requirements, and monitors
student performance and conduct.

e Scheduler (if counselors adjust student
schedules or enter requests)

e Report Cards (to use student Historical and
Archive information)

o Details (if counselors enter student conduct
information)

e Query

School Nurse

Responsible for student and teacher
health issues.

e Query

o Details — Student Details (to enter
information in the Health dialog)

Master Schedule Builds Master Timetable for the e School Setup
Builder school after requests have been )
entered e Details
This task can be done by the Win * Scheduler
School administrator, principal,
vice-principal, or a teacher.
Win School System | Sets up the Win School System, e All modules

Administrator

performs routine maintenance,
troubleshoots for other Win School
users, and runs year end procedures.

e School Setup — Passwords

Running Multi-User or Single-User Win School

Your school will be running Win School single-user or multi-user with a
single server; or multi-user with multiple servers, depending on which

version was purchased.

To run Win School multi-user, you need a network with a server that any
computer running Win School can access.

For installation instructions, see your Win School Release Notes.
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Single-User

Multi-User

O—

To run Win School single-user, install Win School on the computer where
all staff perform their tasks. Both the Win School application and your data
are stored on that computer.

To set file sharing options:

1 Click the Start button, choose Settings, then choose Control Panel.
2 Double-click Network and click the Access Control tab.

3 Set file sharing options. Click OK.

We recommend password protection. If the computer is on a network, everyone
on the network can access its contents unless you use password control.

When running Win School multi-user, many people can use Win School at
the same time. If users are modifying the same data at the same time, the
last change will be the one that is saved.

You must set up either an NT server or NetWare server to run Win School
multi-user. For more information, see “Setting Up the Win School Server”
on page 8.

Some modules and operations require the exclusive use of either the Win
School database or specific records.

To start the following modules, no other module can be running:
e School Setup

e Scheduler

e Course Details

e Teacher Details

e ASCII Transfer

e Utilities

To use the following items, no other person can use them at the same time:
e In Report Manager: a specific template

e In School Setup, Query, or Report Cards: a Comments file

e In Student Details: a specific student

To perform the following tasks, no other module can be running:
e In Attendance, generating attendance totals for Report Cards

e In Report Cards, clearing or updating data from a bin for classes or
students, using Clear/Set Bin Information

If users are editing the same information in Report Cards or Scheduler, they
will see each other’s changes.
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Setting Up the Win School Server

Overview

This is for schools running the multi-user version of Win School. If you are
running Win School single-user, skip this section. This section shows you
how to set up and use Win School multi-user.

To run Win School multi-user, you need a network with a server that any
computer running Win School can access.

You can use a server running either Netware or Windows NT to host 1
Win School database.

If you are running a Windows NT server with TCP/IP, you can set up
multiple servers on the same machine, each hosting a copy of Win School.

This section Describes

“Setting Up One Win School | How to set up Windows NT to host 1

Database on an NT Server” Win School database
below
“Setting Up Multiple Win How to set up Windows NT using TCP/IP

School Databases on an NT to host multiple Win School databases
Server” on page 15

“Setting Up Win School ona | How to set up Netware to host 1
Netware Server” on page 22 Win School database

Setting Up One Win School Database on an NT Server

This section is for schools running multi-user Win School using one NT
Server.

To set up one server, you must:
ensure you meet the minimum hardware and software requirements
verify the protocols installed on your server

install your Win School NT server

know how to start, stop, and quit the NT server

a
Q
a
d  configure TCP/IP
a
1  set up Win School to use the TCP/IP network
a

check the status and configuration of what is in the Main window
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(d change the path to the Win School data directory

1 back up and maintain your Win School NT server

Meeting Single NT Server Hardware and Software Requirements

You must meet the minimum hardware and software requirements before
you can install Win School on an NT Server. Consult your most current
Release Notes or visit Chancery’s Support website at
http://support.chancery.com for this information.

Using a Dedicated NT Server

For optimal performance and troubleshooting, use the server only for
Win School.

Do not store high-traffic data or run other applications, such as a mail
server, on the Win School Server.

Verifying NT Server Protocols
You should review the protocols that are installed and configured on your

server.

To display the protocols installed on your server:

1 From the Start menu, choose Settings, then Control Panel.

2 In the Control Panel window, double-click the Network icon.

3 Click the Protocols tab.

4 Check that the protocol listed is either TCP/IP Protocol or NWLink
IPX/SPX Compatible Transport.

To ensure the SAP Agent Service is running (IPX/SPX protocol only):

1 From the Start menu, choose Settings, then Control Panel.

2 In the Control Panel window, double-click the Services icon.

3 If the SAP Agent is installed, it is listed in the Services window. Its
Status should be “Started.”

If the SAP Agent is not listed in the Services window, complete the
instructions in the following section.

Adding Protocols and Services

To add a protocol:

1 Insert the Microsoft NT Server 4.0 or higher CD in the drive.
2 From the Start menu, choose Settings, then Control Panel.

3 In the Control Panel window, double-click the Network icon.
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4 Click the Protocols tab.
5 Click Add.

6  Highlight “TCP/IP Protocol” or “IPX/SPX-compatible Protocol”
depending on which protocol you use.

7 Click OK.

TCP/IP must be configured properly. Contact your network
administrator for the correct TCP/IP configuration. Record this
information for future reference in the “Noting TCP/IP Configuration”
section on page 10.

8  Click Continue.

9  When the Settings Change dialog appears, click Yes to shut down and
restart your computer.

To add the SAP Agent (IPX/SPX protocol only):

1 Insert the Microsoft NT Server 4.0 or higher CD in the drive.
2 From the Start menu, choose Settings, then Control Panel.
3 In the Control Panel window, double-click the Network icon.
4 Click the Services tab.
5 Click Add.

6

In the Select Network Service window, highlight SAP Agent, then click
OK.

Click Continue, then click Close.

J

8 When the Settings Change dialog appears, click Yes to shut down and
restart your computer.

Noting TCP/IP Configuration

Make a note for future reference and enter the following:

IP Address

e Server IP Address:

e  Subnet Mask:

e Default Gateway (not always required):

DNS

e Host Name:

e Domain:
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DNS Services Search Order:

DNS Suffix Search Order:

WINS Address

Primary WINS Server:

Secondary WINS Server:

Win School Server

Server Address/Port:

Installing the Database on NT

You must meet the minimum hardware and software requirements before
you can install Win School on an NT Server. Consult your most current
Release Notes or visit Chancery’s Support website at
http://support.chancery.com for this information.

To install the Win School database server:

1

At the server, make sure no other programs are running and insert the
Win School CD into the drive.

If AutoPlay is turned on, click “Install the Win School Server on
Windows NT.”

If AutoPlay is not turned on, open the Ntserver folder, then the disk1
folder. Double-click Setup.exe.

In the Installation Type dialog, select the “Install a new Win School
Server for NT” radio button, then click Next.

In the Select an Icon Name dialog, rename the icon, then click Next.

In the Available Disk Space dialog, choose a drive from your available
hard drives, then click Next

In the Choose Destination Location dialog, verify the folder where your
server will be installed, then click Next.

In the Select Data Destination Folder dialog, choose a folder for your
database, then click Next.

In the Select Program Folder dialog, click Next.

In the Selecting Server Type dialog, select the “TCP/IP” radio button,
then click Next.
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10 In the Selecting a Network Port dialog, click Next to accept the default
port.

11 Follow the onscreen instructions to complete the installation.

Diskette Installation

If you want to use diskettes to install the Win School database server, use a
computer with a CD-ROM drive to copy the contents of the disk1, disk2, up
to diskn folders in the Ntserver folder onto diskettes.

Starting, Stopping, and Quitting the NT Server

Stopping the server unloads the database. Users logged on to the server
receive a message informing them that they have lost their connection to the
Database server.

Users cannot log on to the server until it is running again.

To start the Win School database server:

1 From the Start Menu, choose Programs, then Win School
Server For NT.

2 Choose Win School Server for NT again.

To stop and quit the Win School NT server (other than for daily
maintenance):

1 Tell users to log off the server.
2 From the Server menu, choose Stop.

3 From the Server menu, choose Exit.

Setting Up the TCP/IP Network

There are two setup tasks:
e configure the Win School NT server

e set up the workstations

Configuring the Win School NT Server

To configure the Win School NT Server:

1 Ifitis not already running, start the Win School NT Server.
2 From the Server menu, choose Stop.

The Main window displays the message “Win School server shutdown
complete.”

3 From the Server menu, choose Configure.
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4  Set your options using the following table, then click OK.

Field

Action

Start Time

Type a start time for daily maintenance. No one
can use Win School during this time.

Minimum Down
Time

Type a minimum down time. If using a third-
party backup, enter enough time for the backup to
complete. Recommended minimum: 2 hours.

Perform backup
automatically

If you use a third-party backup application, or if
you do not have enough disk space, deselect this
checkbox. Otherwise, select it and type a path in
Backup Directory.

Preferred Socket
(Port)

Deselect this checkbox to make the preferred port
the default number.

Tips:

e  If the port number starts with zero, the next
time you open the Configuration dialog, the
zero is replaced with a blank. Retype the zero
and delete the blank. If you do not, an error
message appears when you close the dialog.

e  Valid port numbers start at 401 hex. Numbers
000 to 400 hexadecimal are not valid.

e This port number is the only one used to
communicate with the server.

Server Name

Type the name of your server.

Transport

Select TCP/IP or IPX/SPX, depending on which
protocol you have chosen.

Setting Up Workstations

Win School defaults to use TCP/IP.

To set up workstations to use a network protocol:

1 Write down the IP address and port number, if you didn’t already in
“Noting TCP/IP Configuration” on page 10. You’ll need these numbers

for Step 5.

Otherwise, restart the Win School NT server to display the IP address
and port number. From the Help menu, choose About. The Server
Address is the IP address and port numbers combined, separated by a
colon. For example, if the server address is 10.10.02.234:8351,
“10.10.02.234” is the IP address and “8351” is the port number.

2 Ateach workstation, use a text editor to open the winschl.ini file in the
Windows directory, and find the TCPIP line.

Setting Up the Win School Server e Setting Up One Win School Database on an NT Server
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3 If you are using TCP/IP, make sure the line is TCPIP=yes
OR
If you are using IPX/SPX, make sure the line is TCPIP=no
4  Exit and save your changes.

5 Start Win School. A dialog appears asking for the IP address and port
number. Type the numbers you noted in Step 1.

6 Repeat Steps 2 to 5 at each workstation.

Using the Main Window

The Main window shows the status and configuration of your Win School

NT Server.
Field Description
Server Name: the server name you entered when setting up

Mode: Running indicates workstations can connect
to the server

Up Time: the amount of time the server has been
running

Usage: Requests/Minute shows how busy the Win
School server is

Daily Maintenance displays daily maintenance settings, as set in the
Configure dialog

Connections Workstations: number of workstations currently
connected to the server

Applications: number of open Win School Shells
and modules

Server Modules: Listener service for Health module

Messages display when the server starts and stops (helpful
when troubleshooting)

Changing the Win School Data Directory

If you want to switch databases, you must change the path to the
Win School data directory by editing the Win School NT server INI file.

To change the Win School data directory:
1 Quit the Win School NT server.

2 From the WinNT directory on the server, open the winschl.ini file.
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The file is in the Windows directory on the computer running
Win School NT server.

3 In the Win School Server section for the server you want to change,
type the correct path after DATA=.

4  Exit and save your changes.

Backing Up and Maintaining Data

After you install your Win School Server, set up your daily maintenance
schedule, directories, and memory allocation.

The Win School NT server has an automatic, nightly backup that copies all
files and directories in your Win School data directory to the Backup
Directory.

Make sure all users are logged off before the Win School NT server shuts
down for nightly maintenance.

Setting Up Multiple Win School Databases on an NT Server

This section is for schools that want to run multiple Win School databases
on the same NT server.

You must use a Windows NT server running TCP/IP.

You can install up to 4 Win School databases on 1 server.
Chancery Software does not support installation of more than 4 databases
on 1 server.

When you install multiple Win School databases, each database requires its
own set of folders, including the modules, backup, temp, and data folders.

At workstations, you can set up multiple icons each accessing a different
Win School database.

To set up multiple server, you must:

ensure you meet the minimum hardware and software requirements
verify the protocols installed on your server

install the Win School databases

configure TCP/IP

know how to start, stop, and quit the NT server

set up Win School to use the TCP/IP network

check the status and configuration of what is in the Main window

change the path to the Win School data directory

U U dJJJdJdooo

back up and maintain your Win School NT server
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Meeting Hardware and Software Requirements for Multiple Databases

You must meet the minimum hardware and software requirements before
you can install multiple Win School databases on an NT Server. Consult
your most current Release Notes or visit Chancery’s Support website at
http://support.chancery.com for this information.

Using a Dedicated NT server

For optimum performance and troubleshooting, use the server only for
Win School.

Do not store high-traffic data or run other applications, such as a mail
server, on the Win School server.

Verifying NT server Protocols

You should review the protocols that are installed and configured on your
system. Multiple Win School Databases must use TCP/IP.

To display the protocols installed on your server:

1 From the Start menu, choose Settings, then Control Panel.

2 In the Control Panel window, double-click the Network icon.
3 Click the Protocols tab.

4 Check that the protocol listed is TCP/IP Protocol.

Noting TCP/IP Configuration

Make a note for future reference and enter the following:

IP Address

e Server IP Address:

e  Subnet Mask:

e  Default Gateway (not always required):

DNS

e Host Name:

e Domain:

e DNS Services Search Order:

16 Setting Up the Win School Server ¢ Setting Up Multiple Win School Databases on an NT Server



Win School System Administrator

e  DNS Suffix Search Order:

WINS Address

e  Primary WINS Server:

e Secondary WINS Server:

Win School Servers

e  Main Server Address/Port:

e Year End Server Address/Port:

e Secondary Server Address/Port:

o  Other Server Address/Port:

Installing Multiple Databases on NT

Make sure you meet the minimum hardware and software requirements for
the number of databases you want to install. Consult your most current
Release Notes or visit Chancery’s Support website at
http://support.chancery.com for this information.

You must use TCP/IP for multiple databases.

Each Win School database requires its corresponding set of server folders,
including the modules, backup, temp, and data folders.

For each database, specify:

e the Win School database server folder name

e data folder name

e the name of the icon to access that database

e the network port number

You can choose the same name for both the data folder and the icon.
If you choose a name that already exists, Win School will replace the
Modules folder in that server.

To install Win School databases:

1 At the server, make sure no other programs are running and insert the
Win School CD into the drive.

2 If AutoPlay is turned on, click “Install the Win School Server on
Windows NT.”

If AutoPlay is not turned on, open the Ntserver folder, then the disk1
folder. Double-click Setup.exe.
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3 In the Installation Type dialog, select the “Install a new Win School
Server for NT” radio button, then click Next.

4 In the Select an Icon Name dialog, rename the icon, then click Next.

5 In the Available Disk Space dialog, choose a drive from your available
hard drives, then click Next

6 In the Choose Destination Location dialog, verify the folder where your
server will be installed, then click Next.

7 In the Select Data Destination Folder dialog, choose a folder for your
database, then click Next.

8 In the Select Program Folder dialog, click Next.

9 In the Selecting Server Type dialog, select the “TCP/IP” radio button,
then click Next.

10 In the Selecting a Network Port dialog, click Next to accept the default
port.

11 Follow the onscreen instructions to complete the installation.

12 Repeat Steps 1 to 11 to install additional databases.

Replacing a Win School NT server
Replacing a server re-installs the Modules folder in that server.

To replace a Win School NT server:

1 At the server, make sure no other programs are running and insert the
Win School CD into the drive.

2 If AutoPlay is turned on, click “Install the Win School Server on
Windows NT.”

If AutoPlay is not turned on, open the Ntserver folder, then the disk1
folder. Double-click Setup.exe.

3 Follow the onscreen instructions.

4 When asked for the IconName and Destination Folder, specify the
server icon name and folder you want to replace.

Starting, Stopping, and Quitting the NT server

Stopping the server unloads the database. Users logged on to the server
receive a message informing them that they have lost their connection to the
Database server.

Users cannot log on to the server until it is running again.
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To start a Win School NT server:

1  From the Start Menu, choose Programs, then Win School

Server For NT.

2 Choose the Win School server you want to start.

3 Repeat for each Win School server you want to start.

To stop and quit the Win School NT server (other than for daily

maintenance):

1 Tell users to log off the Win School server.

2 From the Server menu, choose Stop.

3 From the Server menu, choose Exit.

Setting Up the TCP/IP Network

There are two setup tasks:

e configure the Win School NT server

e set up the workstations

Configuring the Win School NT server

To configure the Win School NT server:

1 Ifitis not already running, start the Win School NT server.

2 From the Server menu, choose Stop.

The Main window displays the message “Win School server shutdown

complete.”

3 From the Server menu, choose Configure.

4  Set your options, using the following table, then click OK.

Field

Action

Start Time

Type a start time for daily maintenance. No one
can use Win School during this time.

Minimum Down
Time

Type a minimum down time. If using a third-
party backup, enter enough time for the backup to
complete. Recommended minimum: 2 hours.

Perform backup
automatically

If you use a third-party backup application, or if
you do not have enough disk space, deselect this
checkbox. Otherwise, select it and type a path in
Backup Directory.

Try to back up each server at a different time.
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Field Action

Preferred Socket Refer to the notes you made in “Noting TCP/IP

(Port) Configuration” on page 16.

Tips:

e  If the port number starts with zero, the next
time you open the Configuration dialog, the
zero is replaced with a blank. Retype the zero
and delete the blank. If you do not, an error
message appears when you close the dialog.

e  Valid port numbers start at 401 hex. Numbers
000 to 400 hexadecimal are not valid.

e This port number is the only one used to
communicate with the server.

Server Name Type the name of your server.

Transport Select TCP/IP.

Make sure workstations are set up to use TCP/IP.

To set up workstations to use TCP/IP:

1

Write down the IP address and port number. You’ll need these numbers
for Step 6.

Otherwise, restart the Win School NT server to display the IP address
and port number. From the Help menu, choose About. The Server
Address is the IP address and port numbers combined, separated by a
colon. For example, if the server address is 10.10.02.234:8351,
“10.10.02.234” is the IP address and “8351” is the port number.

At each workstation, use a text editor to open the winschl.ini file in the
Windows directory, and find the TCPIP line.

Make sure the line is TCPIP=yes

To change the IP address and port number, find and delete the line:
tcpserver addr socket="ip address:port number”

Exit and save your changes.

Start Win School. A dialog appears asking for the IP address and port
number. Type the numbers you noted in Step 1.

Repeat Steps 2 to 6 at each workstation.

Setting Up Workstations to Access Multiple Databases

At each workstation, you can install icons to access different Win School
databases.
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To set up workstations to use multiple databases:

1
2

Using the Main Window

Quit Win School.

Write down the IP address and port number of the server you want to
connect to. You’ll need these numbers for Step 5.

Otherwise, restart the Win School NT server to display the IP address
and port number. From the Help menu, choose About. The Server
Address is the IP address and port numbers combined, separated by a
colon. For example, if the server address is 10.10.02.234:8351,
“10.10.02.234” is the IP address and “8351” is the port number.

From the Start menu, locate the Win School program group, and choose
Set-up a Server Connection.

Type in the icon name, and follow the onscreen instructions to
complete creating the icon.

Double-click the icon you just created. A dialog appears asking for the
IP address and port number. Type the numbers you noted in Step 2.

The Main window shows the status and configuration of your Win School

NT server.
Field Description
Server Name: the server name you entered when setting up

Mode: Running indicates workstations can connect
to the server

Up Time: the amount of time the server has been
running

Usage: Requests/Minute show how busy the Win
School server is

Daily Maintenance displays daily maintenance settings, as set in the

Configure dialog

Connections Workstations: number of workstations currently

connected to the server

Applications: number of open Win School Shells
and modules

Server Modules: Listener service for Health module

Messages display when the server starts and stops (helpful

when troubleshooting)
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Changing the Win School Data Directory

The procedures in “Installing Multiple Databases on NT” on page 17, and
“Setting Up Workstations” on page 20 set up the data directories on the
server and the icons at each workstation to access each server, respectively.

If you want to access a different database, you can change the path to the
Win School data directory by editing the Win School NT server INI file.
See “Changing the Win School Data Directory” on page 14.

Backing Up and Maintaining Data

After you install the Win School databases, set up your daily maintenance
schedule, directories, and memory allocation.

The Win School NT server has an automatic, nightly backup that copies
database files in your Win School data directory to the Backup Directory.

Make sure all users are logged off before the Win School NT server shuts
down for nightly maintenance.

Setting Up Win School on a Netware Server

This section is for schools running multi-user Win School using Novell
Netware.

To set up Netware Server, you must:

(J ensure you meet the minimum hardware and software requirements
J install the required patches on your server

1 configure TCP/IP

1 set up Win School to use the TCP/IP network

(d  know how to load and unload the NLM

(d change the path to the Win School data directory

0

back up and maintain your Win School NLM

Meeting NetWare Server Hardware and Software Requirements

You must meet the minimum hardware and software requirements before
you can install the Win School NLM. Consult your most current Release
Notes or visit Chancery’s Support website at http://support.chancery.com
for this information.

Using a Dedicated Netware Server

For optimal performance and troubleshooting, use the server only for
Win School NLM.
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Do not store high-traffic data or run other applications, such as a mail
server, on the Win School Server.

Required NetWare Server Patches

Before installing and running Win School, install the most up-to-date
patches on your server.

Patches for NetWare are available from the Novell website at
http://support.novell.com or from your vendor.

For an up-to-date list of the required patches, visit Chancery’s Support
website at http://support.chancery.com.

Verifying Netware Server Protocols

You should review the protocols that are installed and configured on your
system.

To list the protocols installed on your server:
e At the server prompt, type protocols.

In order to run Win School multi-user you must have, as a minimum, 1 of
the following lines:

e  Protocol: IPX Frame type: ETHERNET_802.2 Protocol ID: EO
OR
Protocol: IP Frame type: ETHERNET _II Protocol ID: 800

With NetWare 4.1x IPX installed and configured on installation of the
Network Operating System (NOS).

Configuring TCP/IP for Netware

If a TCP/IP network is already installed, get the configuration from your
network administrator. If a TCP/IP network is not installed, you must know
how to assign IP addresses for the devices on your network.

If you have a complex network, such as one with more than 1 subnet, see
your NetWare Server documentation for more information.

Assigning the IP Address

Make a note of the IP address for future reference and enter the following:

IP Address

e Server IP Address:

e  Subnet Mask:

e Default Gateway (not always required):
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Configuring TCP/IP with NetWare 4.x

To configure your NetWare 4.x server for TCP/IP:

1
2
3

4
5

At the server prompt, type load inetcfg.
From the Internetworking Configuration menu, select Protocols.
From the Protocol Configuration menu, select TCP/IP.

In the TCP/IP Configuration window, the TCP/IP Status option is
selected.

To enable the TCP/IP Status option, press Enter and select enable.

Press Escape.

To bind TCP/IP to a network card:

1

wh B~ W

10
11

At the server prompt, type load inetcfg.

From the Internetworking Configuration menu, select bindings.
Press Insert.

From the configured protocols list, choose TCP/IP.

From the configured network cards list, select the LAN board you are
using. Its binding parameters display.

Type the IP address and Subnetwork Mask (Mask), you noted in
“Assigning the IP Address” on page 23.

Press Escape to save your changes.

Press Enter to display the configured protocol-to interface bindings.
The TCP/IP binding you just configured is highlighted.

Press Escape to exit.

Restart your server.

To ensure you have TCP/IP communications, complete the following
instructions to do a ping to your server from each workstation.

Verifying the TCP/IP Protocol

You need to verify your TCP/IP protocol is configured and functioning on
your network.

To ensure the network is communicating properly with TCP/IP:

1

At the DOS prompt, type ping xxx.xxx.xxx.xxx (thex's
represent the server IP address).

Communication with the server is functioning correctly if you see the
following:

Pinging 10.10.3.12 with 32 bytes of data:

Reply from 10.10.3.12: bytes=32 time<lOms TTL=128
Reply from 10.10.3.12: bytes=32 time<lOms TTL=128
Reply from 10.10.3.12: bytes=32 time<lOms TTL=128
Reply from 10.10.3.12: bytes=32 time<lOms TTL=128
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In this example, 10.10.3.12 is the device the ping is sent to; however,
your server address should appear instead.

If you do not see the above lines, your network is not communicating
properly with TCP/IP or the IP address was incorrectly entered.

For example, you do not have communication with the server if you
see:

Pinging 10.10.3.1 with 32 bytes of data:

Request timed out.

Request timed out.

Request timed out.

Request timed out.

Have your Network Administrator verify that the settings are correct. If
TCP/IP communications is not functioning correctly, your server will
not run.

Installing the Win School NLM

After you have configured your Win School NLM, you are ready to install
at each workstation.

To create an installation diskette:

1
2

At a workstation, insert the Installation CD.

If your CD-ROM drive has AutoPlay turned on, quit the AutoPlay
Installation program.

In Windows Explorer, open the NWServer folder.

Copy the contents (2 items) of the NWServer folder to a diskette. Label
the diskette “Win School NetWare Server” with the version number.

To install the Win School NetWare Server from diskette:

1

If you are upgrading, unload the winschl.nlm by typing unload
winschl at the server prompt, then press Enter.

At a workstation, log onto the server as Supervisor or a user with
supervisory authority.

Insert the Win School NetWare Server diskette into your floppy disk
drive.

At the DOS prompt, go to your server drive mapped for sys:, such as
F..

Type a: setup, then press Enter.

Follow the onscreen instructions.
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Setting Up the TCP/IP Network
Win School defaults to TCP/IP.

To use IPX/SPX, see the appropriate product documentation for
instructions on installing IPX/SPX on NetWare, Windows NT, and/or
Windows 95/98.

To check the winschl.ini file on your server:

1  Ata workstation, use a text editor to open the winschl.ini file. The
winschl.ini file for your NetWare Server is located in your winschl
directory, sys:\winschl\winschl.ini.

2 Make sure the TCP/IP line reads:
TCPIP=yes
If not, delete “no” and type yes.

3 Save the winschl.ini file, then reload your winschl NLM using the
instructions in the following section.

Loading and Unloading the NLM

To load the Win School NLM:
1 At the server prompt type load winschl.

2 Note the amount of memory the NLM is using before you unload it. It
defaults to 4 MB of memory which might not be enough.

3 Increase the memory by approximately 2 to 4 MB more than what it is
using.

For example, to load the Win School NLM with 6 MB of memory, type
the memory switch Load winschl /m 6000000.

To unload the Win School NLM:

e At the server prompt type Unload winschl.

Changing the Win School Data Directory
If you want to switch databases, you must change the path to the Win
School data directory by editing the Win School NLM INI file.
To change the Win School data directory:
1 Unload the Win School NLM.
2 From the sys:winschl directory on the server, open the winschl.ini file.

The file is in the Windows directory on the computer running Win
School NetWare Server.

In the Win School Server section, type the correct path after DATA=.

4  Exit and save your changes.
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5 Load the Win School NLM again.

Logging Transactions

You can turn on transaction logging to keep a log of transactions with

errors or all transactions. Turning on transaction logging creates a log file

each day. You can specify how many log files to keep.

Transaction logging is turned off by default.

Transaction Logging Commands

You must add the following lines to your winschl.ini file to activate and
control transaction logging.

Winschl.ini line

Values

Default

DBLogLevel

0 is no transaction logging.
1 is log errors only.
2 is log all transactions.

0

DBLogNbrGenerations

Number of days to keep log files.
Maximum is 50.

DBLogNbrTransSaved

For DBLoglevel=1 only.

Specifies the number of transactions
to log before the error occurred.
Maximum is 200.

10

DBLogReads

0 is log write transactions and errors
only.

1 is log read and write transactions
and errors.

To turn on transaction logging:

1 Unload winschl NLLM using the instructions in “Loading and

Unloading the NLM” on page 26.

2 Use a text editor to open the winschlL.ini file.

3 Inthe [CSL Win School] section, add the 4 lines with the desired
values as listed above. For example:

DBLogLevel=1

DBLogNbrGenerations=14
DBLogNbrTransSaved=10

DBLogReads=0

4 Save the winschlini file, then reload your winschl NLM using the

instructions in “Loading and Unloading the NLM” on page 26.
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Backing Up and Maintaining Data

After you install your Win School Server, set up your daily maintenance
schedule, directories, and memory allocation.

The Win School server has an automatic, nightly backup that copies all files
and directories in your Win School data directory to the Backup Directory.

Make sure all users are logged off before the Win School server shuts down
for nightly maintenance.

Setting Up Your Daily Maintenance Schedule

Daily maintenance occurs unattended overnight. To perform daily
maintenance, you must set up the Shutdown Time, Downtime, and schedule
backing up your data files.

All users must exit Win School during data maintenance. Make sure all
users know your daily maintenance schedule, so they won’t disrupt it.

Use a commercial backup package to backup Win School after your daily
maintenance is complete. For more information, see “Choosing a Data
Backup System and Policy” on page 40.

Setting Up Shutdown Time, Downtime, and Backup

Downtime is the minimum length of time the Win School Server is shut
down. If you are using third party backup software, ensure you set up
enough time for backup to be completed.

To set the Shutdown Time:

1 At the Win School Server, type the shutdown time, such as:
/s 2:00am.

2 Press Enter. The new shutdown time displays.
The next daily maintenance starts at the time you entered, such as 2 am
tomorrow.

To set the Downtime:

1 At the Win School Server, type the downtime in hours and minutes,
such as: /d 3:00.

2 Press Enter. The new downtime displays.

To set the Backup function:

1 In the command line of the Win School Server screen, type either /b or
/backup, followed by a space, then Y to turn backup on or N to turn
backup off. For example, to turn backup off, type: /b n.

2 Press Enter. The backup setting displays.
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Using NLM Administrator Commands
You can use the following administrator commands at the Win School

NLM console.
Console Command Function
request_shutdown Attempts to disconnect the clients that are
connected to the server and shut down the
Win School NLM.

kill_remaining_connections Use this command only if you cannot
account for missing or ghost connections.
This saves you from unloading and
reloading Win School.

unload_winschool If the NLM locks up, use this command to
prevent the console from also locking up.

Changing Win School Directories After Next Year Prep

After Next Year Prep, you must change the Win School directory to point
to the correct data folder by changing the “data=" line.

You can also use this procedure to move or rename the data, backup, and
DBS directories.

Warn all users that they must log off before the Win School Server shuts
down.
To move or rename your Win School Server directories:

1 On the Novell System Console, type unload winschl, then press
Enter.

2 At a workstation, log onto the server as the supervisor.
3 Move or rename the data, backup, and/or DBS directories.

4 Using a text editor or word processor, open the winschl.ini file in the
\winschl directory on the server’s .sys volume.

5  Check the following lines:

This line Must

path= e contain the path to the directory containing your
.dbs and .err files

e end with that directory’s name, followed by a “\”

data= e contain the path to the directory containing your
data

e end with that directory’s name, followed by a “\”

backup= | ® contain the path to the directory containing
yesterday’s copy of your data

e end with that directory’s name, followed by a “\”
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This line Must

temp= e contain the path to the directory containing Win
School’s temporary files only, which can be deleted

e end with that directory’s name, followed by a “\”

6 Save your changes in text-only format.

7 To load the Win School Server from the Novell Server console, type
load winschl, then press Enter.

Setting the Win School Server’s Memory Allocation

The default memory allocation for the Win School Server is 4 megabytes
(4,000,000 bytes). If this amount is not enough, you cannot run the server.

Similarly, if a dialog appears telling you the server did not have as much
free memory as you requested, reduce the amount of memory the server
requests. You can also unload all your NLMs, reboot the server, and reload
them. Otherwise, you will have to get more memory for the server
computer.

Specifying more memory than is available on the server might cause the
server to abend.

To set the Win School Server’s Memory Allocation:

1 Warn all users that the Win School Server will shut down (unload).

2 At the Novell System console, type unload winschl, then press
Enter.

3  Type:
load winschl /m
OR
load winschl /memory

4 Type the amount of memory required. The default value is 4,000,000
bytes.

For example, to request 5 MB of memory, type:
load winschl /m 5000000
5 Press Enter.

If the following error message appears, you’ve requested more memory
than is available on the server computer:

Initializing Win School memory manager.
Main buffer alloc failed.
Unable to initialize Memory Manager.

Press any key to return to the Novell System, then either load Win
School requesting less memory or add memory to the server computer.
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Using the Win School Shell

Overview

This section gives you information on using the Shell and Shell commands.

When you launch Win School, the Win School Shell opens, displaying the
modules you have purchased and the path to your data. The Shell is a
launch pad from which you can access all Win School modules. There are
Shell commands that control how you work with Win School.

Using Shell Commands

Check Versions

You can use Win School Shell commands to do the following:

Display information about Win School.

In the multi-user version of Win School, show who is logged on.
Change your Win School password.

Set preferences to control how Win School behaves.

Run the Next Year Prep command.

You must never have different versions of Win School modules using the
database at the same time. All your modules must be the same version.

To display Shell version:

From the Help menu, choose About Shell.

A dialog displays the version of the Shell as well as other Win School
information. Click the dialog to close it.

To display versions of modules:

From the Shell menu, choose View Info.

The module buttons change to display its version. To change back to
normal view, choose View Info from the Shell menu again.
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Technical Support
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You can minimize the Shell when you launch a module. When you close
that module, the Shell is displayed again.

To minimize the Shell when you launch a module:
e  From the Shell menu, choose Minimize on use.

A checkmark appears beside the command. To leave the Shell displayed
when you launch another module, choose Minimize on use from the Shell
menu again.

The Technical Support report displays information about your computer
and Win School for Chancery Technical Support to use in troubleshooting.
It lists the location and contents of the Win School and Windows files listed
in the table below. Each file is listed on a separate page of the report.

If any problems arise with Win School, you can generate this report to
check your Win School environment.

Page Title File Name File Location

Autoexec Batch File AUTOEXEC.BAT | startup drive, root folder
System Configuration CONFIG.SYS startup drive, root folder
File

CSL Win School WINSCHL.INI Windows folder
Initialization File

System Initialization File | SYSTEM.INI Windows folder
Windows Initialization WIN.INI Windows folder

File

To generate the Technical Support report:

1 In Win School Shell, choose Technical Support from the Shell menu.
The report window opens displaying information about the Autoexec
Batch file.

2 To view information about a specific file, select it from the popup
menu to the right of the heading bar.

OR
Click the next button until the information is displayed.

3 If you want to print the report, choose Print from the Report window’s
System menu.

4  Close the window when you are finished viewing the report.
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Administrator Log

In the Multi-User version of Win School, you can run the Administrator
Log report to see who is currently logged onto Win School, what module
they are using, what degree of access they have to that module, the time
they logged on, and which version of Windows they used to start Win
School.

If you need to shut down the Win School server, you must first notify all
users to save their work and quit Win School. Otherwise, they could lose
their work.

To generate the Administrator Log report:
1 Start Win School and log in as the Administrator.
2 From the Shell menu, choose Administrator Log.

3 To print the report, choose Print from the System menu.

Language

You can set the language Win School uses to French or English.

To set the language:
1 From the Shell menu, choose Language.

2 Click French or English, then click OK.

Change Password

As System Administrator, you set up all Win School users giving them
passwords and access to Win School modules. For data security reasons,
give access to School Setup only to well trained staff who need access to
School Setup.

For information on setting up Win School users, see “Setting Up Other Win
School Users” on page 45. For information on assigning access levels, see
“Deciding Access Levels” on page 45.

All users can change their own password using the Change Password
command.

To change user password:
1 From the Shell menu, choose Change Password.

2 Type your old password and the new password. Click OK.

Next Year Prep
Next Year Prep is part of the process of setting up a new school year.

For more information, see “Setting Up the Next School Year” on page 101.
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Setting Preferences

Setting System Preferences

Win School System Preferences affect all Win School modules and should
only be changed by the Administrator. You must determine how your
school calculates the following information before you set System
Preferences.

e Calculations of GPA, Earned Credits, Percentages, Class Rank letter
grades, and Honor Roll letter grades.

e (Calculations of Points & Credits tables percentages and letter grades.
e Whether to display inactive classes.
e Dates considered valid in Win School.

System Preferences are available in the Shell and all Win School modules
except School Setup, Attendance, Query, Scanning, Universal Access, and
District Extract.

Set the preferences for calculation when you reach that point in your system
setup. Detailed information on calculations is in the guides for: Scheduler,
eClass Grades, Marks, Report Cards, and School Setup.

To set System Preferences for Win School:

1 In the Shell, choose Preferences from the Shell menu.

OR

In Details, Report Cards, Report Manager, Scheduler, or
State/Province; choose Preferences from the Edit menu.

2 In the Preferences dialog, choose Win School: System from the Edit
menu.

3 Set options in the 4 tabs.

4  From the File menu, choose Save, then close the window.

Miscellaneous Tab

Display or hide all of a student’s inactive classes (classes a student has
dropped) on reports and in student windows. This preference can be
changed as needed throughout the school year.

Setup Tab

Set up dates for Win School to use. This is the valid date range that
Win School accepts.

34 Using the Win School Shell e Setting Preferences



Win School System Administrator

Setting User Preferences

User preferences affect only the user that is currently logged in. User
preferences are available in Details, Report Cards, Report Manager,
Scheduler, and State/Province.

You can set User Preferences to display only males or females, and change
the way Win School displays dates.

To set User Preferences:
1 In the Shell, choose Preferences from the Shell menu.
OR

In Details, Report Cards, Report Manager, Scheduler, or
State/Province, choose Preferences from the Edit menu.

2 In the Preferences dialog, choose Win School : User from the Edit
menu.

3 Select options in the Gender Display and Date Format sections. For
more date formats, click Change.

4 Close the Preferences window and save your changes.

Clearing Module Preferences

This command is available from the File menu. It affects the user who is
logged in and returns some preferences to their defaults.

Important information that is cleared is listed in the table below.

Module Dialog Containing Name of Menu to
Information Access Dialog

Scanning Scanner Setup Scan

Scanning Form Setup Scan

Report Cards Preferences - Report Cards Edit

Scheduler Preferences - Scheduler Edit

If you don’t want to clear preferences for a module, start the module and
leave it open while you run Clear Module Preferences. Otherwise, write
down the important information before you clear module preferences, and
re-enter it later.

To clear module preferences:

1 Log in to Win School as the user whose preferences file is damaged.

2 If you want to retain preferences for a specific module, start the module
and leave it open.

3 In the Shell, from the File menu, choose Clear Module Preferences.

Using the Win School Shell o Setting Preferences 35



Win School System Administrator

Setting Up Win School

Overview
This section gives you some ideas about the setup issues that require
decisions or a policy.

As System Administrator, you have to make many decisions about how
Win School is implemented. You will have to work with your school
principal and other Win School users to decide what gets entered. You will
refer to your school policies and standards. You might also have to look
into regulations established in your state or province.

This section does not describe every item you need to set up. Refer to the
specific Win School guide for that information.

This section contains the following information:

e A setup checklist, including things you need to set up before you start
Win School.

e Procedures for establishing yourself as the Win School Administrator
and setting up other Win School users.

e Tips on setting up various items in School Setup, especially in
Scheduler. A great deal of setup work, which affects other modules, is
done in this module.

e Tips on how to set up Report Cards and eClass Grades.

e Procedures for setting up Period to Daily Link in Attendance for twice-
daily or by-period attendance.

e Tips on setting up and managing Report Manager templates.

Using Setup Checklists

When setting up your school, use this checklist to be sure you’ve covered
everything.

O Know all data elements you need to track in Win School.

Know what you have to set up for state or provincial reports.

Know your district data standards.

Have a backup policy, backup software, and equipment.

O 00D

Check the guides or online Help for information about setting
Attendance and Report Cards preferences.

(W]

Set up passwords and ID numbers for all Win School users.

(M

Establish the number of periods and blocks your school needs.
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U000 Do

(M

a
a

Calculate the number of Points & Credits tables you need.
Establish all required Report Card bins for your school.

Set up User-Defined flags or fields to track data that is not part of the
regular Win School setup.

Establish a strategy for managing the Comments file.

Decide the location of teachers’ eClass Grades or Marks files.
Decide when to write, upload and edit eClass Grades or Marks data.
Establish how to verify marks before you generate report cards.

Establish which Period to Daily Link best suits your school:
Occurrence-based or Sample-based.

Check on state, province, and district guidelines for calculation of daily
attendance codes from period attendance codes.

Determine the location of your default Template Folder.

Decide if you need to create Report Manager templates.

Preparing to Start Win School

Before you start Win School, establish policies for using the software, and
how you are going to do the following tasks:

Q

Q

(M

Q

How and when you are going to train or implement Win School at your
School.

Whether you are going to enter or import course, teacher, and student
data.

How and when you are going to enter attendance.

How you are going to schedule your school and which module you are
going to use.

How you are going to back up your Win School data.

Deciding How To Train Win School Users

Before you start Win School at your school, decide how you are going to
implement it, with training scheduled into your implementation.

You will have to tailor training to the users at your school. We offer the
following recommendations:

a
a

Train staff a little at a time, not on everything at once.

Structure Win School training around the tasks of each user, after you
have decided user roles at your school.

Stage training and implementation instead of starting all modules at the
same time.

Train during the summer, not at the beginning of the school year.
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O Train with a copy of your school data, so users can become familiar

with the real data they be will using without harming it. If your
database is very large, delete some students to make it manageable.
Otherwise, use the sample data that comes with Win School.

In training sessions, run Win School as single-user on an individual
computer for each trainee, never over a network.

Training Staff to Use Win School
Never use your live school data to train.

Use either the sample data which comes with Win School or copy your
school data for training.

Train with the Single-User Shell, not the Multi-User, and not over a
network.

To set up training data:

1

If you are using the sample data that comes with Win School, copy it
onto each computer you are using for training.

If you are using a copy of your school data folder, back it up, put a
copy of it on each computer that will be used for training.

Locate the shortcut to Win School Single-User Shell, right-click on its
icon and choose Properties.

Click the Shortcut tab and check the Target text box.

The Target text box must contain the path to CSLSHELL.EXE, a
space, a zero, a space, and the path to either the sample data or a copy
of your school data. For example:

CAWINSCHL\Modules\CSLSHELL.EXE 0 C:\WinSchl\Sample
Test the Single-User Shell by double-clicking it.

If you get a message “Invalid Directory for the Win School database,”
click OK, return to Step 3 and correct the path.

In the password screen, type your ID and Password and press Enter.

In the Shell window, check that the Data path = line shows your
training data folder. If not, choose Quit from the File menu and re-do
this procedure.

Repeat this procedure on each computer you are using for training.

Choosing a Data Entry Method

There are 2 methods to enter initial data into Win School:

U Manually typing it into Details

U Transferring it from another software program into Win School using

ASCII Transfer
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Regardless of which method you use, enter your data in this order:

1 Rooms

2 Courses

3 Teachers
4  Students

5 Resources

The order is important because it is linked. You need room information to
set up courses, course information to set up teacher course preferences, and
teacher data to assign students.

For information on ASCII Transfer, see the Scanning and ASCII Transfer
Guide.

Deciding How and When To Enter Attendance

You can enter attendance information into Win School either manually or
with an optical scanner and scan sheets. An optical scanner is more efficient
and accurate.

Decide when during the school day you are going to take attendance. You
have 3 choices:

U Daily: enter 1 attendance code for each student each day. Decide
criteria for attendance codes, and the time of attendance entry.

U Twice-Daily: enter a morning and an afternoon attendance code for
each student. Choose the morning and afternoon periods that best
represent attendance each day, then take attendance in those periods.

U By Period (Period Attendance): enter an attendance code each period
for each student. A daily attendance code is assigned to each student
calculated by period attendance.

If you are scanning attendance by Period, use Scheduler to schedule
classes.

Deciding How To Schedule Your School

Two modules create classes: Report Cards and Scheduler. Choose the
module that best suits your needs.

Use Report Cards to create classes and put students in them. However,
classes cannot be scheduled into a room or a period.

Use Scheduler to build your Master Timetable and build student timetables
from student course requests. Use Scheduler if your school requires any of
the following functions:

U Track attendance By Period.
O Print student timetables for students.

O Schedule teachers into more than 1 room.
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(M

Automatically set up sections based on the number of student requests.
U Automatically assign students to a study hall for spare periods.

O Automatically scramble periods, so no class is taught in the same
period each day.

Use Report Cards if you don’t need any of these options. Report Cards has
fewer features, is easier to use, and requires less setup work and training
time. The Edit Classes command in Report Cards meets the scheduling
needs of many elementary schools.

Choosing a Data Backup System and Policy
A backup policy and the daily backup of all data is essential.

Back up data at the end of the school day, preferably at night, so that if
problems occur, the most you can lose is 1 day’s work.

Chancery recommends storing more than 1 backups in a location other than
your school, and rotating backups every week.

Check if your school has a comprehensive commercial data backup
package. To choose commercial backup software, we suggest you talk with
a Chancery Authorized Reseller or a local software retailer about what best
meets your needs.

If you are using Win School single-user, you may use backup software such
as DOS or Windows™ backup or PKZIP.

When choosing a backup software package, consider the following:

(d Scheduling and Reporting Capabilities: as data backup is at night,
look for a product that can run unattended.

1 Multi-Platform Support: to back up computers on a network, check
that the software can support all of the operating systems used on the
network, such as Macintosh, Windows, and UNIX.

(d High Capacity Storage Support: depending on the size of your Win
School database, select a product that can support the amount of your
data into the future.

Choosing a Virus Protection System and Policy

Virus protection is essential. Diskettes are particularly vulnerable.

The expense of cleaning a virus out of computers can be very high, in lost
time and lost data. You must be able to check:

e  All diskettes that are used to transfer marks and other data between
teachers and other staff.

e All new programs that you load into the Win School computers and
server.
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e Anything that is imported, or loaded into your computer system,
whether by email, from diskette, by network, or by other form of
transmission.

Check if your school has virus-protection software, and the conditions of
use. Chancery recommends that you purchase the best virus-protection
software you can afford, and that you implement a virus protection policy.

To choose virus-protection software, we suggest you talk with a Chancery
Authorized Reseller or a local software retailer about what will best meet
your needs. Consider the following:

(d The number of computers that need the protection and how the
software will be used on them.

d  Who will perform the virus checking and when. A central checking
point might be better than a site-license where individual computers are
checked.

(d  The school policy for data transfer, and importing anything
electronically. You might have to create such a policy.

Changing Your Win School INI File

Edit the Win School initialization file, winschl.ini, to change location of
data, modules, temporary or .dbs and .err files, or to change the colors used
in highlight bars and grids.

During installation, Win School automatically creates this file on each
workstation which contains information such as data and module locations.
Win School reads this file every time you start it. Most schools do not
change these settings, except to select a different data folder. The Win
School server has its own initialization file, as described in the installation
instructions in your Release Notes.

If you want to change the location of Win School data or modules, make
the corresponding change in the winschl.ini file.

Store the winschl.ini file in your Windows folder, which is the folder that
also contains your win.ini and system.ini files.

If your winschl.ini file is not in your Windows folder, Win School will
create a new winschl.ini file containing the default settings listed below. If
your data, modules, and .dbs and .err files are not in the default locations,
you will not be able to start Win School.
To change winschl.ini settings:
1 Quit Win School.

In the Windows folder, use a text editor to open winschl.ini.

2
3 Make edits.
4

From the File menu, choose Save, and save in text-only format. Close
the window.

5 Restart Windows for changes to take effect.
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Understanding Winschl.ini Settings

O—3]

The main settings for winschl.ini, and their defaults, are listed below.

Data
data=c:\winschl\data\

Win School data files location for single-user. Ignored for multi-user.
Overridden by the path entered in the Single-User Shell, Properties dialog.

Never keep your school data in the folder indicated in the Sample= setting.

The Shell will not start if you see “Invalid Directory for the Win School
Database.” Check your winschl.ini file and make sure this directory exists.

Check the path. The default location is the Data folder in the Winschl
folder, on your hard drive or on a network.

Path

path=c:\winschl\modules\

Location of the Win School .dbs and .err files. The Shell will not start if
you see “DBS message not available. Error Code = 13.” Default location is
the Modules folder in the Winschl folder on your hard drive or a network.

Modules

modules=c:\winschl\modules\

Location of the Win School software files with .exe, .dll, and .hlp
extensions. The Shell will not start if you see “Invalid Directory for the Win
School Modules. Check your winschl.ini file and make sure this directory
exists.” Default location is in the Modules folder in the Winschl folder, on
your hard drive or a network.

Sample
Sample=c:\winschl\sample\

Sample data location is for single-user. It is ignored for multi-user. Use
sample data through the Single-User Shell.

At installation the sample data folder is empty. Sample data is installed in
the Data folder. The next time you install Win School, the sample data will
be installed in the Sample= folder. To use it, change the Data= line in
winschl.ini to match the Sample= line and start the Single-User Shell.
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Default location is the Sample folder in the Winschl folder on your hard
drive or a network.

Never keep your actual school data in the folder indicated in this setting.

Temp
temp=c:\winschl\temp\

This is the location of the Win School Temporary folder with interim files
generated by printing reports or performing long processes.

Never share a temp folder.

Never put any files into the Temp folder. Win School will delete them.

The Shell will not start if you see “Invalid Directory for the Win School
Temporary files. Check your winschl.ini file and make sure this directory
exists.” Default location is in the Temp folder in the Winschl folder on your
hard drive or a network. There must be a Temp folder on every workstation
and on the server.

StartupLanguage NumLanguages Language
English: 1 and ENG French: 2 and FRE

This defines the default language, and includes language support
extensions.

Scanform

data=c:\winschl\scanform\

The Scanform folder contains information about forms generated by the
Scanning module on a particular workstation. The forms are available only

on that workstation because, at most sites, a scanner is connected to the
workstation used for scanning.

ActiveHighLightRGB
ActiveHighLightRGB=0, 0, 0
Defines the color of the highlight bar in an active window. RGB are

settings for red, green, and blue. To avoid confusion, make the
ActiveHighLightRGB and InactiveHighLightRGB settings different.
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InactiveHighLightRGB
InactiveHighLightRGB=128, 128, 128

Defines the color of a highlight bar that is not active. A highlight bar is
inactive when another window is uppermost or when the window has more
than 1 highlight bar. Only 1 bar can be active at a time.

RGB are settings for red, green, and blue. To avoid confusion, make the
ActiveHighLightRGB and InactiveHighLightRGB settings different.

GridPenRGB
GridPenRGB=192, 192, 192

Defines the color of grid lines, including those on Main Win School
windows. RGB are settings for red, green, and blue.

Setting Yourself Up as Administrator
When you start Win School for the first time, identify yourself as the
Administrator so you can view, edit, or delete all Win School data.

Decide on password policy and structure for your own password and
passwords for staff. Win School data is confidential. Make sure that only
those who need access to a module can use it.

Although Win School has an option to ignore passwords, we advise against
using it to protect your data.

Assign Passwords Edit access to another user as a precaution. If you lose
your password there is no way of retrieving it.

To set yourself up as the Win School Administrator:

1 In the School Setup Main window, click Passwords, then double-click
System Passwords.

2 In the Staff Pool list, double-click Administrator.
3 In the User ID field, type an ID number of up to 7 digits.

4 In the Password field, type your password, up to 7 letters or numbers.
Passwords are case sensitive.

5 At the top of the dialog, uncheck “Ignore Passwords and Access Level
settings” so Win School will be password protected.
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Passwords... " Ignore Passwords and Access Level settings
User Name Administrator Staff Pool
Position N/A ator
Uszer ID 1 Double-click Arress, James
Password BOSS on staff | Cavein, Tich A
member to +* | Dean, Bob
display or |/ | Doctor, Heinrich
Module Access Level create " Domoney, Dennis

Archives b Edit password +  Duchesne, Yanick
ASCI [+ Export and Import —— + | Harrigon, John Patrick,
Attendance I+ Edit +* | Mann, Peter Joseph
Details - Add List Items | | Yes b | Marcos, Imelda
Details - Course I+ Edit W | Mam, bay

...Crs. Cust. Tab#1 P Edit | Masmpth, Patricia

...Crs. Cust. Tab#2 P Edit + | O'Reilly, Janet

_..Cre. Cust. Tab# 3 || Edit | Pickle, Shary

...Crs. Cust. Tab#4 |} Edit ' Rebak, Davey

...Crs. Cust. Tab#5 P Edit " | Wilzon, Brenda Jean

...Crs. Cust. Tab# 6 P Edit | Woo, Pita

...Crs. Cust. Tab# 7 ||+ Edi

...Crs. Cust. Tab # 8 |} Edit

...Crs. Cust. Tab#9 || Edi

...Crs. Cust. Tab # 10 ||+ Edi

...Crs. Multi. Tab #1 b Edit 3 R4

Delete Access CopyAccess Cancel 0K

Setting Up Other Win School Users

After setting yourself up, set up other Win School users, assign them a
password, and give them access to the Win School modules they need. For
more information on user roles and suggestions for appropriate access
levels, see “Clarifying Win School User Responsibilities” on page 5.

Deciding Access Levels

Access Level determines what data can be viewed in Query, and what data
the user can change in other modules. The following table describes the
different levels of access.

Access Level

Description

None No access. Default setting is None.

View Run the module, view data, and print reports. Cannot
enter or edit data.

Edit Complete access to the module to add, enter, and delete
data. Administrator setting is Edit.

Change Only For specific Details information. Edit courses, teachers,

students, student groups, status codes, and conduct
codes. Cannot add or delete.

Multi-User View

For Scheduler. Start Scheduler in Multi-User mode.
Cannot change data.

Multi-User Edit

For Scheduler. Start Scheduler in Multi-User mode and
edit all data, including timetables. Cannot build the
Master Timetable. See the Win School Scheduler Guide
for more information.
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1
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In Teacher Details, enter information for every Win School user.

In School Setup Main window, click Passwords, then double-click

System Passwords.

Double-click the first teacher in the Staff Pool list and set up the

following data:

e In the User ID field, type an ID number of up to 7 digits for that

teacher. Some schools use staff numbers.

e In the Password field, type a password. Passwords can be letters or
numbers of up to 7 characters, and are case sensitive.

e In the Access Level column, set up the access level for each
module by pressing Shift and selecting the most common level of

teacher access.

Manually change access levels where needed.

Repeat for each Win School user.

[~ Ignore Passwords and Access Level settings

Passwords...
Usger Name Dean, Bob
Position Teacher
User ID 3
Password bbob
Module Access Level
Archives b Edit
ASCIH [ Export and Import ——
Attendance [ Edit
Detailg - Add List Items b Yes L
Details - Course b Edit
Crs ED Tab #1 P Edit
..CrisED Tab # 2 [ Edit
..CrisED Tab # 3 P Edit
..CrisED Tab# 4 b Edit
CrsED Tab # 5 [ Edit
..CrisED Tab # 6 [ Edit
..CrisED Tab # 7 P Edit
..CrisED Tab # 8 P Edit
.CrsED Tab # 9 [ Edit
...Crs ED Tab # 10 [ Edit
Details - 5/B/A b Search and Replace | ¥

Delete Access |

Double-click
on staff
member to
display or
create
password

CopyAccess | Cancell

Staff Pool
W Administrator
W Amness, James
| Cavein, Tich &

|~ | Dean, Bob

Doctar, Heinrich
Domoney, Denniz
Duchesne, Yanick
Harrizon, John Patrick
tann, Peter Joseph
Marcog, Imelda

b armn, b ay
Mazrnyth, Patricia
O'Reily, J anet
Pickle, Shary
Rebak. Davey
‘Wilzon, Brenda Jean
woo, Pita

AR ASACAARRARA

0K

4 Give each user their ID number and password. Remind them that
passwords are case sensitive.

Entering Information in School Setup

School Setup is where you enter a great deal of information for other
modules. This information is fundamental to how Win School operates. For
example, you establish how you are going to use Report Cards, Scheduler,

and Attendance in School Setup.

After you have set up all the basic information in School Setup in the first
year, only a few changes are needed in future years, such as term dates.
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Although your Win School School Setup Guide and Win School Getting
Started Guide contain a great deal of background and procedural
information about how to use School Setup, this section suggests some
decisions to make as a Win School System Administrator:

O
0
O
0
O

a

How you establish and keep a standardized data set.
Whether your school needs Transfer Recording.

How you set up Scheduler for your school.

How you set up Report Cards and/or Marks for your school.

If you are tracking attendance by period or twice-daily, how to
establish criteria for the period-to-daily link in Attendance.

If you need to set up user-defined information.

Establishing a Data Standard

Four reasons for standardizing data:

To keep school data consistent for sorting and searching.

For reporting to a district office. Every school using the same School
Setup information following a district-wide standard keeps the district
database consistent.

For reports, to ensure appropriate and understandable terminology and
consistent capitalization.

To submit state or provincial reports with data set up exactly the same
way at every school.

To establish a data standard:

1

Check with other people at your school when setting up lists to make
sure everyone needs and uses the same standard.

Establish consistent terminology, spelling, abbreviations, hyphenation,
and capitalization, particularly for geographical and other names.

Use plain English that is appropriate, clear, and understandable.

Supervise the work done in School Setup so you can establish and
enforce data standards.

In some cases, your district office will forward a master list of the data
to be entered in School Setup.

Limit user access to School Setup or to Add List Items in Details to
preserve data standards. See “Setting Up Other Win School Users” on
page 45.

Use the table below to establish the information that should be
standardized and to see which menu in School Setup is used to enter
the information. School Names are a special case. Your School Name is
entered by Chancery Software. If it is misspelled, contact Chancery.
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Using Transfer Recording

In School Setup, click the School menu, then double-click Transfer

Win School System Administrator

School Setup Menu

Information

School

School Names
District Names
Define Grade Levels
Year Round Tracks

Details Lists

Cities

States

Counties

Countries

Areas

Titles for Contacts and Principal
Employer Types (for Contacts)

Departments

Address Types
Attendance Daily Attendance Codes

Period Attendance Codes
Courses Course Types

Course Subject Areas

Student - General

Ethnic Categories
Home Languages
Lunch Status
Contact Relationship

Student -
Codes/Actions

Status Codes
Conduct Codes
Conduct Action

Recording.

Trangfer Recording...

Do you want to have student transfers between Grade Levels,
Homerooms, Tracks, and Mormal Programs recorded?

[0 pou want to keep timetable and clagss roster histom?

Mo

Yz " Mo

Print Settings... | Cancel |

ok |
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If any of the following apply to you, select Yes for transfers between
Grade Levels, Homerooms, Tracks, and Normal Programs:

d  You report attendance statistics according to grade or homeroom.
Transfer Recording keeps the statistics accurate.

[ Your school is a year-round school. Record transfers so that all
previous days of attendance are always accessible for students who
move from 1 track to another.

If any of the following apply to you, select Yes to keep timetable and
class roster history:

(1 Marks are already entered in Report Cards. If a student transfers
from 1 class to another, you have a record of all classes that might
have marks.

(d  Scheduler records changes to student timetables, and reports class
attendance based on period attendance from Attendance.

(d Scheduler timetables have a Transfer Date or the Start Date for
Change is in the future. These changes will not happen if you
select No.

If any of the following apply to you, select No for both options in the
Transfer Recording dialog:

d  You are working in the next year database after performing Next
Year Prep.

([ Itis early in the school year, and you want to ignore changes. After
the transfer frequency slows, select Yes again.

d  You want to minimize disk space.

Setting Up Rooms in School Setup

Before setting up courses in Details, first enter room information. If you use
Scheduler, room information is a factor in how your school is scheduled.

To set up rooms:

1

In the School Setup Main window, click the Rooms menu, then double-
click Room Types.

Establish the different types of rooms at your school. If students in your
school take classes at another school, also enter those Room Types.

From the Rooms menu, choose Room Setup. Set up all the information
about all the rooms you schedule students into, regardless of the
whether those rooms are at other schools.

For scheduling purposes, ensure the School ID is correct, the Capacity
is accurate, not 0, and the For Scheduler flag is Yes.
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Setting Up Scheduler in School Setup

If you decide your school will use Scheduler after reading “Deciding How
To Schedule Your School” on page 39, you must set it up.

To use Scheduler, you must decide on:
e  Setting Scheduler Terms
e Timetable Structure

e Teacher Course Load

To set up Scheduler in School Setup:

1 In School Setup, click the Scheduler menu, then double-click each item
in order and set up the options.

2 Use the information in this subsection to help make decisions about
your scheduling structure:

e  “Setting Scheduler Terms” on page 50

e “Setting Your Timetable Structure” on page 50

e Setting the “Day Cycle” on page 51

e Setting the “Number and Length of Periods” on page 51
e Setting the “Number of Blocks” on page 52

Setting Scheduler Terms
Before setting up Scheduler information, set up the correct school year in
the School menu in School Setup.

Set up Scheduler terms for each school year by setting each term’s start and
end date. A term is defined by the length of the shortest class your school
offers.

For example, if you have 1 class which is only 6 weeks, you must set up a
term for that class, even if every other class offered is eighteen weeks.

Create one 9-week term for the first class and another 9-week term for the
other classes. Then in Details, set all eighteen-week classes as 2-term
classes and set the 6-week class to be taught in the first term.

Although many schools have 2 to 4 terms, you can have up to twelve
Scheduler terms. Setting up fewer terms will use less memory and disk
space.

Setting Your Timetable Structure

Your Timetable Structure defines the following aspects about the daily
framework of your school:

e if your school uses Fixed Day or Relative Day cycles
e if your school has classes on Saturday or Sunday

e how many periods there are in a school day
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e how long each period is
e how many blocks your schedule uses

A block is the smallest unit of time, representing classes, teachers, rooms,
and students taught at the same time. Blocks are identified by letters.

If you move a block letter from one time in the timetable to another, you
change the time that all the classes scheduled in that block are taught.

If you duplicate a block letter, adding it to a new period in the timetable, all
the classes scheduled in that block are now also taught in the new time.

A day is a series of blocks, with 1 block per period. A block taught in 1 day
might be unique to that day, or it might also be taught on other days.

A cycle is the largest unit of time, measured in days. A Cycle is a pattern of
days repeated in your school timetable.

A Fixed Day cycle is either 1 or 2 calendar weeks.

Day Cycle

A Fixed Day cycle occurs when every weekday has the same schedule. If a
holiday lands on a weekday, that day is skipped. This cycle can run for
either 1 week or 2 weeks before repeating.

A Relative Day cycle (for example, Day 1, Day 2, and so on) occurs when
each day in the cycle has its own schedule. This cycle rotates, so when a
holiday occurs the cycle is not interrupted. A Relative Day or rotating cycle
can have up to 14 days.

If your school uses the Fixed day cycle, with only 1 day in the cycle, set
your timetable as a 1-day Relative cycle so your school will be scheduled
faster.

Number and Length of Periods

Depending on the complexity of your timetable, setting up periods with
start times and end times can range from being simple data entry to
requiring you to plot out your timetable.

Take your bell schedule into account when setting up this information.

Some schools have linear and non-complicated timetables: each period is
the same length, runs consecutively, and everybody has lunch at the same
time.

However, if your school schedules more than 1 lunch hour or has classes
shorter or longer than other classes, you will have to chart your timetable,
set up shorter periods, and make longer classes 2 or more periods long.

With complicated timetables, you might have to set up more periods to
accommodate your timetable.

For more information on the Timetable Structure dialog, see the Scheduler
Guide.
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Examples of Periods

If most classes are 50 minutes long, but lab courses are 105 minutes long
(two 50-minute periods plus the 5-minute class change break), then set up
all periods as 50 minutes, and in Course Details, set up labs are in 2
consecutive periods. Because the whole school takes lunch at the same
time, lunch hour is not included as a period, and not scheduled.

Pd1 09:00 -09:50
Pd2 09:55-10:45
Pd3 10:50-11:40
Pd4 11:45-13:30
Pd5S 13:35-14:25
Pd6 14:30-15:20

< lunch not included

The timetable below is the same as the timetable above, but half the school
takes lunch in Period 4 and a class in Period 5. The other half takes a class
in Period 4 and lunch in Period 5. All students take classes in all other
periods. When classes are scheduled at the same time as lunch, include
lunch as a scheduled class.

Student 1 Student 2
Pd1 09:00-09:50 Class Class
Pd2 09:55-10:45 Class Class
Pd3 10:50-11:40 Class Class
Pd4 11:45-12:35 Lunch Class
Pd5S 12:40-13:30 Class Lunch
Pd6 13:35-14:25 Class Class
Pd7 14:30-15:20 Class Class

If most classes are 45 minutes long, but some are 70 minutes long, based on
20-minute periods divided by 5-minute breaks, a 45-minute class is two 20-
minute periods plus the 5-minute break between them, a 70-minute class is
three 20-minute periods plus the two 5-minute breaks between them.

In Course Details, set up the 45-minute classes in 2 consecutive periods,
and the 70-minute classes in 3 consecutive periods.

Number of Blocks

Scheduler schedules according to blocks, not periods. When you have set
up the periods in your timetable, calculate the number of blocks your school
needs. A block is a unique combination of class, room, teacher, and
students in a time period.

Depending on the complexity of your timetable, some classes might be 2 or
more blocks long.
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Blocks can be repeated throughout your timetable which means the same
students and teachers will be in the same rooms for the same classes at
different times. If even 1 element changes, it is considered a unique block,
which is important in calculating how many blocks your school needs.

Do not decrease the number of blocks after you have started creating your
school timetable in Scheduler. You can increase the number of blocks,
rearrange them, and add or delete days at any time. But leave in your
timetable at least 1 of each of the block letters used when scheduling
started. Otherwise, scheduling won’t work and must be re-started. Only
student requests are saved.

Examples of Block Timetables

The simplest block timetable doesn’t have repeating blocks. In the example
below, multiply the 6 days by the 6 periods to get 36 unrepeated blocks.
This timetable accommodates classes that are taught every day, or on some
days. For this type of timetable, in Course Details, select for individual
classes to be scheduled in the same period each day.

C6 Days, 6 Periods, 36 BlockB

Day 1 Day?2 Day 3 Day4 Day 5 Day 6

Pd 1 A G M S Y AE
Pd 2 B H N T Z AF
Pd3 C 1 o U AA AG
Pd 4 D J P v AB AH
Pd5 E K Q w AC Al
Pd6| F L R X AD AJ

If every class is taught every day, the number of blocks can equal the
number of periods.

If classes are taught in the same order every day, the timetable can be a 1-
day relative cycle, or it can be a 5-day fixed cycle with the same sequence
of block letters every day. The effect is the same.

Cl relative Day, 6 Periods, 6 BlockE

Day 1 CS fixed Days, 6 Periods, 6 Blocks)
Pd 1 T M T W R F
Pd2| B Pd1| A A A A A
P3| C b3l ¢ c c e
Pd 41D Pd4| D D D D D
Pd5 | E PA5| E E E E E
Pd6|F Pd6] F F F F F

Setting Up Win School e Entering Information in School Setup 53



Win School System Administrator

If the order of blocks changes each day, each day still uses the same blocks,
so every class is taught every day.

1 2 3 4 5 6
Pdl |[A B C D E F
Pd2 |B C D E F A
Pd3 |C D E F A B
Pd4 |D E F A B C
Pd5 |[E F A B C D
Pd6 |[F A B C D E

If some classes don’t meet every day, the timetable needs more blocks than
periods in a day. But if the schedule follows a specific pattern, reproduce it
with a repeated pattern of block letters. The fewer unique blocks the
timetable needs, the less drive space and memory needed to schedule
classes.

The timetable below allows a class to be taught on Monday, Wednesday,
and Friday; or Tuesday and Thursday; or every day.
5 fixed or 2 relative Days, 6 Periods, 12 Blocks
M T W R F

Pdl |JA G A G A
Pd2 |B H B H B
Pd3 |C I C I C
Pd4 |D J D J D
Pd5 |E K E K E
Pd6 |F L F L F

The timetable below is a rotating cycle of 10 blocks, repeated 3 times in a
cycle. This repetition provides Classes 3, 6, 9, (any multiple of 3) times per
cycle.

5 Days, 6 Periods, 10 Blocks |
1 2 3 4 5

Pd 1
Pd 2
Pd 3
Pd 4
Pd 5
Pd 6

mm g QW >
W == za

= QT moAn
U w > =

Setting Teacher Course Load

Before you schedule teachers, determine how many blocks teachers can
teach in a Scheduler term, as well as how many blocks in a row they can
teach in a school day, without a break. You might have to check contracts
or the district mandates for this information.
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To set up Teacher Course Load:

1 In School Setup, click the Scheduler menu, then double-click Teacher
Course Load.

2 Select a number from the popup menus.

3 Click OK.

Setting Up Report Cards in School Setup

The Number of different blocks a teacher can teach is the default in Details
when you enter information for each teacher. You can modify this number
for specific teachers in Details. Scheduler uses the number you entered in
Details when scheduling each teacher.

The Maximum consecutive blocks taught dictates how flexible Scheduler
can be in creating a teacher timetable and scheduling free periods.

For your school to use Report Cards, use the Report Cards menu in School
Setup to establish:

e the number of Report Card bins your school needs

e how many Points & Credits tables your school needs and how you want
to set up each one

Deciding How Many Bins to Set Up

Report Card bins store a set of student marks and other details, which
include percentages, letter grades, grade points, pass/fail information,
earned credits, student comments, and class attendance.

The number of Report Card bins your school needs depends on how often
you need to store sets of marks. For example, to report marks for the first
midterm, at the end of each of 3 terms, and a final mark, you would need to
set up 5 bins.

The first 12 bins can go into students’ Historical files, so any bin
information you want in Historical files must be in the first 12 bins. Many
schools use Bin 10 for first semester, Bin 11 for second semester, and Bin
12 for final marks.

Your district might want to follow a data standard on the number and
names of bins you use in order to generate consistent reports on this data.

In Win School, you can use up to 30 report card bins. Because bins require
a lot of disk space, only set up the bins your school needs.

Setting Up Points & Credits Tables

Points & Credits tables dictate how letter grades, percentages, grade points,
and earned credits are calculated from letter grades or percentage marks.

For example, using the Auto-Filling function in Report Cards, when a
teacher enters a letter grade, the Points & Credits table automatically
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calculates the corresponding percentage mark, grade points, earned credits,
and whether that mark is considered a pass or a fail.

In Report Manager, when you design a template, you control which items
appear in a report card or a custom report.

Decide on the number of Points & Credits tables your school needs by
examining the different courses at your school and their marking schemes.
Each different marking scheme requires its own Points & Credits table.

Many schools have different tables for honors and regular courses. If some
courses have both honors and regular students you can calculate their marks
differently using the same Points & Credits table, as shown below.

Mormal Courses Honours Courses
Letter Grade Eamed Letter Grade Earned
Grade Percent Pointz  Credits Passz/Fail Grade Percent Pointz Creditzs Paszsz/Fail
f+ 95.00 4.000 1.260 b Pazzed af | A+ 95.00 4,500 2800 b Pazzed
Pl 90.00 4.000 1250 p Paszed A, 90.00 4.500 2800 b Pazsed
A- ah.00 2500 1.250 P Paszed B ah.00 4.000 2800 b Pazzed
B+ 80.00 3500 1.2580 b Pazsed B+ 20.00 4.000 2500 p Paszzed

Some schools design 2 tables for each marking scheme: 1 with Earned
Credits and 1 without. The table with Earned Credits is used for all bins
storing final marks.

Each of the following scenarios describe different types of courses, each
requiring their own Points & Credits tables:

e courses marked Pass/Fail
e courses marked Incomplete/Complete

e courses taught by a specific department using a different grading
scheme than courses taught by other departments

e courses with different Earned Credits or grade points assigned to
different marks

As a means of pre-weighting specific classes, some schools assign
higher grade points or earned credits to marks in more difficult classes
and lower grade points or earned credits to the same marks in less
difficult classes.

Setting Up Attendance in School Setup

To track student attendance using Attendance, you need to make decisions
about the following items in School Setup:

(d Daily and Period Attendance Codes
d Reporting Terms for Attendance

d Day Types

1 Daily Calendar

In School Setup, choose options from the Attendance menu.
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Daily and Period Attendance Codes

When you have determined how often your school records Attendance, set
up Daily and Period Attendance Codes. Check with your principal to be
sure that you enter the correct codes, especially if your district has
standards.

Reporting Terms for Attendance

If you include Attendance information on report cards or if you generate
reports displaying Attendance data, set this information. Usually this
information will be the same as what you set up in “Setting Scheduler
Terms” on page 50.

Define Day Types

Find out how your school defines and calls its different Attendance Day
Types. Day Types are how you define days in terms of the attendance
taken. Examples include Snow day, Professional Development day, and
Sports day. These days have specific names and attendance values.

Daily Calendar

Each year, set up the Daily Calendar by assigning the applicable Day Type
to all of the days in the school year. You need the dates of all holidays and
Professional Development days before setting up this information.

If your school uses the Relative Day cycle, assign Relative Days to all days
in the school year.
To assign Relative days to a school year:

1 In School Setup, click the Scheduler menu, then double-click
Timetable Structure.

2 Select the Relative days radio button and select the number of days
from the “Days in cycle” popup menu. Click OK.

3 In School Setup, click the Attendance menu, then double-click Daily
Calendar.

4 Highlight the first day of the school year and click the Assign Relative
Day number, then click Auto.

5 Click OK.

Setting Up Scanning in School Setup
If your school is scanning course requests, set up course numbers so that
they are unique and numeric.
To set up course numbers for scanning:

1 In School Setup, click the Courses menu, then double-click Course
Numbers.
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2 Select the Unique and Numeric radio buttons, then click OK.

If you want to use the CSL-897 (Using COL) scan form to scan
alphanumeric course requests, select Unique and Alphanumeric.

Setting Up User-Defined Information

There might be some specific data for students, teachers, or courses, which
your school needs to track and which cannot be entered into any of the
regular Win School fields. In some cases, this data can be state or province
specific.

To track this data, you can set up your own user-defined fields, flags, codes,
or lists to appear in Details:

e A field is where you type text, numbers, or dates, up to 15 characters.
For example, to store a student work phone number, a teacher license
plate number, or the date of each final exam for a course, you define a
field and its format for this information in School Setup, then enter the
appropriate information in Details.

e A flag takes a yes or no answer. For instance, to store data about
whether a student has a part-time job, or if a teacher is a blood donor,
or if a course has field trips, set up a flag for this information in School
Setup, then enter the appropriate response for it in Details.

e A code allows you to choose 1 code from a popup menu. The date of
each code is automatically entered and you can add comments to that
code.

e Alist allows you to choose 1 item from a popup menu.

When a user-defined flag, field, code, or list appears in Details, it looks like
part of Win School. Also use this type of data in reports with filters and
constraints.

Setting Up Custom Tabs

In addition to user-defined information, you can set up custom tabs with
custom fields, lists, and codes. You can define up to 200 fields, 100 lists,
and 50 codes that you can use in up to 10 custom tabs for Courses,
Teachers, and Students.

If you use the Custom Tab Designer, anyone who has access to School
Setup can change or delete the custom tabs you have designed, including
the data in the custom fields, lists, and codes. You can set up password
access for custom tabs.

You can import data into custom tabs, and you can export custom tab data.

For more information on using the Custom Tab Designer, see the School
Setup Guide.
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Setting Up Multi-Data Tabs

You can set up Multi-Data tabs with repeating fields, lists, and codes. You
can define up to 20 fields that you can use in up to 5 Multi-Data tabs
Students, 2 Multi-Data tabs for Teachers, and 2 Multi-Data tabs for
Courses.

If you use the Multi-Data tabs, anyone who has access to School Setup can
change or delete the Multi-Data tabs you have designed, including its data.
You can set up password access for Multi-Data tabs.

You can import data into Multi-Data tabs, and you can export Multi-Data
tab data.

For more information on using Multi-Data tabs, see the School Setup
Guide.

Setting Up Scheduler Data in Details

If you don’t use Scheduler, skip this section. The Scheduler Guide has a
complete list of all data set up in Details.

The areas which affect Scheduler, and which need decisions are:

e The Scheduler tab in Course Details. Check that appropriate
information is entered for each course. All information entered in this
tab is used by Scheduler.

e The Periods tab in Course Details. Set up timetable information for
each section of a course. The settings in this tab are for each section or
class, not for the entire course.

Working within school guidelines, be very flexible with these settings.
For example, highlight all or as many “Usable Blocks/Periods” as you
can and enter No in the “All sections in the same blocks” field. Being

flexible reduces possible scheduling conflicts.

If your school has study halls in which you place students with free periods,
create a Study Hall course. In the Periods tab for this course, select all
blocks as usable, then enter 1 or No where applicable in the Other
block/period info section.

To have a study hall available each period, set up 1 section per block per
term. For example, if you have 40 blocks and 2 terms, manually set up 80
sections, assigning 40 to the first term and 40 to the second term.

e The Lists tab in Course Details. Establish whether a course is required
for any program at your school. Required courses are scheduled before
electives. Flag a course as both Required and Requested if you want to
automatically request that course for all students in a program.

If students have a choice of required courses, those courses will be
flagged as Required but not Requested.

Setting Up Win School e Entering Information in School Setup 59



Win School System Administrator

For example, a program might require students to take either Biology
or Chemistry. Both Biology and Chemistry would be flagged Required.
However, neither would be flagged Requested because you wouldn’t
want all the students in that program to request both courses.

If a course has room preferences, set them up in this dialog. Be as
flexible as possible and set up all possible rooms and room types.

The Scheduler tab in Teacher Details. Set the maximum number of
blocks each teacher can teach and their course and room preferences.

Course and room preferences are critical components of the scheduling
process. You can determine the rooms and courses a teacher is assigned
by setting preferences high for rooms and courses. To be scheduled,
both a course and a teacher must have preferences set for at least 1 of
the same rooms.

Setting Up Report Cards and eClass Grades

This section shows how to set up Report Cards and eClass Grades at your
school. No matter what type of electronic marking software is used,
establish policies for entering student marks into Report Cards.

The policies must cover the procedures in these sections:

Setting Report Cards Preferences

Establishing Class Rank and Honor Roll Criteria
Managing the Comments file

Choosing the Points & Credits file for your school
Managing Report Cards without eClass Grades

Managing eClass Grades files

Setting Report Cards Preferences

You must set up each workstation running Report Cards with identical
Preferences for: Win School : System, Win School : User, and the Report
Cards module.

If Preferences are not set up exactly the same in each workstation, problems
might occur in:

how Auto-Fill translates percentages or letter grades
how GPA is calculated
how Report Cards tracks daily attendance information

whether students’ inactive classes are displayed

For specific information on Preferences, see the Report Cards Guide.
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Establishing Class Rank and Honor Roll Criteria

Find out what your school uses to calculate Class Rank and Honor Roll in
terms of the grades, bins, courses, and programs included in these
calculations, as well as whether your school includes inactive students
when calculating these items.

Also determine the GPA percentage, course, and attendance criteria for
promoting or retaining students.

Set up this information in Report Cards. For more information, see
“Generating Class Rank and Honor Roll” on page 97.

Managing Comments Files

Comments appear on student report cards and provide extra information
about academic performance and assessment.

Assign a code to each comment when you create it. eClass Grades comment
codes are numeric, and Marks comment codes are alphanumeric. If your
school or district uses both modules, use only numeric codes for comments.
eClass Grades re-numbers comment codes.

A Comments file for a school could number in the hundreds, so adopt 1 of
the following strategies:

e Use different themes for different groups of comments.

For example, reserve the first 50 Comment codes for addressing
positive behavior, the next 50 for disruptive behavior, and so on. Give
teachers the thematic groupings and their codes.

e Assign each teacher or department a range of Comment codes, so they
can create their own comments.

Assigning comments can be more personal and specific with this
approach. For example, teacher A uses codes 1 to 30 and so on.

Another advantage is that your school can have a wider range of
comments because teachers can use each other’s comments.

Set up this information in Report Cards. For more information, see the
Report Cards Guide.

Naming and Storing Archive Files

If your school keeps Archive files (formerly called Transcript files) for
graduated students, establish a naming convention for these files and decide
where you are going to store them.

If you change Bin names or numbering systems over the years, you will not
be able to manage Archive Files. For example, 1991 Bin 9 becomes Bin 11
in 1992. If this happens, go back to the original 1991 files and re-name
them to create archives.

Store Archive files where Win School can access them, such as on a server
if running multi-user, or on your local hard drive for single-user. We
recommend you create a new file for each year.
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Using Report Cards without eClass Grades

If teachers in your school are not using eClass Grades, decide:

(d How marks will be entered into Report Cards. There are 2 ways to

enter marks into Report Cards: manually or using an optical scanner
with the Scanning module. Decide which approach your school will
use, and consider the cost-effectiveness of using a scanner.

When marks will be entered. Set up a schedule with teachers to submit
marks. Marks can be entered at any time during the term, but set a
deadline for each term. As it takes time to enter or scan marks, verify
them, and print report cards, allow a few days between the submission
deadline and generating reports or report cards.

How marks will be verified. Before generating report cards, check for
blank marks fields. You can create a template in Report Manager to
print the names of students who have a blank mark field. Then give this
report to the teachers. For more information on creating a Report
Manager template, see “Using the Marks Verification Report and the
Missing Bin Marks Report” on page 81.

Include marks verification in the report-card generating process.

Working with eClass Grades

If teachers in your school use eClass Grades, there are several issues to
consider:

Identity of the Mentor Teacher for eClass Grades data management.
See the eClass Grades Guide.

Location of the data files for each teacher.

eClass Grades files are backed up or updated more easily if they are
located in an accessible folder, rather than on diskette. If teachers run
eClass Grades either on the same computer that runs Report Cards, or
on a connected computer, write files to a folder. Some schools put a
computer in the staff room or in a computer lab.

Timing of writing the marks file for each teacher.

Update rosters regularly and manage edits to student data.

When to upload term grades into Report Cards.

To generate reports or to generate report cards, have all data transferred
into Report Cards. Set a date to receive all marks files, and allow a few
days between the deadline and generating reports or report cards.

Where to edit Report Cards data.

If marks are edited in Report Cards, the next upload will overwrite
changes. Only edit in Report Cards when no further uploads are
expected.
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e  Marks Verification process.

Include marks verification in your report cards process. Check for
blank mark fields with the Missing Bin Marks Report in Report Cards.

Generate the Marks Verification Report and give to teachers to check
the accuracy of reported marks before distribution in report cards.

Use these reports no matter how the marks are entered into the Report
Cards module.

Setting Up Attendance

If your school takes attendance once a day, setup is fairly simple. If your

school takes attendance twice-daily or by period, setup is more complex,

and includes setting up the Period to Daily Link for each daily attendance
code. Win School uses this Link to calculate daily attendance codes from
the period attendance codes.

Set up daily attendance codes and period attendance codes in School Setup.
See the School Setup Guide for more information.

Setting the Period to Daily Link

If your school takes attendance twice-daily or by period, set up the Period
to Daily Link for each daily attendance code. Win School uses this Link to
calculate daily attendance codes from period attendance codes.

To set the Period to Daily Link:

1 In School Setup, establish your daily attendance code criteria with
functions in the Attendance menu.

2 Decide which type of Period to Daily Link your school will use:
Occurrence-Based or Sample-Based. See following sections.

3 In the Attendance module, choose Period to Daily Link from the Edit
menu, then select an option and edit the dialog.

4  Test your Links.

Establishing Daily Attendance Code Criteria

Regardless of which Period to Daily Link type you use, first define the
criteria for each daily attendance code. Some provinces and states base
school funding on attendance totals, so you might need to check with your
district or your principal.

For example, if a student is absent 3 out of 8 periods in 1 day, is the student
present that day or absent half the day? What if 1 of the absences was
unexcused while the other 2 were excused? Is there a difference? If a
student is present for only 1 out of 8 periods, which daily attendance code is
assigned? These are a few of the types of issues you must resolve.
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Attendance calculates a daily attendance code for each student based on the
information you set up.

Using Occurrence-Based Attendance

Occurrence-based Period to Daily Link calculates daily attendance codes by
looking for a specific number of period attendance codes. Set up the
definitions for each calculation based on:

If Y period attendance code happens at least X times during the
selected periods, then Z daily attendance code is assigned.

Set up a series of these definitions, and when you run Period to Daily Link,
Attendance finds and assigns the corresponding daily attendance code.

As shown in the first row in the following figure, if a student is present 7
periods during the 7 selected periods, the student is assigned a present daily
attendance code.

Period to Daily Link

Minimum Period Code
Sequence Occurences Resulting Daily Code Periods Examined

I ‘ N
1 1|k Present b Fresent 1T 2 3 4 ]

4 1|k Ay Absence b Absent/Present 1 2 3 4 5 B |7 8

3 1|k Tardy b Fresent 1 2 3 4 5 6 |7 8

4 1 b Abs. Unexcused b Off Track 1 5

5 1 » @9 )5 P Off Track (1 [2 |3 [4 [5 |6 [7 [& ]

Select Period(s) To Be Examined

¥ Cross-reference with students' class timetable atlink time

Mew Link Delete Link Cancel | Daone I

Using Sample-Based Attendance

Sample-based is more specific, more powerful, and requires more setup
work, because you can incorporate “and” (as a Boolean operator) into your
definitions.

Your definitions can expand the criteria necessary for a specific daily
attendance code:

If X period attendance code happens during these specified periods and
if Y period attendance code happens during these specified periods,
then Z daily attendance code is assigned.

You have to be specific with each definition, so you will create a more
comprehensive series of definitions than you would using Occurrence-
based attendance. The following figure shows the detail required for each
daily attendance code.
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Testing Your Links

Each definition serves as a “sample” of a student day. Attendance goes
through each Daily Code Equivalent until it matches the period attendance
record of the student. Again, sequence order of the links is very important.

A slashed zero (&) is displayed when you want to ignore a period.

Period to Daily Link ]
Period Short Code
Daily Code Equivalent 1 2 3 41 5 b 7 8
Il | e
Absent/Present v} v} v} v}
Absent/Present ] 0] 0] 0] a a a o]
Absent/Present a a a o] o] g 2] 2]
Absent/Present a a a a fu} fu} fu} a
Absent/Present 9} 9} a a Jul Jul Jul a
Off Track, Suspended Mot Enralled Present =
Absent/Present Field Trip Present/Absent Professional Day
Tardy Tardy Excused e
New Link | Delete Link| Cancel Done

It is very easy to mismanage a scenario and assign an incorrect daily
attendance code. Setting the Period to Daily Link requires that you think of
every possible occurrence or combination of period attendance codes.
During this process you must consider many hypothetical scenarios.

Using either the sample data or real data from your students, run the Period
to Daily Link to ensure students are assigned the correct daily attendance
code.

Setting Up Report Manager

To set up Report Manager, determine what reports, labels, or letters your
school generates.

Covering Your Reporting Needs

You know the form letters, reports, and labels your school requires. Decide
which built-in reports in Win School meet these needs by reading about
reports in the guide for each module.

Create custom reports using Report Manager where built-in reports don’t
match the needs of your school.
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Also create the templates your school uses for report cards and transcripts.
Design the information needed for these templates before starting to create
them.

The next chapter “Preparing for a New School Year,” describes how to
create the following templates:

d Report Card
(d Transcript

(d Mailing Labels
(1  Failure List

a

Marks Verification
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Preparing for a New School Year

Overview

This chapter outlines preparing your database for the coming school year. If
your school used Win School in the previous school year, perform these
tasks on the next year database, and use this section with “Ending the
School Year” on page 131.

If this is the first year your school uses Win School, incorporate the tasks in
this section into your Win School set up and implementation. Use the
instructions in “Scheduling Your School” on page 113 to schedule your
school before the first day of classes.

This section includes procedures for designing Report Manager templates
because the best time to design and test new templates or update existing
ones, is before the start of the school year.

This section describes the following tasks:
e Changing Enrollment Dates
e Updating Student Data

How to update student homeroom, Conduct code, and Status code
information.

e  Printing Timetables

Before school starts, print and distribute timetables to students as well
as print and distribute teacher timetables and class rosters to teachers.

e Deleting Empty Classes

e Creating Bin Files

e Creating Transfers

e Designing Report Manager Templates

An overview of designing some of the templates your school requires:
report cards, transcripts, and mailing labels. Templates for marks
verification and failure list reports are also described.

Preparing for a New School Year e Overview 67



Win School System Administrator

Changing Enroliment Dates

When you enroll students in Details, the current date is assigned as the
Enrollment date.

If your school policy requires that new students have the first day of school
as their Enrollment date, you must enter that date on their Codes tab in
Details. Before the Enrollment date, these new students won’t be
considered active and their names will be italicized when they are displayed
to show that they are inactive. Furthermore, to schedule these students
using Scheduler, you must check the Show Inactive Students checkbox in
Preferences under the Edit menu.

Another approach is to leave the Enrollment date, schedule all students,
then change all new students’ enrollment dates using Select/Replace/Assign
in Details.

To change Enroliment dates using Select/Replace/Assign:

1  In the Details Main window, click the Students icon.

2 From the Edit menu, choose Select/Replace/Assign.

3 If you already have items selected in the Main window, the Selected
Items Found dialog appears. Choose the radio button you want and
click OK to display the Search Criteria tab.

Selected tems Found m

Some items are currently selected. Do you want to:

& Select { Replace } Assign the currently selected items.;

 Clear all selections and search all items.

" Search and add any found items to the selected set.

oK I Cancel

4 In the upper list, make sure the End of List marker is highlighted. If
not, highlight the End of List marker, the horizontal bar under the last
field.

5 Inthe Search Criteria tab, click Codes in the Category list at the bottom
left.

6 In the Field Palette list, double-click Status Codes [Multiple Items].
Four Status Code smart items appear in the top section.

In the Status Code (Long) row, select Enrolled in the Value column.
In the Status Code Date row, select start at in the Relation column.

In the Value column, enter the first day on which to change a new
student Enrollment date, usually the first day of summer.
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Search Criteria Replacement ¥ alues |
Field Relation Yalue Dperator
P [ Status Codes A
I Status Code [Long) P equalto  Enrallied I b and
I 5 de D ate b start at 01 JuL 99 3 B and
3 Status Code Comments B equalto N 0
-
Category Field Palette
Enraliment - |
Perzonal
Contacts
Miscellaneous
Conduct Codes
Uszer Defined
- -

Add

| Remuvel Clear All

Cancel | 0K I

7  Click the Replacement Values tab.

8 Click Codes in the Category list.

9

In the Field Palette list, double-click Status Codes [Multiple Items].

Four Status Code smart items appear in the top section.

In the Status Code Date row, enter the first day of the school year in the
Value column, then select Applicable in the Replacement Method

column and click OK.

Status Code Comments

Search Criteria Replacement Values
Replacement
Field Yalue Method
Statuz Codes b replace first match |0
Status Code [Long) [ Mg P not applicable
St e Date 07 SEF 93 b applicable
2

nat applicable

Category
Enralment
Personal
Contacts

Miscelaneous
Conduct Codes
Uszer Defined

Field Palette
: |

w

Add

| Removel CIearAIIl Cancel | 0K I

Any student enrolled since the date you specify in the Search Criteria
tab will be assigned the first day of school as their enrollment date.
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The Replace/Assign Information report appears listing every student
whose enrollment date was changed.

e To print this report, choose Print from the System menu at the top left
of the window.

vf:‘-,Replac:e { Assign Information

. —_—

Mail.. | Completed 100% Stop|
Sanve As.. fted ...

ment data fields were successully mo
Eestare emert data fields were successully mo
howe emert data fields were successfully mo
Size emert data fields were successfully mo
= . ement data fields were successtully mo
kinimize hplete.
kaximize
Close Alt+F4

Updating Student Data

When you use Next Year Prep to create your data folder for the coming
school year, you can advance students to the next grade level. All student
data remains the same as in the previous school year until you change the
grade level.

To update a student record for the new school year, complete these tasks
according to school policy:

e Change Homerooms
e (Clear Conduct Codes

e Assign New Status Codes

Changing Homerooms

Each year you will usually assign students to new homerooms. If your
school uses Scheduler, you can do it in that module. Otherwise assign
homerooms in Details.

There are 2 ways you can use Details to assign new homerooms, either
manually in each student Enrollment dialog, or by using
Select/Replace/Assign.

For more information on Select/Replace/Assign, see Changing Multiple
Records in the Details Guide.
To change homerooms using Select/Replace/Assign in Details:

1  In the Details Main window, choose the Students view, then select all
the students you want to assign to a particular homeroom.

2 From the Edit menu, choose Select/Replace/Assign.

3 In the Selected Items Found dialog, choose “Select/Replace/Assign the
currently selected items.” Click OK to display the Search Criteria tab.
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~N O B

Selected tems Found m

Some items are currently selected. Do you want to:

& Select { Replace } Assign the currently selected items.;

 Clear all selections and search all items.

" Search and add any found items to the selected set.

oK I Cancel

Click the Replacement Values tab.
In the Category list at the bottom left, click Enrollment.
In the Field Palette list, double-click Student Homeroom.

In the upper list, select the homeroom you want to assign to the
selected students from the popup list in the Value column, then click
OK.

The Replace/Assign Information report appears. If you want to print
this report, choose Print from the System menu.

The selected students are assigned to the homeroom.

Repeat Steps 1 through 7 until you’ve assigned each student a
homeroom.

Using Scheduler to Assign Homerooms
If your school uses Scheduler, you can assign homerooms in 2 ways:

Clearing Conduct Codes

Create a block and a course especially for homerooms and
automatically schedule students into it when you create student
timetables.

After you’ve created the school timetable, use Assign Homerooms from
the Schedule menu.

Some schools clear student conduct records each year.

Depending on school policy, you might clear all conduct records or only
clear some Conduct codes, opting to keep specific Conduct codes on file.

For example, some schools keep permanent records of more severe
infractions, like weapon possession.

For a conduct record to be deleted, it must meet all of the criteria you set up
for it. Unless you have specific reasons for selecting other options, only
select the infractions you want to delete.
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To clear Conduct codes:

1 In the Details Main window, choose the Students view.
2 Shift-click a checkbox to select all students.

3 From the Edit menu, choose Select/Replace/Assign.

In the Selected Items Found dialog, select “Clear all selections and
search all items.” Click OK.

4  Click the Replacement Values tab.
In the Category list, click Conduct Codes.
In the Field Palette list, double-click Conduct Codes [Multiple Items].

In the upper list, scroll to the top of the list and highlight Conduct
Codes.

Leave the Value field blank.
5 Select Delete All from the Replacement Method popup list.
To delete all Conduct records, click OK.
6 To delete specific Conduct codes, highlight Conduct Code (Long).

From the Value popup list, choose the first Conduct code you want to
delete.

From the Replacement Method popup menu, select Applicable, then
click OK.

7  Repeat Step 6 for different codes.

For more information on Select/Replace/Assign, see the Details Guide.

Assigning New Status Codes

Some schools have a policy of re-enrolling students each year, after
assigning Withdraw status codes at the end of the previous school year.

If your school doesn’t track student enrollment this way, skip this section.

Some states and provinces require that enrollment be tracked in a specific
manner, so check the guidelines for your school.

A student with a Withdraw code is considered inactive. To schedule
inactive students, start Details and choose Preferences from the Edit menu.
From the Miscellaneous tab, select “Show all inactive classes and
students.”

To assign a new Status code to all students:

1 In the Details Main window, click the Students icon.

2 Shift-click a checkbox to select all students, then deselect those
students not returning to your school.

3 From the Edit menu, choose Select/Replace/Assign.
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Printing Timetables

In the Selected Items Found dialog, select “Select/Replace/Assign the
currently selected items.” Click OK.

Click the Replacement Values tab.

In the Category list, click Codes.

In the Field Palette list, double-click Status Codes [Multiple Items].
In the upper list, highlight Status Codes.

Leave the Value field blank.

Select Add to Existing from the Replacement Method popup list.
Highlight Status Code (Long).

From the Value popup list, select the Status code you want to assign to
the selected students.

From the Replacement Method popup menu, select Applicable.

If necessary, type a different date in the Value field for Status Code
Date and select Applicable in the Replacement Method column.

To enter a comment for all students being assigned a new Status code,
type the comment in the Value field for Status Code Comments and
select Applicable in the Replacement Method column.

You must set up your Preferences and Print Options before you print and
distribute timetable information.

Set up Preferences and Print Options:

1
2

Start Scheduler.

From the Edit menu, choose Preferences, then set up the following
information:

e If you use Resource Mapping, select Use Resource Mapping.

e If you schedule students into classes taught at other schools, select
Show All District Items.

e To show when classes actually meet, or if you use period
scrambling, select the Show Actual Periods radio button.
Otherwise, select the Show Scrambled Periods radio button.

If you store print-outs in a binder, set the left margin to at least 1 inch.
From the Shell System menu, choose Margin Setup and enter the
margins you want.

To print student or teacher timetables or class rosters:

1

In Scheduler, select students or teachers in the Students, Teachers, or
Classes view.
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2 From the Reports menu, choose a Timetable.

3

Select the options to print.
Select the timetable days and terms to include in the timetable.

If you want to print a message on student timetables, type text in the
Report Message text box.

Click OK.

Deleting Empty Classes

If, after scheduling, you have empty classes that you are sure no students
will transfer into, delete them. Deleting empty classes speeds up Win
School operation.

To delete empty classes:

1
2
3

Start Scheduler.
From the Windows menu, choose Sections.

In the Sections dialog, highlight the course. All of the classes for that
course appear in the bottom section of the dialog.

If the class you want to delete has no students scheduled in it, highlight
it. Empty classes have 0 students scheduled.

Press Delete.

Repeat Steps 3 through 5 for each class.

Designing Report Manager Templates

The best time to design Report Manager templates is before school starts.

This section gives an overview of designing the templates most schools
require, including:

Report Cards
Transcripts

There are 2 types of transcript templates: 1 for students still attending
your school and 1 for students who have left your school.

Mailing Labels

Some other templates are outlined:

Failure List

Marks Verification
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Designing a Report Card Template

This section describes an example of a report card template by outlining its

3 parts:

e Header
e Body

e Footer

This section also describes how to define smart items, an important step in
designing report card templates.

Although the template outlined in this section contains many of the report
card items schools require, you must be sure your template includes
appropriate information for your school.

There are 2 approaches you can take to designing report card templates:
e Design a template displaying information for the entire school year.

e Design a template displaying information for only 1 term or bin, then
duplicate the template for each term it will be used and modify the
smart items.

Setting Up the Template

When you set up the template, define it for Report Cards then use the
Students - Classes path.

e  “Stretch” smart items to center their text.

e  Most Smart Items in the header are from the Main level.

® School Name Description
PROGRESS REFORT

ﬁ Current Date |

You can stretch smart items,

Most smart items in the header and center the text

are from the Main level

Designing the Header and Footer

If you want your report card to contain header and footer information, place
text and graphics, and smart items from the System category only, in the
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header and footer spaces. This information appears on every page of the
report.

The System category contains smart items for the current date, page
number, and general information about your school. You can also place text
or graphics in headers and footers.

Drag the fixed header/footer bars over existing template objects to place
them in the header or footer. Objects must be either completely in the
working area of the template, or completely in the header/footer.

See the Report Manager Guide for more information.

Designing the Body

The body of your report card contains information about students, classes,
marks, and attendance. Choose the main category of information based on
the purpose of the report. All smart items must be selected from the sub-
categories of only 1 category.

If clicking the T tool icon does not activate the text tool, choose Text from
the Insert menu. Use the same process for graphics and smart items.

Associate each text and graphic item in the body of the report with a smart
item. Click the Object Association tool (second from the right), then click a
smart item box, and Shift-click each text box. When associated, each text
box has blue handles and the smart item has green handles.

Use Line Control tool to draw all lines

Use Text Boxes for titles
[ /_ Set up Smart Items below titles Use a Text Box for standard information

—
Student ||P

Student Name I Grade l - Counselor

: ] .
= Student MNomber]| [@ Student Name

W Student J§ |@  Counselor

ClassfTeacher

| Q1 | Q2 | Mid | Q3:| Q4| This Quarter's Comments

|2 Course Name |

[@Bin| | @Bin] | [@Bin] |[2Bin]|[@EBin] @ Bin Comment

|{§)Teacher Mame |

g‘l‘imes Present

‘@Bin Fresent | ;Sc:hnul Message

gTimes Absent

‘@Bin Ahsent ‘

§Times Late

‘@ Bin Late ‘
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If this is a report for 1 term, duplicate the template for each term and
redefine smart items specifically for each term.

Test each template individually to ensure you’ve defined smart items
correctly.

Defining Formats and Smart ltems
Double-click a smart item to display options such as phone number and date.

Double-click the circle in a smart item with the Arrow tool, to open the
format dialog.

+ Smart ltem Definition H[=] E3
Bin Present
Format Yalue
| .
Use Attendance B alues Define bins in
Bin B o1 / Smart ltems with
Decimals 1| this popup menu
Ok Cancel

Double-click a rectangle to open a format dialog for rectangles.
Double-click a line to open a format dialog for line style, color, and width.

To format text and the text of smart items, select text, then from the Set
menu, select Object Attributes, then Smart Items and Text.

Designing Transcript Templates
In order to print transcripts, design 2 different templates:
e A transcript template for students currently attending your school

e A transcript template for students graduated from your school

Designing Transcripts for Currently Enrolled Students

This section describes an example of a transcript template you can use to
print transcripts for students currently attending your school. The following
example might not contain all the items you need. However, use this section
as a model when you design your transcripts.

When you complete your template, test it using student data.
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Use smart items from the
Student sub-categories for
demographic information and
cumulative academic totals

Use smart items from the
System category to print
school information in the
header and footer

Schfol Name Description

o |

EXNI School Address 1

EXNNI /  &chool Address Cirg|@&chool Address State
EXNI / School Address Zip Code

&3 Principal Mame Telephone: : ) Bchool Phone

gElirthdate

[2Student Nanfe

Curmuiat g GRA, @ Cumulaty] Total Credits Earned: & Curnalativel Btudert Humber: ¢ [@Student Number
=5 [@¥ears| Credits eamed in yeari [@Yeard

Course Code! Grade! Pass/Fall;

BHame | [ Hurnber | BEn

Use smart items from the —/
Student/Classes sub-category to
print classes and mark information.

Transcript Date: | [ Current Date

Hamecrp A THHEEETT N " E i

Designing Transcripts for Graduated Students

Designing the transcript template for graduated students is similar to
designing the transcript template for current students. However, use
archival smart items which are located in the Archive Years sub-category of
the Students category.

Using Other Report Manager Templates

You can use Report Manager to create the customized reports your school
needs that are not already built into Win School:

e  Mailing labels (for laser printers)
e Failure list report

e Marks Verification report

The procedures in this section assume you know how to use the Report
Manager Toolbar. For more information, read the Report Manager Guide.

Even if these templates do not specifically apply to your school, still go
through this section for insight into the whole process.

Designing Mailing Labels (for Laser Printers)

Your school probably needs mailing labels for sending letters or report
cards to parents. Create a mailing label template either using macros, as
described in the following procedures, or using smart item objects.
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The labels used in the 2 figures below are laser labels that print 3 labels
across and 33 to a sheet.

Most schools print mailing labels in conjunction with report cards, so this
template is usually assigned to Report Cards and smart items from the
Students category.

To design a mailing label template:

1 Count the number of labels on a sheet and measure the length and
width of 1 label.

2 In Report Manager, open a new template.

3 From the Set menu, choose Number of Columns, then enter the number
of columns that are on a label sheet, and click OK.

4  Double-click the Smart Item tool to open the Smart Item window.

5 Double-click Student, then Contact Information to display selections.
Then follow the instructions in the following figure.

Ei. Mailing Label 3

Eile

Edit Miew |nsen Set Arange  Win

DRI N EEEEE]

e e S0

1

1D
C |.|1.|.I.|.|2.| raw a text box

In
0]

|

the size of the mailing label

= ontact Title @ Contact Mame
@ Contact ﬁ{_jdrESS 1 \ | 2 With the cursor inside the
@ Contact City  |[@Contact Zip text box, double-click the
_ode Contact Title smart item,
add a space, then
X double-click the Contact Name
smart item

3 Draw the other smart items
outside the text box, then drag
them into position inside the text box

If smart items disappear while placing them, click anywhere outside the text
box and all smart items will re-appear.

Before you use this template, test it by selecting students and printing 1
page of labels. You might have to edit the text box or the font size of your
template.
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Designing a Failure List Report
You can design a report for students receiving failing marks and the classes
they are failing.

When you’ve created this template, apply Constraints to all smart items
from the Classes sub-category, including any Bin smart items, so only
students with failing marks are reported.

Applying and Defining Constraints
e When printing a report, click the Constraints button to add and edit
reporting constraints.

e To define a constrained smart item, double-click it. All Bin smart items
must be defined.

Place a constraint delimiter
Place the smart item you want to constrain

Select a Relation

Enter constraining information

General | Student Classes
[ ] [ /
j I Smart ltem / Relation / YWalue Operator
b { | BWLetter Grade b Bqualto » b b ar =
4 Bin Letter Grade b equalto E b b ar
b Bin Letter Grade b equalto F 3 f) ]
I

/ |

\ Place the ending delimite f
[b Sorby Tile | |\ Ing detimrter ’
Select the Operator

\ Double-click a Smart ltem to edit it
Category utle

N | T I [T

Class Info

Marks - Calculated
barks from Bin
FEIMS Info
Fepart Card Info
Foom Info

Schedule Info -
| I

=
&
=
L =
=
=
=
=

Add | Remove Clear All Cancel OK
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Testing a Template

Using the Marks Verification Report and the Missing Bin Marks
Reports

Verifying marks is part of the report-card generating process. Occasionally,
teachers forget to enter a mark and empty mark fields appear on report
cards, or they enter marks incorrectly.

Use the Missing Bin Marks Report to report empty mark fields to teachers.
They can fill in the missing mark and return the report, or update the
database, depending on your policy.

Use the Marks Verification Report to give to teachers for checking the
accuracy of reported marks before distribution in report cards.

You can change the templates, and save them in different formats for
different purposes. Use Save As in the File menu to rename templates, and
save them for different terms. Re-define the bins appropriately on each
template.

Use these reports no matter how the marks get entered into the Report
Cards module.

When you finish designing or changing a template, test it to ensure that
printed data lines up the way you intended.

Test each template individually to be sure smart items are defined correctly.
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Starting the New School Year

Overview
The first weeks of a school year are busy in terms of last minute edits,
especially with student timetable information.

To be sure timetable and class changes are updated throughout Win School,
you must rebuild roster and wait list information and re-create Transfer
files, then either generate eClass Grades class files or update them.

If your school uses Transfer Recording, we recommend you wait until you
have finalized student timetables before switching it on.

When you have completed edits to class rosters and student timetables, you
can delete student course requests.

This chapter contains the following sections:
e Editing Student Timetables

e  Generating eClass Grades files

e  Using Transfer Recording

e Deleting Course Requests

Editing Student Timetables
Usually, the first week of school or the first week of a term is when students
drop and change classes.

If you used Report Cards to create your class rosters, edit the appropriate
rosters. For more information, see the Report Cards Guide.

If you used Scheduler to schedule your school, edit student timetables. The
following instructions describe how to modify a student timetable by
dropping and adding classes during specific periods.

You can print the Course Timetable report to see what classes are available
and when they are taught.

To edit a student timetable:

1  Start Scheduler in multi-user mode, and double-click the student whose
timetable you want to edit.

2 In the View Classes section, click “In School” to display all the classes
taught in your school.

In the Enter by section, click Year to schedule the student into a class
for all of the terms it meets.
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In the Timetable Term section, highlight the term in which you are
editing the student timetable.

3 In the list of classes in the middle of the window, highlight the class
into which you want to schedule the student. Triangles appear in the
periods the class meets.

4  In the timetable, double-click 1 of the periods displaying a triangle and
the student will be scheduled into that class.

When you edit a student timetable, you can schedule a student into a class
that is full. Use the VCR buttons in the middle section to select Students
and monitor class capacity.

Generating eClass Grades Files

As described in “Working with eClass Grades” on page 62, there are 2
approaches to writing eClass Grades Class Roster files:

e  Generate them before the school year so teachers can set up tasks, then
update them when class rosters have been finalized.

e  Wait until class rosters have been finalized then generate and distribute
them.

Either way, the procedure for generating and updating is the same.

Manage teacher data by folder, so that each teacher has a master folder with
full rights. The teacher can write eClass Grades information to folders
within their own master folder.

Any school can use any combination of the following methods for marks
transfer:

e  ASCII Transfer
e Optical scanning
e eClass Grades for Macintosh or Windows

As System Administrator, establish Report Cards bins for your school, with
a naming convention that each teacher follows. Be sure teachers have
access to their folders. Teacher folders should not be inside the Win School
folder, as the Win School folder should only be accessible by the System
Administrator.

Make sure all eClass folders are included in your daily backup.

Preparing to Generate Class Rosters for eClass Grades

The Mentor Teacher and the Report Cards user set up everything teachers
need to get started using eClass Grades. The Mentor Teacher sets up
generic class files in eClass Grades to contain the school standards for
grading, grading periods, summaries, grading-scale calculations, and
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comments. The generic class files can be developed for departmental or
grade-level use.

Style files and templates may also be created by the Mentor Teacher for
grade-level or departmental use in reporting.

Other teachers copy the generic and style files as a base for their own
marking and reporting.

The Report Cards User is a support person or teacher who updates teacher
gradebook rosters, collects term marks, calculates class averages and honor
rolls, and prints report cards.

The Report Cards User exports setup files from the Win School Report
Cards module at the beginning of the year.

To generate class rosters:
1  Mentor Teacher: create Generic class files in eClass Grades.

2 Report Cards user: in Report Cards, choose “Write Teachers’ Classes”
from the Marks menu to create class rosters. They contain class and
teacher name, and names of all students for each class.

Werite the Class Files to the folder or network location where the
teachers can access them.

After teachers have exported term marks from eClass Grades, import
those term marks into the Report Cards module.

Updating an eClass Grades file has no effect on marks (or grades) already
entered.

Using Transfer Recording

Transfer Recording records every student transfer between grade levels,
homerooms, tracks, and normal programs.

Use Transfer Recording only if your school needs to because it adds
another step every time you edit student data, and increases the size of your
database.

If your school is not year-round, turn Transfer Recording off while
preparing data in the next year database. Then turn it on when student
timetables have settled after the first weeks of a term or school year.

If your school is not a year-round school, use Transfer Recording only in
the following instances:

e If your school takes Classroom Attendance by Homeroom.

e If your school needs to display transfer information on report cards, the
Grade Statistical Summary report in Attendance, or any Universal
Access or State/Prov report calculating data based on homeroom or
grade level.
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If your school is a year-round school, turn on Transfer Recording to
maintain Attendance data for students who move to a different track.
To use Transfer Recording:

1 In School Setup, choose Transfer Recording from the School menu.

2 Select Yes or No, then click OK.

Deleting Course Requests

When you have finalized student timetables and you are certain you will
not need student course requests during the school year, you can delete this
information to reduce the size of your data folder and to speed up Scheduler
operation.

If your school needs to use student course requests, especially electives or
alternative requests, do not delete course requests.

To delete course requests:
1 In Scheduler, select all students.
2 From the Schedule menu, choose Change Students.

3 Select “Clear Requests” and “Clear Alternates,” then click Perform.
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Working Through the School Year

Overview

This chapter outlines some of the tasks which don’t occur at specific times,
but happen either at regular intervals or at any time throughout the school
year.

The tasks outlined in this section are specific to you as a Win School
System Administrator. Other tasks usually done by other Win School users
throughout the year, such as entering attendance, tracking student marks,
and generating reports, are covered in the Getting Started Guide and in the
specific guides for each module.

The following tasks are described in this section:
e Identifying Current Users

e Updating Win School

e Initializing Attendance Days

e Changing Relative Days

e Changing Bins Used in District Extract Files
e Changing Details Information

Whenever you change any data in Details, you must be sure that these
changes are updated in student timetables and report card bins.

e Globally Changing Information

e Deleting Students

e Rescheduling or Replacing Teachers

e Viewing Student or Teacher Information

You can view information for students currently in your school and for
graduated students. You can only view information for teachers who
are currently at your school.

e  Printing Transcripts

Identifying Current Users

If you are using Win School multi-user and you need to shut down the Win
School server, you must first notify all users to save their work and quit
Win School. Otherwise they could lose their work. You can find out who is
logged on by running the Administrator Log report.
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To generate the Administrator Log report:
1 Start Win School and log on as the Administrator.
2 From the Shell menu, choose Administrator Log.

3 To print the report, choose Print from the System menu.

Initializing Attendance Days
Before you can record attendance for a day, you must initialize it. You
should initialize a day only when you need to record attendance.
e Double-click a date in the Attendance module calendar to initialize it.

If your school scans attendance, you must initialize all the days in a
scanning period before printing scan forms.

Updating Win School

Whenever Chancery Software sends you new versions of Win School
modules, back up your data and install these modules using the
accompanying instructions.

Design a way to update the appropriate workstations on the same day
because you must never have different versions of a module using the
database at the same time. To see the version of each module, see “Check
Versions” on page 31.

Working with Relative Days
If your school uses the Relative Day cycle, you might have to adjust your
schedule for special events or occasions that cause your school to close.

For example, if weather forces your school to shut down on a Day 3, your
school policy might require that the next full day of classes is Day 3, not
the Day 4 as originally set up.

To reschedule a Relative Day:

Start School Setup.

In the Attendance menu, double-click Daily Calendar.
Highlight the first day your school did not operate normally.
Click Clear.

Double-click the Day Type you want to assign to it.

Repeat for each day you need to re-assign the Day Type.
Highlight the next full day of classes.

00 N N Lt AW -

Click the Relative Day number. That school day will now be that
Relative Day.
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9  Click Auto to adjust the rest of the schedule. Although you’ve changed
the Relative Day for 1 day, the rest of the cycle is not updated until you
click Auto.

Changing Bins Used in District Extract Files

If your District uses District Data Integrator (DDI), you need to generate
District Extract files. If you generate District Extract files, you will
occasionally have to change the included bins.

Report Card bins are some of the larger components of these files, so
limiting the included bins will speed up transfer time and reduce file size.
Your district should arrange a schedule for changing specific bin
information.

To change bins used in District Extract Files:

1 In School Setup, click Report Cards then double-click Report Card
Bins.

2 In the Bin In Use column, select Yes for every bin you want included
in the District Extract file.

Report Card Bins...
Bin In

Bin Bin Mame Use

1 Tst Quarter B Mo -
2 | 2nd Quarter P Mes =
3 | 1st Semester Exam P es

4 | 1=t Semester Average poe:
5 | 3rd Quarter B No

6 | dth Quarter B ez

7 | 2nd Semester Exam B Wes

8 | 2nd Semester Average B Yes

9 Final Average P es

10 10 B Mo ~

Print... Cancel 0K

Changing Information in Course Details

Validating Timetables

If you change any information in Course Details after scheduling your
school, you must perform the following procedures to be sure that Win
School data uses the changes:

e Validate Timetables

o (lear/Set Bin Information

When you change information in Course Details, those changes are not
automatically reflected in the school or student timetables, especially if you
change any of the course credit information.
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To validate timetables:
1 In Scheduler, choose Validate from the Schedule menu.

2 In the Confirmation dialog that appears, click OK. All timetables are
validated and match the course information in Details.

Running Clear/Set Bin Information

To reset Course Details data in Report Cards, run Clear/Set Bin
Information.

You can only run Clear/Set Bin Information as a Single-User. Therefore,
generate the Current Users report to ensure you are the only Report Cards
user. See “Identifying Current Users” on page 86.

To Clear/Set Bin Information:

1 In the Report Cards Main window, select the classes edited in Course
Details or shift-click to select all classes.

2 Select all students.
From the Edit menu, choose Clear/Set Bin Information.

4 In the Clear/Set: All Selected Classes dialog, select the bins to update
and other options. If you are unsure, select everything.

5 Click OK.

Changing Information Globally in Win School

Using Select/Replace/Assign in Details can save you a great deal of time
and work. You can use it on student, teacher, or course data.

Use Select/Replace/Assign for any of these tasks:

e Select specific items for generating reports

e Replace specific data with some other value

e Assign specific data to selected items

e  Assign the same homeroom to students in various homerooms

For more information on Select/Replace/Assign, see the Details Guide.

Deleting Students

There are only 2 times when you delete a student in Win School:

e After you run the Year End procedures and are clearing out the
graduated students from the next year database.
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e At the beginning of the school year when one of the new students you
registered doesn’t attend your school.

Otherwise, only change a Status Code in Student Details to make a student
inactive.

Rescheduling or Replacing Teachers

If a teacher leaves your school during the school year, you have to assign
their classes to another teacher.
To assign a teacher to another teacher’s classes:

1 If a teacher is new to your school, check that their information is
entered in Details.

2 Start Scheduler in Master mode.

If Scheduler starts only in Multi-User mode, generate the Administrator
Log to see who is using Win School and ask them to quit while you
perform this task. For more information, see “Identifying Current
Users” on page 86.

3 From the Windows menu, choose School Timetable.
4 In the Class Name column, highlight the class you want to assign.

5 In the Class Timetable section, highlight 1 of the periods in which the
class is taught.

6 In the Teacher Name column, double-click the teacher you want to
assign to the class.

7  Repeat for all classes that need re-scheduling.

8 Close the School Timetable window when you are finished. Your
changes are saved.

Viewing Student or Teacher Information

Use Query to view information about students or teachers currently in your
school. Using Query, you can view the information about a student for the
current school year and for any of the previous years the student was
enrolled in your school.

Query is a view-only module, so no data can be entered, modified, or
deleted. We recommend you train all users at your school on how to use
Query.

To view information about students who have graduated or who have left
your school, use Report Cards to view Historical or Archive information.
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Using Query

Instead of starting Report Cards, Details, or Attendance to view
information, start Query where you can view all information in 1 place.

Users can view anything in the following modules for which they have
“Edit” or “View” access: Attendance, Teacher and Student Details, and
Report Cards. For more information on setting access levels, see “Setting
Up Other Win School Users” on page 45.

For specific lists of the information displayed in Query, see the Getting
Started Guide.

Viewing Historical and Archived Information

The Student Historical window displays class, mark, and attendance
information from previous years for students who are currently in your
school. Historical data can be created automatically from Win School data
you have entered using the Update Historical File command, or it can be
imported using a file from another computer, or it can be entered manually.

An Archive file contains the Historical files for students who have either
graduated or have left your school plus demographic information because
these students are no longer stored in Details.

To view Historical and/or Archive information, a user must have at least
View access to Historical and/or Archives in School Setup. For more
information about setting user access, see “Setting Up Other Win School
Users” on page 45. Read the Report Cards Guide for more information
about what is displayed in either window.

To view a student Historical file:

1 In the Report Cards Main window, click the Students icon.

2 In the popup menu below the Students icon, choose Historical
information.

3 Double-click the student name to view Historical information.

To view a student Archive file:
1 In Report Cards, choose Load Archive from the Historical menu.

2 Choose the Archive file you want to view and click OK. The Archive
Information window opens.

3 Double-click the student name to view archived historical information.

Printing Transcripts

During the school year, you might generate transcripts for students
currently attending your school or for students who have graduated from
your school.
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To print transcripts for students currently enrolled at your school, use the
template you designed specifically for them, as described in “Designing
Transcripts for Currently Enrolled Students” on page 77.

To print transcripts for students who have graduated from your school, use
the template you designed specifically for them, as described in “Designing
Transcripts for Graduated Students” on page 78.

Printing Transcripts for Currently Enrolled Students

For current students, you can print transcripts using only Historical marks
or using both Historical marks and the current year marks in any
calculations.

To print transcripts for students:

I In Report Cards, select the students whose transcripts you want to print.
2 From the Reports menu, choose Custom Templates.

3 Highlight the template for current transcripts and click Print.

4

To include the current year marks, check the Use Report Options
checkbox. Click Print, and then click the Marks tab. Select the
checkbox in the Cumulative Totals section. In the Bins section,
deselect bins you don’t want included in the calculations.

5  Click Print.

6 In the Report window, choose Print from the System menu to print a
paper copy of the transcripts.

Printing Transcripts for Graduated Students

You can print transcripts with only archive information for graduated
students.

To print transcripts for graduated students:
1 In Report Cards, choose Custom Templates from the Reports menu.
2 Highlight the template for graduated-student transcripts and click Print.

3 If you selected the Use Report Options checkbox, set Report Option
Filters and click Print.

4  Locate the Archive file containing the students whose transcripts you
want to print, then click OK.

5 In the Archive Student Selection window, select the students whose
transcripts you want to print, and click Print.

6 In the Report window, choose Print from the System menu to print a
paper copy of the transcripts.
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Ending Each Term

Overview

At the end of each term, most schools print report cards. This chapter
outlines all of the tasks involved in generating report cards.

This chapter also describes how to print the following items:

e Mailing labels

e Honor Roll

e Failure List report

Generating Report Cards

There are 6 steps involved in generating report cards:
1 Ensure that all marks have been entered, including incomplete.

2 If any marks are a result of 2 or more bins averaged, run Consolidate
Bins.

Verify marks.
4 If Attendance is printed on report cards, Write Attendance totals.

5 If Honor Roll or Class Rank information is printed on report cards,
generate the Honor Roll and Class Rank from the Edit menu in Report
Cards.

6  Print report cards.

Ensuring Marks Are Entered

As discussed in “Working with eClass Grades” on page 62, you must
establish a schedule for teachers to get their marks to you in time to be
entered into Report Cards.

Assigning Incomplete and Other Marks

If you need to enter any mark other than a letter grade or a percentage, such
as INC for incomplete, you can do it after marks have been entered into the
Report Cards data or show teachers how to do it in eClass Grades.

Check to see what your school policy is for non-standard marks.
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To assign an Incomplete mark:

1
2

Consolidating Bin Marks

Enter or upload marks into Report Cards.

Start Report Cards and double-click the first student who has a mark of
Incomplete.

Click By Bin, then select from the left popup menu the term the class
was taught.

From the middle popup menu, select the bin into which you are
entering the mark.

From the right popup menu, select Class Info & Marks.

For the class you are assigning the Incomplete mark to, delete any mark
displayed in the Percent column.

In the Letter Grade column, enter what you want displayed on the
student report card, usually INC.

If you don’t want this mark to be included in GPA calculations, select
Used in GPA in the second column, then enter No.

If you don’t want this mark to be included in Earned Credit
calculations, select Used in E. Credits in the second column, then enter
No.

Repeat for every student receiving an Incomplete mark.

On your report cards, some marks, especially final percentages, might be
the calculated average of 2 or more bins.

For example, if term-work marks and the midterm mark produce a final
term mark, consolidate those marks into 1 bin.

To perform these calculations, use Consolidate Bins in Report Cards. For
more information, see the Report Cards Guide. Perform these calculations
before teachers verify marks.

Edits made after consolidating bins will not be included in the
consolidation.

To consolidate bin marks:

1

In the Main window, select the students and classes whose marks you
want to consolidate.

From the Marks menu, choose Consolidate Bins.

In the “Consolidate Bins into” popup menu, select the destination bin.
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Consolidate Bins m

Congolidate Bins into IFinaI Average ;I
Earied Credit [E.C.] Caloulations | Calcul [~]
|l Fies i les ol Sum E.C. from Source Bing :
Sum E.C. from Source Bing if Conzolidated % iz Failing
Bin M| &ssign 'Fail' and 0 E.C.if any Bin Failed
1 13t Quarter 1.000 =] ~
2 2nd Quarter 1.000 [
3 15t Semester Exam 1.000 O
4 13t Semester Average 1.000 I
5 2rd Quarter 1.000 ]
g Ath Quarter 1.000 i
7 2nd Semester Exam 1.000 O
g 2nd Semester fverage 1.000 I
9 Final Average 1.000
3 ([l = |
—Flags To Copy
¥ Potential Credits ¥ wieighted Class ™ UserFlag 2
¥ Used in GPA I Iz Final Mark ™ UserFlag 3
¥ Used in Eamed Credits [ Print Flag ™ Usger Flag 4
[v Haonars [ User Flag 1 I~ UserFlag§
Help | Cancel | Ok I
In the “Earned Credit (E.C.) Calculations” popup menu, select a

calculation method.

Use this option

For this result

Calculate Earned
Credits from
Consolidated %

Earned credits and pass/fail status are assigned
from the consolidated percentage, using the Points
& Credits table for the consolidated bin.

Sum Earned
Credits from
Source Bins

Pass/fail status is calculated from the consolidated
percentage, based on the Points & Credits table for
the consolidated bin.

Earned Credits in the consolidated bin will be the
sum of the earned credits in the source bins.

Consolidated percentage is ignored when
calculating Earned Credits.

Sum Earned
Credits from
Source Bins if
Consolidated % is
Failing

Pass/fail status is assigned from the consolidated
percentage based on the Points & Credits table for
the consolidated bin.

If the consolidated percentage is a pass, earned
credits are assigned from the consolidated
percentage based on the Points & Credits table for
the consolidated bin.

If the consolidated percentage is a fail, the earned
credits in the consolidated bin is the sum of the
earned credits in the source bins.
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Use this option For this result

Assign ‘Fail’ and 0 | If a student has a pass in all source bins, earned
Earned Credits if credits and pass/fail status are assigned based on
any Bin Failed the consolidated percentage using the Points &
Credits table assigned to the consolidated bin.

If the student has a fail in any source bin, the
earned credits are 0 and pass/fail status is failing in
the consolidated bin.

In the list of bins, select the source bins from which to take marks.
Enter a weight for each selected bin.
Select options in the Flags To Copy section.

If you select Potential Credits, the potential credits is copied from the
highest-numbered bin that is selected.

Click OK.

As described in “Setting Up Report Cards and eClass Grades” on page 60,
marks verification is part of your report card generating process.

To print the Missing Bin Marks Report:

1

5

In the Shell, from the System menu, choose Page Setup. Select Portrait
orientation, then click OK.

In Report Cards, select all teachers, all students, and all classes.
From the Reports menu, choose Missing Bin Marks Report.

In the Missing Bin Mark Report dialog, select options, then click Print.
To print the report on paper, choose Print from the System menu.

Distribute the report to teachers to provide the missing marks.

To print the Marks Verification Report:

1

In the Shell, from the System menu, choose Page Setup. Select Portrait
orientation, then click OK.

In the module to which you assigned the custom Grades or Marks
Verification Report template, select all teachers, all students, and all
classes.
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3 From the Report menu, choose Marks Verification, then select the bins
to use from the popup menus.

OR

From the Reports menu, choose Custom Templates, then highlight
either:

e Grades Verification Report
e Marks Verification Report
e The verification template you created in Report Manager
4 Click Print.
To print the report on paper, choose Print from the System menu.

6 Distribute the report to teachers to check for accuracy.

Entering Attendance Information in Report Cards

If your school prints only daily attendance on report cards, you can set up a
smart item when you create your report card template in Report Manager.
For more information on creating your report card template, see “Designing
Report Manager Templates” on page 74.

If your school prints period attendance on report cards, this information can
come from Attendance when you copy attendance totals into Report Cards
before printing.

To copy Attendance totals into Report Cards:

1 In Report Cards, select students or classes.

2 From the Marks menu, choose Write Attendance Totals.

3 From the Bin Number popup menu, select the bin number you are using
to print the report card.

4  Enter the term date range in the Date From and Date To fields.
5 In the Students and Classes popup menu, choose Selected or All.

6 Click OK. Attendance totals are written to Report Cards.

Generating Class Rank and Honor Roll

Class Rank and Honor Roll are calculated and generated separately. They
are grouped in this section because their dialogs are the same. After you set
up the Class Rank or Honor Roll dialog, you won’t have to set it up again.

Some of the information you set up in the Attendance & Marks dialog of
the Class Rank dialog is used at the end of the school year for promoting or
graduating students.
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To generate Class Rank or Honor Roll:

1 In Report Cards, if students are retained for having failing marks in
specific courses, select those courses in the Main window.

2 From the Edit menu, choose either Class Rank or Honor Roll.

3 In the Students & Courses tab, set up the following information based
on your school criteria:

e Whether to include or ignore inactive students.

e Grades for which you are calculating Class Rank or Honor Roll.
e Bins used in these calculations.

e Courses your school doesn’t include in these calculations.

e Programs included in these calculations. If you include students not
in any program or if your school has no programs, select N/A.

4 In the Attendance & Marks tab, set up the following information:

e Set Class Rank Criteria: current year marks or current year marks
and Historical marks.

e Criteria for promoting students based on GPA, Earned Credit, or
Percentage calculations.

e  Whether students with failing marks in any course or selected
courses are included in these calculations.

e Attendance criteria for promoting or retaining students.
e Courses used in these calculations.
Click OK.

5 If you are calculating Class Rank, specify whether you are generating
only Class Rank or both Class Rank and Weighted Class Rank.

Specify whether you are doing calculations for All Students or Selected
Students.

6 Click Continue. Your school Class Rank or Honor Roll is calculated.

Printing Report Cards

When you have completed all of the other tasks outlined in this section,
print your report cards using the Report Manager template you created.

For more information on creating a report card template, see “Designing a
Report Card Template” on page 75.
To print your report cards:

1 In Report Cards, choose Sort from the Edit menu and sort the student
records in the order you want report cards printed.

2 From the Reports menu, choose Custom Template and highlight your
report card template.
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3 Click Print. A Report window displays the first report card.

The status bar at the top of the window displays the progress of
generating report cards.

4 When Win School is finished generating the report cards, choose Print
from the System menu to print on paper.

Printing Mailing Labels

If your school mails report cards, you need to print mailing labels for the
report cards. For more information about creating a mailing label template,
see “Designing Mailing Labels (for Laser Printers)” on page 78.

To print mailing labels:

1 In Report Cards, choose Sort from the Edit menu and sort students as
they were sorted when you printed the report cards.

2 From the Report menu, choose Custom Template, and highlight a
mailing label template.

3 Click Print. A Report window displays the mailing labels.

4  Make sure there are mailing labels in the laser printer, then choose
Print from the System menu.

You might want to print a few labels to make sure they print correctly.

Printing End of Term Reports

In addition to printing report cards, there are other reports which you
usually generate at the end of each term. If your district uses District Data
Integrator, the end of term is usually when you generate District Extract
files and transfer them to the district office.

An Honor Roll might be another report you need at this time.

Use the templates you designed in “Using Other Report Manager
Templates” on page 78.

Printing Attendance and State/Prov Reports

Some districts and states or provinces require specific reports at the end of
each term.

Consult with your principal and your district office to ensure you generate
all necessary reports.
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Printing a Failure List

If your school tracks students with a failing mark, print the Failure List
report you created using a Report Manager template. Counselors might
need to review this information.

These instructions are specific to the template described in “Using Other
Report Manager Templates” on page 78. If you created your own template,
what you select in the Main window will be based on the smart items you
use.

To print a Failure List:

1 In Report Cards, choose Custom Template from the Report menu.

2 Highlight the Failure List template and click Print.

3 From the System menu, choose Print to print a paper copy.
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Setting Up the Next School Year

Overview

In the middle of the school year, you need to create a Win School database
for the next school year. This allows you to enroll incoming students and
schedule the coming school year. This process is described in “Running
Next Year Prep” on page 101.

For the rest of the year, you do most of your work in your current year
database, and some work in the next year database. For guidelines, see
“Working with More than One Data Directory” on page 108.

The tasks are described in this section, in the order they must be completed:
¢ Running Next Year Prep.

Back up your current year data, then, in Windows, create a data folder
for the coming school year. From the Shell menu, choose Next Year
Prep to select next year’s directory.

e Working with More than One Data Directory.

Devise a system to ensure data is entered into the correct folder. This
section outlines what data you can edit in each database.

e Enrolling Students.

Start enrolling the new students coming to your school in the next year
data folder.

e  Planning Scheduling Strategy.
e Manually Scheduling Your School.

e Automatically Scheduling Your School.

Running Next Year Prep

Each school year requires a separate data folder. This data folder can be on
the same server or a different server.

The Next Year Prep process copies the relevant data from your current year
folder into a new data folder. All current year data except attendance and
marks data is copied into your new data folder.

The Next Year Prep process involves the following tasks:

O Setting Up Next Year Prep: You need to set up your current year’s
Report Card data, back up your current year’s data, and create a data
directory for next year’s data.
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Running Next Year Prep: Next Year Prep duplicates the current year’s
data (excluding attendance and mark information) and places it in the
directory you set up for it.

Accessing Next Year’s Data: You need to set up the Win School Next
Year Shell icon to access your next year data.

Deleting Scheduler’s Timetables and Requests: Because the next year
database contains the Scheduler data from the current year, you might
want to either delete the files or keep the current year’s school
timetable to use for next year’s schedule.

Deleting Classes Created in Report Cards: If you used Report Cards’
Edit Classes function to write your class rosters for the year, you will
want to either delete classes or remove students from them.

Advancing Students Into the Next Grade: In the next school year, most
students will be a grade higher than their current grade, so you have to
increment all students’ grades.

Before you run Next Year Prep, you must set up any Report Cards data you
need to access in next year’s database, create a directory for next year’s
database, and back up your current year’s data.

If your school runs Win School multi-user, you must perform all these
procedures at the same workstation.

These instructions show you how to create a data directory on the same
drive and in the same directory as your current year’s database, which
means it will get backed up during your daily backup.

To set up Next Year Prep:

1

If you want to sort students by Class Rank in next year’s database, you
must calculate Class Rank information in Report Cards by choosing
Class Rank from the Edit menu. See “Generating Class Rank and
Honor Roll” on page 97.

Write down the data path for the current year’s data. This information
is displayed in the Win School Shell. Usually, the data path is
something like C:\WINSCHL\DATA.

Quit the Shell.
Back up your current year’s data.

If you are using Win School multi-user, log onto the Win School server
as the administrator.

If you are using Win School single-user, create a directory for next
year’s database that you can access using the computer running Win
School. This new directory should follow the same path you wrote
down in step 2 except for a different name for the last part of the path.
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Running Next Year Prep

The last part of the path is the name of the current year’s data directory;
therefore, you must type a name for your next year’s data directory, a
name which references the school year. For example, use “DATA9900”
to name the 1999-2000 school year’s data directory.

Write down the information of next year’s directory as you need it
when you run Next Year Prep and to access next year’s data. If you are
using multiple servers, write down the server information including the
server IP address and port number.

After you set up your next year’s data directory, you can run Next Year
Prep. Running Next Year Prep copies all your current year data except
attendance data and current year marks into your new data directory.

If you are running Win School multi-user, you must ensure no other users
are logged on to Win School before you run Next Year Prep because
running Next Year Prep locks your database and they will lose their work.
Use the Administrator Log from the Shell menu in Win School Shell to find
out who is running Win School, then ask them to save their work and log

off.

To run Next Year Prep:

1
2
3

5

Start the Win School Shell.
From the Shell menu, choose Next Year Prep.

In the Select Next Year’s Directory dialog, double-click next year’s
data folder so that it is open. Click OK.

Win School creates next year’s database and displays the Next Year
Prep dialog. Specify the location of the Win School icon to access next
year’s database. Click OK.

Next Year Prep m

Mext “rear Prep will add a new icon to the
Pragram Folder listed below. You can type a
new falder name, or select an existing folder
from the list.

Exizting Folders:
|

ACCessones -
Adobe

Chancery Products
Main

M5 Office 4.2

M5 Office 57
Morton Antivirug
Other Proarams

[ o 1]

[

Cancel |

The folder with next year’s database icon is opened, and a message
informs you that Next Year Prep is complete.
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6 Click OK.
7 Quit the Win School Shell.

After running Next Year Prep, we recommend you do not delete students
from the current year’s data. Similarly, add new courses, students, or
teachers pertaining to next year in the next year database. If you need to add
any students, teachers, or courses to the current year’s database, you also
have to add that information to the next year’s database.

Accessing Next Year’s Data in Single-User Mode

Once you’ve run Next Year Prep, you have to set up the Win School Next
Year Shell to access next year’s database.

Do not rename your next year data directory.

You need to know the path to next year’s data, which you wrote down
while performing the instructions in “Setting Up Next Year Prep” on page
102.

You must perform this procedure at every computer that needs to access
next year’s data.

If you are running the multi-user version of Win School, you must ensure
each workstation accesses the hard disk containing next year’s data using
the same drive letter it uses to access the current year’s data. Although you
can set up more than one workstation to access this data, it is single-user
access, so only one person can access next year’s data at a time.

To set up your Next Year Shell:
1 Locate the Win School Next Year Shell icon.
2 Right-click the icon, and choose Properties from the popup menu.
3 Click the Shortcut tab. Make sure the Target field ends with a zero, a
space, and the path to your next year’s data directory, for example:
Win School 9900 Properties EHE
General Shortcutl

%’SE win School 3300

Target bype: Application

Target location: Maodules

Target: I\M odulestCelshell ewe 0 C:vwINSCHLADAT ASI00Y

Start ir: IE:\WINSEHL\MDDULES

Shortcut key: INone

Bur: I Mormal window ;I

Find Target... | Qhangelcon...l

QK I Cancel | Apply |
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Click OK.
Test the Next Year Shell icon by double-clicking it.

If you get an error message stating that you have an “Invalid Directory
for the Win School database,” click OK. The path you typed in the
Properties dialog does not describe an existing directory. Repeat steps 2
and 3 and ensure you type a valid path.

In the password screen, type your ID and Password and press Enter.

In the Shell window, the “Data path =" line should show your next
year’s data directory.

If it does not, Quit the Shell and redo this procedure.

If it does, you have correctly set up that Shell to access next year’s data
in single-user mode. Choose Quit from the File menu.

If your school has the multi-user version of Win School, repeat this
procedure at all computers that need to access next year’s data.

Accessing Next Year’s Data in Multi-User Mode

Once you’ve run Next Year Prep, you have to set up the Win School Next
Year Shell to access next year’s database.

To access next year’s database:

1

Start the next year database server. See “Starting, Stopping, and
Quitting the NT Server” on pages 12 and 18.

Set up client workstations that need to access next year’s database. See
“Setting Up Workstations” on page 13. This creates the icon to access
next year’s database.

Double-click next year’s database icon.

If you cannot connect to next year’s database, check that the database
server is running and that the IP address and port is correct. See
“Starting, Stopping, and Quitting the NT Server” on pages 12 and 18,
and “Noting TCP/IP Configuration” on page 10, respectively.

Deleting Scheduler’s Timetables and Requests

If you used Scheduler to schedule the current school year, your next year’s
data will contain the timetables and requests for the current school year.

You can either delete all of this information or delete only student requests
and keep the current year’s class timetables to use for next year’s schedule.

To delete Scheduler information:

1
2

Start the Next Year Shell.

Start Scheduler in Master mode.
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To keep the current year’s class timetables, proceed to step 5.
OR

To delete class timetables, choose New Schedule from the Schedule
menu.

In the Confirmation dialog that appears, click OK.

In Scheduler’s Main window, select all students by Shift-clicking a
student’s checkbox.

From the Schedule menu, choose Change Students.

e If you want to delete student requests, select “Clear Requests” and
“Clear Alternates.”

e If you want to delete student timetables, select “Clear Timetables.”

Change Students B

Far the zelected studentiz]...

W Clear Bequests

V¥ Clear &ltemates

™ Glear Additional Classes

[~ Assign Requests
[ Create Requests from Timetables
[ &dd Co-requisites

[~ Remove Duplicate Requests

[Selected processes will be done in the order in
which they appear, one student at a time]

Perfarm I Cancel I

Click Perform.

From the File menu, choose Quit.

Deleting Classes Created in Report Cards

If you used the Edit Classes dialog in Report Cards to create your class
rosters for the current school year, you might want to delete them or remove
the students from them.

To remove students and delete classes:

1

2
3
4

Start the Next Year Shell.
Start Report Cards.
From the Marks menu, choose Edit Classes.

In the Make Classes tab, click the first class in the upper list. Scroll to
the end of the upper list and hold down the Shift key while you click on
the last class in the list. All classes are selected.
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5 Press the Delete key. All classes are deleted and disappear from the
upper list.

6 Click Done.
7  Quit Report Cards.

To remove students and keep classes:

1 Start the Next Year Shell.

2 Start Report Cards.

3 From the Marks menu, choose Edit Classes.
4

In the Schedule tab, Shift-click a checkbox in the upper list to select all
classes.

(9]

Click Clear Classes. The Clear Classes dialog appears.
6  From the upper popup menu, choose “Clear ALL students.”

7  If most teachers will teach the same classes next year, choose “Do not
clear scheduled teachers” from the lower popup menu. Otherwise,
choose “Clear scheduled teachers as well.”

8 Click OK.
9  Click Done.
10 Quit Report Cards.

Advancing Students into the Next Grade

In the next school year, most students will be one grade higher than they are
currently. The following procedure describes how to start with the highest
grade and promote all students to the next grade level.

If, at the end of the year, some students are retained, manually move those
students back to their former grades and reschedule their classes.

You must start with the highest grade and work your way down the grades.
If you start with the lowest grade and work up, you’ll end up with all your
students in the highest grade.

To advance students in the next grade:

1  Start the Next Year Shell.

2 Start School Setup.

3 Click the School menu, then double-click Define Grade Levels.

4

In the list of grades, find an unused grade (for example, Grade 13), and
change that grade’s short code to Gd, its long code to Graduated,
and its usage to Full Day.

5 Click OK.
6  Quit School Setup.
7 Start Details.
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8 In the Details Main window, click the Students icon.
9  From the Edit menu, choose Select/Replace/Assign.

10 In the Search Criteria tab, set up the following information:

Category Field Palette Relation Value

Enrollment Student Grade (Short) equal to 12

The first time you run this process, the Value must be the short code for
the highest grade in your school. The next time you run it, the grade
should be the second highest in your school, and so on.

11 Click the Replacement Value tab.

12 In the Replacement Value tab, enter the grade higher than the one you
entered on the Search Criteria tab:

Category Field Palette Relation Value

Enrollment Student Grade (Short) equal to Gd

The first time you run this process, the grade will be the Graduated
grade, which has a short code of Gd. The next time you run it, the grade
should be the highest in your school, and so on.

13 Click OK.

14 The Replace/Assign Information window shows the students whose
grades have been incremented. You can print the report by choosing
Print from the System menu. When you have finished looking at the
window, close it.

15 Repeat steps 9 through 14 for each grade in your school.

Working with More than One Data Directory

How you work with two or more data directories depends on whether you
are running Win School single-user or multi-user, and how many data
directories you are working with.

Single User: Accessing Next Year’s Data

If you are running the single-user version of Win School, you cannot run
both Shells at the same time; you can only start either the Next Year Shell
or the current year Shell.

Multi-User: Accessing Next Year’s Data

When you first set up the Next Year Shell, only one user can use it to
access next year’s data. If another user has already started the Next Year
Shell, you will see a dialog informing you that you cannot start the Next
Year Shell at that time.
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Accessing the next year’s data has no effect on users accessing the current
year’s data.

If you have the multi-user version of Win School, the Win School Server
allows multiple users to access one database simultaneously.

Usually, you want multi-user access to the current year’s database. On
occasion, you need multi-user access to next year’s data so that several
people can register new students or manually edit student requests or
timetables.

On those occasions, you must make sure that all your Win School users
understand that the Win School multi-user Shell they use to access the
current year’s data will be accessing next year’s data. During that time, they
will not be able to access the current year’s data.

At the end of the school year, when you’ve completely finished using the
current year’s database, follow these procedures to make the next year
database the current year’s data for the new school year.

To change which data directory the Win School Server NLM loads, see
“Changing the Win School Data Directory” on page 26.

To change which data directory the Win School NT server loads, see
“Changing the Win School Data Directory” on page 14.

Working with More than One Next Year Data Directory

Some schools, particularly those that use Scheduler, create more than one
next year data directory so they can experiment with a variety of scheduling
scenarios.

Usually, they run Next Year Prep to create a next year data directory, enter
all the new students in Details, and enter all the student course requests for
next year, then start scheduling.

Whenever they try a new option, they duplicate the next year’s data
directory and try the new option. If the experiment is unsuccessful, they
delete the duplicated data directory and return to the original. If the
experiment is successful, they continue using that data directory.

To maintain multiple data directories, you must understand how Windows
stores and organizes directories and how to access them using directory
dialogs and paths.

Setting Up Next Year Data

With 2 separate data folders, you need to understand how to maintain these
2 folders until the end of the school year, at which time you perform Year
End processing and use only 1 data folder again.

Changes in 1 folder do not affect the other. You can create new timetables
in the next year folder without disturbing existing timetables. When you
update an address in 1 data folder, that change is not made in the other.
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After the school year ends, use the Year End process in Utilities to
consolidate the data in both folders. The Current Year End option extracts
data from your current database that has changed since you ran Next Year
Prep. The Current/Next Year Merge option uses this data to update next
year’s database.

To run Year End, you must follow guidelines about the data you change
and where you change it. Otherwise, you will overwrite the work you have
done in the next year database and have to redo it.

The following sections outline, by module, what you can and cannot
change.

School Setup: Data You Cannot Change

Do not change the following School Setup information in next year’s data:
e Short codes for popup menu lists

e Withdrawal Inactive Day (School menu)

o Teacher - User Defined (Teachers menu)

e Student Age Reporting Date (Student - General menu)

o Student - User Defined Fields (Students - User Defined menu)

e Student - User Defined Flags (Students - User Defined menu)

In lists for popup menus, do not change the Description for existing items,
because this information will be replaced by the corresponding data from
the current year’s directory.

Do not delete or edit short codes for popup menu lists in either data directory
between the time you run Next Year Prep and the time you perform year end
processing. If you do, the corresponding data fields will not be updated correctly.

O=—3

You can, however, add items to popup menu lists.

School Setup: Data You Can Change

You should update the following information in next year’s data to reflect
the coming school year:

School Menu Rooms Menu | Scheduler Menu Attendance
(if necessary) Menu
School Year Room Types |Set Scheduler Terms |Reporting Terms

for Attendance

Transfer Recording |Room Setup Daily Calendar
(if your school uses
it, turn it off until the
school year begins)
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If your school uses Resource Mapping, add new room clones in next year’s
data directory. Cloned rooms are used when scheduling more than one class
in the same room at the same time.

Teacher Details: Data You Cannot Change

Do not edit any data fields, including address and contact information other
than the fields outlined in “Teacher Details: Data You Can Change” on
page 111. Current/Next Year Merge replaces this data with the
corresponding data from the current year’s data directory.

If you must change the teacher number of an existing teacher between the
time you run Next Year Prep and the time you perform year end processing,
change it in both the current and next year databases.

If a teacher number appears in next year’s data that does not exactly match
a teacher number in the current year’s data, Current/Next Year Merge
assumes you have added a teacher to the current year’s data and logs it as
an error during the Year End process.

Teacher Details: Data You Can Change

In next year’s directory, add all data for any new teachers. Make any
changes to Teacher Teams. If required, add new teachers who teach classes
in the current year to the current year’s data. However, you will have to add
that information to next year’s database too.

If your school uses the Resource Mapping feature, add new teacher clones
in next year’s data directory.

Most of the information in next year’s data directory for existing teachers
will be replaced by data from the current year’s data directory. Therefore,
for existing teachers, make only these changes in the following fields:

Personal tab Scheduler tab
Active Scheduling Teacher
Department Type

Homeroom Aide Type
Administrator Max No. of blocks...
Counselor Course Preferences
Dept. Head Room Preferences
Substitute

Position

Track
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Course Details

Edit course information and add new courses pertaining to next year in next
year’s database only. Modifications to course information are not
transferred from the current year’s data to next year’s data.

Student Details: Data You Cannot Change

In next year’s data, do not edit student demographic data for students
currently in the school, including address, contacts, groups, health
information and user-definable items. Current/Next Year Merge replaces
this data with the corresponding data from the current year’s data directory.

If you must change the student number of an existing student between the
time you run Next Year Prep and the time you perform year end processing,
change it in both the current and next year databases.

If a student number appears in next year’s data does not exactly match a
student number in the current year’s data, Current/Next Year Merge
assumes you have added a student to the current year’s data and logs it as
an error during the Year End process.

Student Details: Data You Can Change

Add all data for any new students in next year’s data directory. If required,
you can add new students who attend classes in the current year to the
current year’s data. However, you will also have to add their information to
next year’s database.

Most information in next year’s data directory for existing students is
replaced by data from the current year’s data directory. Therefore, change
only the following fields for existing students:

Personal tab Groups tab

Grade Level Normal Program

Homeroom Special Program
Counselor
Track

Report Cards/Scheduler: Data You Cannot Change

Do not make changes in next year’s data directory to state or provincial
data fields that are unrelated to Scheduler or course information, because
they will be overwritten with the corresponding data from the current year’s
database.

In Report Cards, do not enter or edit Historical information in next year’s
database for students who are in your current year database. The Year End
process will replace those students’ Historical information in next year’s
database with the Historical information from the current year’s database.
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Enrolling Students

Report Cards/Scheduler: Data You Can Change

If your localization uses additional Scheduler or course-related data
elements, you can edit them in next year’s database.

If your school uses Scheduler, you can start working on your next year’s
schedule at this time.

If your school uses Report Cards’ Edit Classes function, you can start
writing your classes at this time.

In the next year data folder, enroll all new students starting at your school
in the coming school year. See “Choosing a Data Entry Method” on page
38, for an overview of how to enroll students.

When you enroll students, they are assigned the current date as their
Enrollment date. If your school requires that the Enrollment date be the first
day of school, see “Changing Enrollment Dates” on page 68.

Scheduling Your School

If this year is the first year your school is using Win School, create your
schedule before the start of the school year. After using Win School for
more than 1 year, start scheduling your school in the middle of the school
year, using the next year data folder.

Everything that follows in this section provides an overview of the
scheduling process, gives some tips, and lists the decisions you need to
make. The Scheduler Guide is more comprehensive and describes how to
use all of the functions in Scheduler.

Choosing How to Use Scheduler

You can use Scheduler to manually or automatically schedule your school,

or in combination. You can automatically schedule some information, save

it, then schedule the rest manually, or schedule some information manually,
lock it, then automatically schedule the rest.

Scheduler takes many factors into account when it schedules automatically,
so there is more specific setup work involved than if you manually
schedule. Depending on how complex your school schedule is,
automatically scheduling your school can take a lot of time. You always
need more than 1 scheduling run, trying various options to arrive at an
optimal schedule.
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Scheduling Manually

These are the steps to manually scheduling your school:
1 Ensure you’ve set up all of the necessary data in the other modules.
2 Enter sections for all of the courses at your school.

3 Create your school timetable by scheduling classes, teachers, and
rooms.

4 Create student timetables by scheduling their classes.

This section describes these steps in detail. If you mix manual and
automatic scheduling for your school, you will also have to consult
“Scheduling Automatically” on page 117.

When you have completed scheduling your school, you can print
timetables, as described in “Printing Timetables” on page 73.

Setting Up Win School Data for Scheduling

Check the Scheduler Guide for a comprehensive list of the mandatory data
setup items.

Creating Sections or Classes

In Win School, a section and a class mean the same thing. It is 1 instance of
a course, scheduled in a room with a teacher and a group of students.

Even if there is only 1 class taught for a course, you must create a section
for that class. Calculate how many sections you need for each course before
entering information into Scheduler. The number of sections you set up can
be determined by the following:

e adistrict or school policy
e the number of students who took the course last year

available teachers

e the number of students taking a pre-requisite course

Some schools choose to use Scheduler to automatically do this portion of
their scheduling and then continue manually. To use Scheduler to
automatically create sections, you must first enter student requests. For
more information, see “Entering Non-Required Requests” on page 118.
To create sections for courses:

1 In Scheduler, choose Set Sections from the Schedule menu.

2 If a Confirmation dialog appears, click OK.

3 In the Sections window, the first course is highlighted.
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4 Double-click a course to add another section or class in the bottom part
of the Sections window. The new section is red until you select terms.

5 Click a term cell to select or deselect it.

6 Repeat for every course at your school. Work your way down the list of
courses.

Creating Your School Timetable

When you’ve determined the number of sections for each course, you can
schedule each section into a period and a room and assign a teacher.

Manual scheduling overrides the teacher block information you set up in
School Setup and Details, so you must not schedule a teacher into too many
blocks in total or too many consecutive blocks.

If you set up room or teacher preferences, the preferred teacher and room
for a class appear green when you schedule that class.

If your school has teachers assigned to other schools in Details, rooms
assigned to other schools in School Setup, or courses flagged Yes for
District Use Only in Scheduler dialogs in Details, select “Show All District
Items” in the Scheduler Preferences dialog. Otherwise, these items will not
be displayed in the School Timetable window, and you will be unable to
schedule them.

See “Creating the School Timetable” in the Scheduler Guide for the
complete procedure.

General procedure for creating school timetable:

1 Inthe Scheduler Main window, click the Classes icon to display a list
of all classes.

2 To open the School Timetable dialog, double-click a class.
At the top of the School Timetable dialog, select the setup you need.

4  In the “Enter by:” section, click Period to schedule with maximum
flexibility. Click Year or Term to schedule into the same period all term
or all year.

5 In the “Class Display Mode:” section, click Difficulties to view
potential difficulties of scheduling a class into a specific period. This
generates the Conflict Matrix.

6 Complete the following tasks:
e in the Class Name column, highlight a class
e in Timetable Term, select the term
e in the Teacher Name column, highlight a teacher
¢ in the Room Number column, highlight a room

e in the Class Timetable area, double-click a room to schedule the
highlighted class
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5 Double-click a period to schedule the highlighted class

Scheduling Students into Classes

When you have created your school timetable, start scheduling students into
classes.

Manually scheduling students overrides the class capacity information you
set in Details. Therefore, monitor the Students column in the Classes Main
window to ensure you don’t schedule too many students into a class.

You can also use the Scheduler Multi-Paste feature to schedule more than 1
student into a class.

To manage what occurs when you schedule a student twice in a specific
period, set Preferences from the Edit menu.

Change Preferences sparingly to prevent inconsistencies in student timetables.

The following procedure is the general process for multi-pasting students
into classes. If you assigned course requests to students, use “Setting
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Student Requests” on page 119, or if you are only scheduling 1 student, use
“Editing Student Timetables” on page 82.

For more information on Multi Pasting, and on scheduling a single student,
see the Scheduler Guide.
To manually Multi-Paste students into classes:

1 In Scheduler Preferences, select an option from the “When Pasting
Classes” section to control how conflicting classes are handled. If you
select Remove Periods that conflict with paste or Remove Classes that
conflict with paste, any classes conflicting with the class being pasted
are removed from the schedule.

2 Highlight a class in the Classes Main window, and choose Copy from
the Edit menu.

3 If you are copying a timetable and/or request list from a student, select
Requests and/or Timetable.

4 Click OK.

5 In the Students Main window, select the students for pasting, then
choose Multi-Paste from the Edit menu.

A status bar reports the progress of the procedure.

Scheduling Automatically

Automatically scheduling your school involves the following chronological
tasks.

Although these steps are in chronological order, you will backtrack through
them and through previous procedures to assemble your timetable.

To schedule automatically:

Set up Scheduler Data.

Set Student Course Requests.

Set Sections.

Load Teachers.

Schedule Specialty Classes (Optional).
Create Your School Timetable.
Finalize Your School Timetable.

Schedule Students.

O 0 N N B B WD =

Finalize Student Timetables.

These sections describe specific components of the scheduling process and
provide some insight while giving some tips. Every school is different, so
there is no perfect model to use to automatically schedule your school.
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You might have to schedule some items manually at the end of the
scheduling cycle for 2 reasons:

e Even with its complex algorithm, Scheduler cannot cover every
scenario and might require you to make some decisions.

e Scheduler works within the guidelines you set up for it, and if
something falls outside the guidelines, it will not be able to
accommodate. Again, you might need to make some decisions on
scheduling.

Setting Up Scheduler Data

In the Scheduler Guide, there is a comprehensive list of the data you must
set up to use Scheduler. For more information on the data you set up in
School Setup and Details, see “Setting Up Rooms in School Setup” on page
49, and “Setting Up Scheduler Data in Details” on page 59.

Setting Student Requests

When you’ve set up all of the necessary data for Scheduler, set student
course requests.

There are 2 steps involved in setting student course requests:

1 Assigning Required Requests. Automatically assign students a course
request for all the courses in their program.

2  Entering Non-Required Requests. After assigning student requests for
required courses, enter requests for courses which are not required.

Assigning Required Requests

In Scheduler, choose Assign Requests from the Schedule menu to assign
each student a request for any course flagged Requested in Course Details.
Scheduler will assign only requests for courses in the same program and
grade level as the students are assigned.

The Assign Request command clears all student requests before assigning
required requests, so never use the Assign Request command after you've
entered any non-required requests.

O—3]

Entering Non-Required Requests

After you assign required requests; enter other, non-required requests
(electives).

You can use the following methods to enter student requests:

e Scanning: If your school has a scanner, you can use Scanning to enter
student course requests. See the Scanning and ASCII Transfer Guide.
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Setting Sections

e Importing: If you store student course requests in another program, you
can use ASCII Transfer to transfer them into Win School. See the
Scanning and ASCII Transfer Guide.

e Manual Data Entry: In Scheduler, you can edit student course requests.

e  Multi-Paste: To assign course requests to more than 1 student, use
Multi-Paste in Scheduler. See “Scheduling Students into Classes” on
page 117.

Removing Duplicate Requests
Depending on your school policy, students might not be able to take a
course more than once in the current school year.

A duplicate request occurs when a student requests a required course as an
elective or when a course request sheet is scanned more than once.

To remove duplicate requests:

1 In the Students view in Scheduler, select students with duplicate
requests.

2 From the Schedule menu, choose Change Students.
Select Remove Duplicate Requests.

4  Click Perform.

When you have set requests for all students in your school, you can create
sections (classes) for the courses offered at your school.

The first time each school year that you choose Set Sections from the
Schedule menu, Scheduler creates sections for each course based on student
requests and the class size figures you set in Details.

After running Set Sections, check the number of sections each course has
against the number of student requests for that course. If necessary,
manually adjust the number of sections in the Sections window.

Setting Study Halls

If you want to have study halls throughout each school day, create a Study
Hall course in Details, then manually set up sections for the number
required. For example, if you have 40 blocks and 2 terms, manually set up
80 sections of the study hall and assign 40 to Term 1 and 40 to Term 2.
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When you have set up sections for each course, load teachers for those
classes. By loading teachers, you establish which teachers can be scheduled
for each class.

The first time each school year that you choose Load Teachers from the
Schedule menu, Scheduler identifies a pool of teachers for each course,
based on the Course Preferences you set up for each teacher in the
Scheduler dialog in Details.

After loading teachers, make sure each course is “fully loaded” with enough
(or even more than enough) teachers. Open the Teaching window from the
Windows menu, and check that each course has enough teachers. Add
teachers to a course pool where necessary.

You can also adjust what courses a teacher is available for to ensure each
teacher has a balanced teaching load.

If your school has 1 teacher teach 2 or more classes at the same time, or has
2 or more teachers teaching in the same room at the same time, use
Resource Mapping before you start scheduling your school. See
“Performing Resource Mapping” on page 129.

Always review the Teaching window to see that each teacher has a
balanced teaching load.

To edit Teacher Loading:

1 In Scheduler, choose Load Teachers from the Schedule menu, then
complete the tasks described in the figure below:

e in the Course Name column, highlight a course

e in the Teacher Name column, highlight a teacher name to display
the teacher’s class load

e in the Courses for column, highlight a class to edit the loading

e in the middle area, enter a number in the middle columns for the
load

e monitor the load

2 Monitor the Maximum Load and Course Preferences totals when
editing this information.
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Scrambling Periods

If your school wants to schedule classes so they are taught in different
periods during the week instead of during the same period each day, you
can scramble periods before you schedule any classes.

See the Scheduler Guide for details.

Scheduling Special Cases (Optional)

Before performing the Create Timetable process, set up or schedule the
following items if they apply to your school:

e Setting Up Clusters and Teams.

If your school uses Student Clusters and Teacher Teams, set up and
load this information before scheduling.

e (Class Combining.

If your school has classes that meet at the same time, in the same room
with the same teacher, combine these classes.

e Reserving Teachers and Rooms.

To ensure a teacher or room doesn’t get scheduled during a specific
scheduling block, you can reserve them.
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e  Manually Scheduling and Locking Classes.

If any course must be held in a specific period, you must manually
schedule it and lock it.

Setting Up Clusters and Teams

When you set up Clusters and Teams, you can have students take their
required courses in 2 ways: always with the same classmates, or with
different classmates. For specific information about Student Clustering and
Team Teaching, consult the Scheduler Guide.

To set up Clusters and Teams:

1 From the Schedule menu, choose Clusters & Teams, and set options in
the top of the dialog.

Clusters & Teams

Mommal Program __ Students ITeamW LI oK. I
-
Teacher Name Teams |
Academic 12 27 EanceS
Yocational 11 20 Dl |
Yocational 12 15 Maicos, Imelda 1
Advanced Placement 11 B Load... |
Advanced Placement 12 7
v i Delete |
Cluster | 1 Cluster | 2 Cluster | 3
Courses Requests Teams: 3 Teams: 3 Teams: 3
Jas |
[ =
1 1 1
Biclogy 11 41 Fickle | 1 Fickle | 1 Fickle
Biology Lab 11 301 “Wwioo 1 “Woo 1 Wwoo
Computer Science 11 401 1 1
—

2 To keep students in the same group, enter different numbers in the
Cluster field (default).

3 Torandomly assign courses, enter the same cluster number in each
Cluster field.

Class Combining

If you have any classes that meet at the same time, in the same room with
the same teacher, combine those classes. This function is useful for multi-
grade or multi-disciplinary classes.

To combine classes:

1 In Course Details, click the Scheduler tab, and set “Allow Class
Combining” to Yes.

2 In Scheduler, from the Schedule menu, choose Class Combining.
In the Class Combining dialog, set options.

4  Click OK to combine classes.
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Reserving Teachers and Rooms

If any room or teacher has to be reserved for any reason, reserve them
before you create your school timetable.

For example, a room might be needed for a regular meeting. Similarly, a
teacher might only work mornings or need specific time for preparation,
meetings, or office hours. Reserve items only if essential; otherwise, you
place unnecessary limitations on Scheduler.

You reserve rooms or teachers for specific blocks, so you might need to
review how you’ve set up your scheduling blocks, as described in “Setting
Up Scheduler in School Setup” on page 50.

To reserve a room or teacher:

1 In Scheduler, choose School Timetable from the Windows menu.

2 In the “Timetable for:” section, click Teachers or Room.

3 In the “Enter by:” section, click the period of time.

For any timeframe except Year, select a term in the Timetable Term:
box.

4 Highlight an item in Teacher Name or Room Number.

To delete a reservation, in the timetable, highlight the cell to be cleared
and press Delete.

5 Highlight a label in Reserve Label.

6 Double-click the appropriate cell in Teacher Timetable or Room
Timetable at the bottom.

Use the Resource Check report to locate any problems.

Manually Scheduling and Locking Classes

You can only lock a class after you have scheduled it into a room with a
teacher. Before running Create Timetable, manually schedule and lock any
class that must be taught during a specific period.

If you are scheduling automatically, lock each class or the Create Timetable
function will de-schedule your work. You can only lock a class after you’ve
scheduled it into a room with a teacher.

If you are manually scheduling all your classes, you do not have to lock
them.

You can either lock each class as you schedule it or lock all scheduled
classes.
To lock or unlock a particular class:

1 In the School Timetable window, select a class from the Class Name
list.

2 Click the Lock button above and to the left of the Class Name list. A
padlock icon appears beside the locked class.
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To lock or unlock all classes by term:

1 In the Classes Main window, choose Lock Classes from the Schedule
menu.

2 Select (darken) the terms in which you wish to lock or unlock classes.

3 Click Lock or Unlock to start the process. All classes scheduled in the
specified term(s) will be affected. In the Classes view of the Main
window, padlock icons appear in the left margin beside locked classes.

Creating Your School Timetable

After setting up the necessary data and taking care of any specialty classes,
you are ready to create your school timetable using Create Timetable.

This section describes an approach you can take to schedule your school. It
provides some tips and gives you a good head start. However, only by
working with Scheduler and using the Scheduler Guide can you work out a
system that best suits the needs of your school.

Using Create Timetable

Using the Create Timetable dialog, set up the type of scheduling for your
school. The following sections provide some tips for using this dialog.

Create Timetable E

[+ Lookahead — Select teacher for clazs
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[ Keep teachers in homerooms

[V Ignore rooms and teachers
— Start zcheduling with:
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= Momal Courses

Cancel

Pre-Check |
—%Wwhen problem occurs:
Schedule
" Stop
Optimize | " Pause
| & Continue

Setting Potential Conflicts

Allowable Potential Conflicts looks at the number of conflicting requests
for the class before determining that the class cannot be scheduled. Student
requests, teachers, and physical resources are all considered.

Set this number low when you first schedule Linked and Special Courses
and when you first schedule Normal Courses.
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If you have a very restricted schedule, you might need to set this number
higher, and resume Create Timetable. If it is already high and if you
manually scheduled and locked many classes, either unlock some classes
and re-start Create Timetable at Special Courses, or increase the number of
usable blocks for the course.

Using Lookahead

Use Lookahead to examine available rooms and teachers, and check all
sections of a course to find the best room/teacher combination. Lookahead
is useful only for courses with more than 1 section.

Setting Problem Handling

Select Pause to stop the scheduling run, fix the problem, then go on. Select
Stop to stop the scheduling run when a problem is encountered. You will
have to start the scheduling run again. Select Continue to ignore problems
during the scheduling run and fix them later.

For the first scheduling run, select Pause. When a problem occurs, stop the
scheduling run, fix the problem in School Setup or Details and resume
scheduling.

After you’ve finished the first scheduling run and have fixed any major
problems, either select Stop or Continue for the next scheduling runs.

Performing Multiple Scheduling Runs
By selecting the appropriate radio button, you steer Scheduler through the
various runs you perform.

If your school schedules study halls, schedule other classes first. For more
information, see “Assigning Study Hall” on page 129.

First Scheduling Run

If your school has courses which are Linked Groups or Following Triplets
or courses that require all sections be scheduled during the same blocks,
select the Special Courses radio button for the first run. Otherwise, select
the Normal Courses radio button.

When you’ve set up your Create Timetable options, click Pre-Check to
have Scheduler look for problems before actually building the timetable.
The Pre-Check function performs the following tasks:

e Removes students from unlocked classes and clears those classes from
the school timetable.

e Determines teachers available for courses.
e Examines classes.

This process can take some time, depending on the number and size of
classes that must be cleared.
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A report tells you what problems are preventing a class from being
scheduled. Using the report, edit the applicable data, then do the first
scheduling run.

Again, from the Schedule menu, choose Create Timetable, but this time,
click Schedule.

If you are resuming a scheduling run after a Scheduler pause, click Resume.

To keep classes scheduled, lock classes after each scheduling run,
otherwise Scheduler will re-schedule the unlocked classes.

Subsequent Scheduling Runs

You will have to perform more than 1 scheduling run if you have Linked
and Special Courses. Schedule those courses first, then schedule Normal
Courses. Follow the pattern of setting the Allowable Potential Conflicts low
and increasing it with each run.

Do not select Continue when creating the school timetable. Use Continue
only for preliminary runs, to identify problems with room preferences.

Inspect your timetable occasionally to be sure it is shaping up to your
satisfaction. If you want to reschedule classes, lock any class you want to
keep and re-schedule the remaining classes.

Final Scheduling Runs

When all your classes are scheduled, run Optimize to ensure you’ve
generated the best timetable possible. Optimize reviews each class and
checks for the best place in the timetable for it.

Optimizing only works on unlocked classes, so unlock any class that can be
rescheduled. When you are finished, lock all classes again.

Do not skip optimizing. It can make a big difference in results.

To optimize your timetable:
1 From the Schedule menu, choose Create Timetable.
2 Click Optimize.

Keep running Optimize until the report shows that no classes have been
changed, because with each change a new set of possibilities is created.

Finalizing Your School Timetable

At the end of the Create Timetable process, finalize your school timetable
by resolving scheduling conflicts and scheduling study halls.

Manually Resolving Conflicts

Review your school timetable. If you have any unscheduled classes,
manually schedule them using rooms or teachers you did not consider, or
schedule them into a different term. Genuine conflicts do exist.
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Scheduling Students

Edit your school timetable following the instructions in “Creating Your
School Timetable” on page 115. Display potential difficulties for each class
by first selecting the class in the School Timetable, then clicking the
Difficulties button.

Scheduling Study Halls

If your school schedules students with free periods into study halls,
schedule study halls after you’ve scheduled and locked all other classes.
Otherwise, your scheduling run will be longer with more classes to
schedule.

After you’ve locked all of your scheduled classes, select all students in the
Students view, select the study hall in the Courses view, then from the
Schedule menu, choose Assign Study. For more information on setting up
study halls, see “Setting Up Scheduler Data in Details” on page 59.

When you’ve created your school timetable, start scheduling students into
it.

Scheduling students requires a series of scheduling runs, and this section
provides some tips on how to approach the various runs.

Prioritizing How Students Are Scheduled

You can either schedule all students at once or schedule groups of students
in a specific order. For example, you can schedule students by grade, by
requested credits, or by program.

In Scheduler, sort students, then re-order them using the following
procedure. Some schools sort students by grade, select the students in the
graduating grade, and re-order those students randomly.

You can order students randomly for the first scheduling run to obtain a
more balanced mix of students in each class. For later scheduling runs,
remove that sort order and use others.

To sort and select students:

1 In the Students view, choose Sort from the Edit menu.

2 Select your sort options. Select Random Order for the first runs to
balance the scheduling.

Close the Sort Order dialog and click Yes to perform the sort.

4 In the Students view, select all or some students with the Shift or
Control key.

Assigning Students

After deciding your scheduling order, start scheduling students using
Assign Students from the Schedule menu. Assign Students only works after
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students have course requests, sections have been set, teachers have been
loaded, and the timetable created.

The next 3 sections provide some tips for using the Assign Students dialog.

Assign Students m
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Setting Class Overfill

When scheduling students, you can allow a class to be over-scheduled by
setting class overfilling. For example, if you set a class maximum size of 30
students, then set the Class Overfilling at 10%, up to 33 students can be
scheduled. Overfilling can reduce potential conflicts. However, take teacher
contracts into account when setting this amount.

Scheduling Selected Courses

If you are scheduling specific courses, first select those courses in the
Courses view, then check “Use selected courses only.”

With this option, you can set priorities for course filling. For example,
schedule a student into required courses first, then schedule electives.

Using Alternates or Backtracking
Select either Use Alternates or Use Backtracking, not both.

When you select Use Backtracking, Scheduler examines possibilities for
each student by looking at more than 1 section of a course. Scheduler
spends 90 seconds on each student, looking at the available options based
on student course requests. When you use backtracking, you increase the
length of your scheduling run, but you get better student timetables.

When you select Use Alternates, Scheduler examines each student’s
alternate course requests.

128 Setting Up the Next School Year e Scheduling Automatically



Win School System Administrator

For the first scheduling run, don’t select Use Backtracking or Use
Alternatives and see what happens. Then, try a couple of scheduling runs
with Use Backtracking selected. Lastly, if students make alternative course
requests, select Use Alternatives.

Finalizing Student Timetables

At the end of the Assign Student process, finalize student timetables by
performing the following tasks:

e manually Resolving Scheduling Conflicts
e assigning Study Hall

e performing Resource Mapping

Manually Resolving Scheduling Conflicts

After you have created student timetables, you might need to manually
schedule students not scheduled into specific classes. Schedule them into
either a section taught in another term or a section taught during a different
period.

Assigning Study Hall

If your school assigns study halls to all students with free periods, first
resolve student conflicts manually. Select all students in the Students view,
select the study hall in the Courses view, then from the Schedule menu,
choose Assign Study.

Performing Resource Mapping

Resource Mapping works by expanding your room and teacher resources
creating cloned rooms and teachers to schedule classes that meet in the
same room at the same time, but have separate teachers, or when 1 teacher
needs to teach 2 classes that meet at the same time in different rooms.

If your school uses Scheduler’s Resource Mapping function, turn it on after
scheduling students and before printing timetables.

Resource Mapping is in Preferences from the Edit menu.

Scheduling More Than 1 Teacher and/or Class in 1 Room

Scheduler maps resources by matching 1 period with 1 or more teachers in
1 room. One teacher cannot teach 2 classes at a time, and 2 teachers cannot
teach in the same room at the same time.

First plan Resource Mapping, then set up the rooms and teachers in School
Setup and Details.

Do not select Use Resource Mapping while editing your school timetable,
because you need to see the real teacher and room names.
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The Use Resource Mapping preference determines whether Scheduler
windows display clone names or the real room and teacher names. In
general, this preference should be deselected.

The Use Resource Mapping print option determines whether real or clone
names appear in reports.

Don’t use Resource Mapping if you need to schedule more than 1 class that
can be taught by 1 teacher in 1 room at the same time. Instead, create a
combination class using Class Combining.

For example, for Ms. Chan to teach English 10 and English 11 at the same
time in Room 100, create an additional teacher, Ms. Chan A and an
additional room, Room 100A, then schedule Ms. Chan for English 10 in
Room 100 and Ms. Chan A for English 11 in Room 110A. Direct Scheduler
to print Ms. Chan instead of Ms. Chan A, and Room 100 instead of Room
100A.

Planning Resource Mapping

Fill in the following table for each group of classes with overlapping
resources. Fill in the class, the actual teacher and the actual room first, then
fill in a different scheduled teacher and scheduled room in each row. Make
1 the real teacher and room and the rest clones.

Class Actual Teacher Scheduled Actual Room Scheduled Room
Teacher
Examples of Plans
Three classes taught in the same room by the same teacher:
Class Actual Teacher Scheduled Actual Room Scheduled Room
Teacher
Latin 10 (1) Mrs. Jon Mrs. Jon Room 101 Room 101
Latin 11 (1) Mrs. Jon Mrs. Jon A Room 101 Room 101A
Latin 12 (1) Mrs. Jon Mrs. Jon B Room 101 Room 101B

Two classes taught in the same room by different teachers:

Class Actual Teacher Scheduled Actual Room Scheduled Room
Teacher

Boy’s P.E. Mr. Ets Mr. Ets Gym Gym

Girl’s P.E. Ms. Haro Ms. Haro Gym Gym A
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Ending the School Year

Overview

At the end of the school year, you need to finalize student marks towards
retiring the current year’s database and set up the database for the coming
year.

Wrap up the school year by performing the following tasks:
U  Generating final report cards to distribute or mail.

O Calculating final Class Rank and Honor Roll in order to set students’
Promotion Status, which indicates whether they passed or failed the
school year.

U Update the students’ Historical files to include the final calculations
from the current school year.

U Run Year End procedures to update your next year’s database, then
retire the current year’s database.

U Create Archive files for the graduating students by deleting them from
next year’s database.

Calculating Final Class Rank and Honor Roll

Although you can calculate Class Rank and Honor Roll at the end of each
term, calculating the Class Rank at the end of the year sets students’
Promotion Status for that year, which determines whether a student has
passed or failed the school year. Use the procedures described in
“Generating Class Rank and Honor Roll” on page 97 to calculate this
information.

Once you have calculated the Promotion Status for the students in your
school, you can graduate the students who are leaving your school.
Promoted students stay in your school, but advance to the next grade, where
graduating students have completed their studies and are leaving.

When you calculate students’ Promotion Status and Graduation Status, you
need to write down the students who were retained or who did not graduate
because you will have to adjust those students in next year’s database.

Changing Promotion Status

Often, after you generate student Promotion Status, teachers or counselors
review this information to make judgment calls on border-line students.
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To change Promotion Status:
1 In Report Cards, click the Students icon.
2 In the fifth column, use the VCR buttons to display Promotion Status.

You might want to sort students based on Class Rank, so you can see
where the “borderline” is between Promoted and Retained students.

3 Highlight the first student whose Promotion Status you want to change.
4 From the Promotion Status popup, choose the option to assign.

Hold down the Shift or Control key to change the promotion status of
more than 1 student.

5 Repeat for every student whose Promotion Status you are changing.

When you have calculated the Promotion Status, graduate the students who
are leaving your school.
To graduate students:

1 In Report Cards, sort students by Grade, then by Class Rank to group
the promoted students in the last grade taught at your school.

2 Select the graduating students.

Shift-click the first promoted student in that grade to select all the
students in that grade, then Shift-click the first retained student.

From the Edit menu, choose Graduated Status.
4 From the popup menu, choose Graduate Selected Students.
5 Click OK.

The selected students are assigned Graduated for their Graduated
Status.

6  Write down the names of students who are not graduating so you do
not create Archive Files for them. For more information on archiving,
see “Creating Archive Files” on page 134.

Generating Final Report Cards

Generate your final report cards the same way you generate report cards at
the end of each term, as described in “Printing Report Cards” on page 98.
At the end of the school year, indicate whether a student passed or failed
the year.

You might have a different template for final report cards, to include
Promotion or Graduation Status. For more information about creating report
card templates, see “Designing Report Manager Templates™ on page 74.

132 Ending the School Year ¢ Generating Final Report Cards



Win School System Administrator

Updating Historical Files
Historical files contain the following items for students currently attending
your school:
e reported bin marks
e credits
e averages
e class rank and honor roll standings
e attendance totals

Historical files are for final information only, not mid-term information,
unless you specify differently.

Archive files contain information for graduated students, as well as
demographic information from Details.

By maintaining Historical and Archive files, you can calculate cumulative
GPAs and earned credits, and print transcripts. In both these files, you store
all attendance information and up to twelve bins of Report Cards data.

You must use Historical Bins for the same information each year for a
student. For example, if a Final Mark for a student is stored in Bin 11, that
Final Mark must always be in Bin 11. Otherwise, you will not be able to
accurately calculate cumulative marks.

All edits made before updating the Historical file will be deleted by
updating, so only edit bins after updating Historical files.
To update the Historical file:

1 In School Setup, choose Report Card Bins from the Report Cards
menu.

2 Ensure the “Bin In Use” column is “Yes” for all the bins you want to
copy, and make sure the bins you are copying are among the first
twelve bins. If they are not, re-arrange them.

3 Start Report Cards.

4 If you want to update specific students’ Historical files, select those
students. If you are updating all students’ Historical files, don’t select
any students

5 From the Edit menu, choose Bins to View/Edit.

6  Select the bins containing the information you want copied to the
Historical file.

7 Click OK.

8 From the Historical menu, choose Update Historical File.
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9 In the Update Historical File dialog, choose the bins you want copied to
the Historical file.

10 If you are only updating the Historical files for selected students, select
the “Selected Students Only” checkbox.

11 Click OK. The Historical files are updated.

Creating Archive Files

If your school does not keep Archive files, you can skip this section.

When you create an Archive file, demographic information from Details
and all of the Historical files for graduating students and students who have
left your school are all moved from your database into an Archive file. You
name and store Archive files in a directory either on your network or on
your hard drive.

Archive files do not include conduct information or detailed attendance
information. If you keep permanent records of this information, don’t delete
the student until you have performed Year End and retired your entire Win
School database.

Deleted students, even if they have Archive files, are not counted in
statistical reports for your school. To include the student in reports, delete
the student only after printing the reports.

Preparing to Create an Archive file

The Archive process is performed automatically when you delete selected
students from Details. When you have finalized marks and updated your
Historical file, create Archive files for students leaving your school.

As described in “Naming and Storing Archive Files” on page 61, you must
have established a naming convention and storage location for all Archive
files. We recommend you create a new Archive file each school year.

To prepare to create an archive file:

1 In Scheduler, delete all requests and timetables for every student you
want to delete and archive. See “Deleting Scheduler’s Timetables and
Requests” on page 105.

2 Make sure no Win School users are viewing student information for a
student you want to delete. Use the Administrator Log from the Shell
menu in Win School Shell to get this information.

Be certain the student has left your school. When you've created an Archive file
for a student, you cannot access their Historical information because it has been
irreversibly removed from the Historical file.
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Creating an Archive File

Before creating an archive file:
1 Complete the year-end processing.

2 Complete preparations for archiving Win School data for the current
year.

To create an archive file:

1 Back up your data.

Start Details.

Select all the graduated students and any students leaving the school.

From the File menu, choose Delete > Selected.
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A message asks if you wish to place deleted students in an Archive file.

If a dialog appears informing you some students cannot be deleted
because they have other references, click OK. Students with references
in Scheduler will not be deleted and will remain selected so you can
identify them.

Delete selected students’ timetables and requests from Scheduler before
you try creating the Archive file again.

6 Click 1 of the following options:

Yes Delete students and archive their historical and
demographic information.

No Delete students without archiving any information.
Cancel Do not delete the students.

7  In the Directory dialog that appears, enter the name of your Archive
file and where you want to store it.

8 Click OK. Your Archive file is saved.

Performing the Year End Process

After creating Archive files for graduating students, perform Year End
processing to update the next year database and make it the current year
data folder.

Year End processing involves all of the following procedures:
(J  Finalizing the current year’s database.

You must make sure specific tasks have been completed in Report
Cards using the current year’s database.
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J Extract data from the current year database and merge with next year.

Any information you’ve changed or added to the current year database
needs to be extracted so it can be merged with the next year database.

d Merging the current database into next year’s database.

When you’ve extracted the new or modified data from the current
year’s database, you need to merge it into next year’s database.

J Modifying next year’s data.

If any problems appear on the Current/Next Year Merge report, go
through the report, adjust your next year data, and regenerate the report
until there are no problems.

(d Retiring last year’s data.
Remove the old folder from your hard drive or network.
(1  Setting up the current year’s database.

When you’ve retired last year’s data, you must make your next year’s
database the database for the current year, which is accessed by the
Win School Shell.

Extracting Data from the Current Year and Merging with Next Year

You need to extract all data which has been added or modified since you
ran Next Year Prep. Using this procedure, your next year data folder is
updated with this data.

The files created require a significant amount of disk space. Their actual
size depends on the amount of information in your school’s Win School
database. A good rule is to count on double the disk drive space currently
used by your next year’s and current year’s data directories, then ensure the
disk storing your Temporary directory has that much free space for the files
that will be created.

To extract data from the current year’s database:

1 Start Win School using the current year data.

2 Start Utilities.

3 From the Utilities menu, choose Current Year End.

4

In the confirmation dialog, click Yes.

Status bars appear as Current Year End extracts data and creates
transaction files.

5  Quit the Win School Shell.

You are now ready to update next year’s database by merging these files
into the database as described in the next section.

You must merge this data using the same computer you used to extract data
from the current year’s database.
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To merge the current year database into next year data:

1
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Back up next year’s database.

This is a critical step, as you will need a backup copy of this data in
case there are any problems with student or teacher information during
the merge.

Start the Win School Next Year Shell in single-user mode.
Start Utilities.

From the Utilities menu, choose Current/Next Year Merge.
In the confirmation dialog, click Yes.

The Current/Next Year Merge report appears as your data is merged.
To print this report, choose Print from the System menu.

Reading the Current/Next Year Merge Report

This report is generated when you run Current/Next Year Merge, and
displays problems. Check it to be sure your current year data is successfully
copied to your next year database.

The names of School Setup and Details record types appear as headings in
the report as Utilities merges the information. If you see 1 of the following
2 messages for a record, correct it in the backup of the next year database
that you created before running Current/Next Year Merge. See “Changing
Information in the Next Year Database” on page 138.

For student and teacher information: “No match in the next year database
was found for Number X and Name Y.”

These are the reasons for the message:

A student or teacher record exists in the current year database, but not
in the next year database.

Start Win School using the next year database and add the record to
Details, or use ASCII Transfer to copy the data to the next year
database. You don’t need to do this if the student or teacher will not be
in your school next year.

You changed a name or number in 1 database after running Next Year
Prep, without changing it in the other database.

Change the listed name or number in the next year database to make it
match the current year data.

You assigned a number in the next year database that belongs to a
different person in the current year database.

Change the number in the next year database.
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For School Setup information: “No match in the next year database was
found for X. Creating new record.”

This message appears in the Current/Next Year Merge Report if you added
a School Setup item to the current year database but not the next year
database, after performing Next Year Prep.

If you don’t want this item to be in the next year database, delete it from the
next year database after you have run Current/Next Year Merge for the last
time.

Changing Information in the Historical Database
You can clear “Use in GPA” and “Is Final Mark” for students who have no
marks in any year in the historical file.
To clear historical Use in GPA and Is Final Mark:
1  Start Utilities.

2 In the Students view, select students that you want to clear Use in GPA
and Is Final Mark.

3 From the Utilities menu, choose “Clear Historical Use in GPA and Is
Final Mark for classes with no marks.”

Changing Information in the Next Year Database

To correct the problems listed in the Current/Next Year Merge report, you
must correct the information in the next year database, then perform
Current/Next Year Merge again.

To change information in the next year database:

1 Shut down the Win School Shell.

2 Restore the backup of next year’s data you made immediately before
running the Current Next Year Merge.

3 Start the Next Year Shell, which should reference the data you restored
in step 2.

4  Start Details and/or School Setup. Add or change records described in
“Reading the Current/Next Year Merge Report” on page 137.

Shut down the Win School Shell.
Back up your next year database.

Start the Next Year Shell.
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Run the Current/Next Year Merge again. Follow the instructions in
“Extracting Data from the Current Year and Merging with Next Year”
on page 136.
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Modifying Next Year’s Data

If no problems appear on the Current/Next Year Merge report, you can
proceed to “Modifying Next Year’s Data” on page 139.

OR

Repeat steps 1 through 8 of these instructions until no problems appear
on the Current/Next Year Merge report. Proceed to “Modifying Next
Year’s Data” on page 139.

All your data is copied into next year’s data directory. All Win School tasks
should occur in the next year directory. First, you need to ensure certain
students are in the proper grade, as shown in the following table:

For these students Do this

Students assigned to grade N/A either | Ensure they are assigned to the proper
last year or next year. grade in next year’s data.

Students advanced to the next grade |Change their grades.
in next year’s data who were not
actually promoted to the next grade.

Retiring the Last Year Database

When you have performed Year End processing, all your school’s
activities should be carried out in the new data directory, and the old
directory should be removed from the hard drive.

Make 2 backups of your old data directory, and store them in different
places.

Remove the transaction files created during the Year End process.

To retire last year’s database:

1

Shut down Win School and delete all the files from the winschl
Temporary folder. For more information see “Changing Your Win
School INI File” on page 41.

After you have retired the current year data, change the Next Year Data
to become your current year. See “Working with More than One Data
Directory” on page 108.
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You can store your Archive files by merging them into 1 large file.

Create a policy for grouping merged files. For example, you might want to
keep the last 2 years of files separate, and merge Archive files in groups of
5 years. If there is an Archive file which you seldom use, consider storing it
on tape or another medium, to free up space on your hard drive or server.

Regardless of how you store your Archive files, always have a backup
copy.

To merge Archive files:

1 Start Report Cards.

2 From the Historical menu, choose Load Archive File.

3 Highlight the first Archive file you want to merge, then click OK. The
Archive Information window opens.

4 Shift-click the checkbox to select all students.

From the Archive Information window’s File menu, choose Copy
Selected Students.

6 In the Directory dialog, either highlight the Archive file into which you
want to merge the selected Archive files or type the name you want to
assign to the merged Archive files.

7 Click OK.

8 Repeat steps 2 through 7 for each Archive file you want to include in
the merge.

In the new current-year database, change the grade for students who are:
e assigned a grade N/A
e promoted but should not have been

Depending on how much of the coming school year you’ve scheduled,
make appropriate changes in Scheduler or Report Cards for retained
students.
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Managing Year Round Schools

Overview
If you are the System Administrator at a year-round school, use this section
for the following tasks:
e Setting up tracks
e Scheduling students into tracks
e Viewing attendance for off-track students

e Entering attendance for off-track students (inter-session attendance)

Use tracks only if you are using Scheduler.

To schedule your school for year-round classes, define tracks in School
Setup, then in Details, assign students, teachers, and courses to tracks.

Each track is in session for a different set of terms during the year. In any
term, 1 or more tracks can be on vacation or off-track.

After you have scheduled your school, use Attendance and Query to
determine whether students are in school or off-track.

Setting Up Tracks

In School Setup, enter all the tracks at your school, then correlate each track
with the terms it is off-track. You can create up to 6 tracks.

The table below displays the schedule for a year-round school with twelve
scheduled terms where students, teachers, or courses are off-track every
fourth month.

Sep | Oct | Nov | Dec | Jan | Feb | Mar | Apr | May | Jun | Jul | Aug
Trackl Term— 1 2 3 4 5 6 7 8 9 10 | 11 12
Red Off Off Off
Blue Off Off Off
Green Off Off Off
Orange Off Off Off
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To create tracks:

1 In School Setup, click School, then double-click Year Round School.
2 Select Yes, then click OK.

3 Double-click Year Round Tracks.

4

In the Description field, type the names of all the tracks at your school
(for example, Red, Blue, Green, Orange).

5 Click OK.

Setting Up Your Daily Calendar
After setting up tracks, set up the Daily Calendar for each track.

To set up the Daily Calendar:
1 In School Setup, click Attendance, then double-click Daily Calendar.
2 Assign Holiday day type to all school-wide holidays.

3 To assign Relative days, highlight the first day of the school year, click
1, then click Auto in the Assign Relative Day section.

4 From the Track popup menu, select the first track, then click “Copy
School Calendar.” Repeat this step for each track you need.

5 Click OK.

Assigning Tracks

If your school uses tracks, set up school tracks in School Setup, then use Details
to assign students, teachers, and courses to tracks. If you are using Scheduler,
decide which of 2 scheduling methods you are going to use. If you are uncertain
which method to use, call Chancery Technical Support.

Create either 12 terms, 1 term for each month as shown in the table below, or
create a single term for the entire year so tracks are not bound by specific

dates.
Sep | Oct | Nov | Dec | Jan | Feb | Mar | Apr | May | Jun | Jul | Aug
Trackl Term— 1 2 3 4 5 6 7 8 9 10 | 11 12
Red Off Off Off
Blue Off Off Off
Green Off Off Off
Orange Off Off Off
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Assigning Students to Tracks
In Details, assign students to tracks and homerooms.

At your school, if homeroom numbers change while the teacher and group
of students for each homeroom remain constant, either leave students with
the same homeroom and use the teacher name to identify homeroom
classes, or update student homeroom numbers as they change.

One way to monitor a student is to use a numbering system. For instance,
assign student numbers so the first digit is the student track assignment.

To schedule students and homerooms to tracks:
1  In Details, double-click a student name.
2 In the Personal tab, assign a homeroom number.

3 In the Groups tab, assign a track. (Try to keep siblings in the same
track.)

4 Repeat Steps 1 through 3 for all students you want to schedule.
Click Done.

Assigning Teachers and Courses to Tracks

Before scheduling teachers and courses into tracks, you might need to edit
existing teacher and course names and numbers. For example, you might
need to add an extra number to the teacher and course numbers to identify
different tracks. This edit allows you to easily identify each teacher and
course track assignment.
To assign tracks to teachers:
1 In Details, double-click a teacher name.

In the Personal tab, select the correct track.

2
3 Repeat Steps 1 and 2 for each teacher.
4

Click Done to save your changes.

To assign tracks to courses:

1 In Details, double-click a course name.

2 In the General tab, select the correct track.
3 Repeat Steps 1 and 2 for each course.

4  Click Done.
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Scheduling Year Round Schools

Scheduling a year round school is not much different from scheduling any
other school. For more information on scheduling, see “Scheduling Your
School” on page 113.

In School Setup, click the School menu, then double-click Transfer
Recording to turn it on. Do this at the beginning of the year.

To schedule a year-round school, set up the following:

e In Course Details, Scheduler tab, set up “Course can be taught in”
information so courses are only taught when their tracks meet.

e In Teacher Details, Scheduler tab, set up teacher course preferences so
teachers are loaded for courses in the correct track.

e In the Student Request window in Scheduler, monitor student course
requests, so students only request courses in the correct track.

e In the Create Timetable dialog in Scheduler, select “Use 2 or more
rooms if necessary.”

If a teacher does not teach all sections of a class, either manually schedule
that class or schedule that class with 1 teacher, then change the teacher
using “Rescheduling or Replacing Teachers” on page 90.

Viewing Attendance for Off-Track Students

In Attendance, off-track student names are not displayed in student lists.
Therefore, throughout the school year, some homerooms will not display
any students.

To view attendance for off-track students:

1 In Attendance, double-click a day in the Calendar window on which
the student is on-track.

2 Double-click the student name.

The Worksheet window for that student appears, listing attendance,
including off-track codes.

Entering Attendance for Off-Track Students

Depending on your school policy, students might have to remain in school
to make up a few days when their track is on holidays.

To record attendance for a student whose track is off-track, you must
temporarily assign that student to an active track for those make-up days,
then return the student to the original track.
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Another approach is to create a special homeroom or track with no off-
track days in which you place all students attending classes when their track
is finished. To record daily attendance for these students, change their
tracks or homerooms for those extra days, then change them back to their
regularly scheduled track.

Read the following procedure completely before using it as you have to
move in and out of the various student records and functions.

To record attendance for extra days:

1

10

11

In School Setup, from the School menu, ensure that Transfer Recording
is turned on. It should be turned on and left on at the beginning of the
year.

In Details, double-click a student name.

In the Groups tab, change the student’s track to either N/A or 1 of the
active tracks.

In the Personal tab, change the homeroom.
Click Done.

In the Current Student Transfer Date dialog that appears, enter the first
day you want to record extra attendance days for the student. This is
usually the first day that the regularly-assigned track starts holidays.

Click Done.

Open the student record again and put the student back into the regular
track and homeroom.

Click Done. The Current Student Transfer Date dialog re-appears.

Enter the first day after the student has fulfilled make-up days. This day
will also be the first day that the student will be on holidays, like the
other students in the regularly assigned track.

Click Done. You can enter attendance for that student for those extra
days.
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Troubleshooting Win School

Overview

As System Administrator, you are responsible for the daily maintenance of
Win School.

This chapter describes some common problems and their solutions. For
more information, refer to other Win School guides and Win School online
help. If you are unable to find the solution to a problem, contact Chancery
Technical Support.

Identifying Specific Win School Information

The Technical Support report, which you print from the Shell menu in Win
School Shell, lists the location and contents of the Win School and
Windows files listed in the table below. Each file is listed on a separate
page of the report.

If any problems arise with Win School, you can generate this report to
check your Win School environment.

For more information, see “Technical Support” on page 32.

Troubleshooting Next Year Prep

Spaces or long filenames for next year data in Windows 95

Win School follows DOS naming conventions. Win School requires folder
names no longer than 8 characters with an optional 3 character extension.

Moving Next Year data to the network so more can access it

Both Novell and Windows NT servers require user names and access rights
to the data folder on the server when running Win School single user. After
you have set up these user names and access rights, copy the data folder
from C drive to this shared folder on the server. At each workstation either
change the data= statement in the C:\Windows\winschl.ini file to point to
this folder, or change the properties in the Win School Next Year data icon
to include the data path to the shared directory. For example:
f:\winschl\data9900.
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Renaming CSL Win School Next Year Data icon

It is a good idea to give your Win School shell icon a name representative
of the data it will launch. For example Win School Data 99_00 Single-User.

Changes in next year database appear in current year database

You have probably pointed your next year icon to launch the current year
data files or vice versa. Look at the properties of your next year shell icon.
The Target line should look something like this:
c:\winschl\modules\cslshell.exe 0 c:\winschl\data0001

where “c:\winschl\data0001” represents your next year data path.

Depending on your installation you might see a drive letter other than C: on
the icon Target line.

If you are running Current Year data as Single-User, your icon properties
should point to this year’s files. For example, The Target line in the icon
properties should look like this: c:\winschl\modules\cslshell.exe 0
c:\winschI\data9900

If you haven’t specified a data path in your icon properties, it is finding the
data path through the Winschl.ini file: c:\winschl\modules\cslshell.exe 0

If you are running Current Year data as Multi-User, your icon properties
should look like this: c:\winschl\modules\cslshell.exe 1

The “1” in the Target line tells Win School to look for Multi-User Win
School on the server. Multi-User Win School icon properties cannot point
to a specific data path as the Single-User icon can.

Cannot access database on a different server

This is usually an incorrect IP address and port number. Check that the
database server is running and that the IP address and port is correct. See
“Starting, Stopping, and Quitting the NT Server” on pages 12 and 18, and
“Noting TCP/IP Configuration” on page 10, respectively.

Check that both the server and workstation are installed and set up
correctly. Check the server logs for any errors.

Troubleshooting Win School e Troubleshooting Next Year Prep 147



Win School System Administrator

Solving Problems in Win School

Can’t see a module for which you have View or Edit access
The file storing your preferences might be damaged.

Use the Clear Module Preferences command to clear the preferences file
and return settings to their defaults.

To clear module preferences, see “Clearing Module Preferences” on page
35.

Message “Bad command or filename” when installing Win School

Your system might not be viewing the root level of your CD drive. In DOS,
go to your CD drive and type cd\ then press Enter.

Message “General Protection Fault” when starting modules

If the General Protection Fault (GPF) is in a Win School file such as
csltools.dll, rcards.exe, use the Clear Module Preferences option in the File
menu on the Win School Shell to clear module preferences and try again.

Message “The file you are trying to open is in use by another
program. Quit the program and try again.”

If virus detection software is active, it might be checking every program on
your system. Close the virus detection software and try again.

Message “Unable to register with Messages Database”
Reinstall the Win School Server.

Starting Win School is really slow

See if McAfee anti-virus software is running on the workstation. Some
configurations of this software use a lot of system resources, slowing
system performance. This might cause other software applications to run
more slowly. If McAfee is running, try disabling it to see if Win School
starts faster.

What to look for:
e Very slow start of multi-user mode.
e Very slow start of single-user mode on C drive.

e Others on the network are starting much faster (30 seconds instead of
12 minutes).
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e The launch was much faster before installation of McAfee.

e If McAfee is already on the machine, it might have been reconfigured.

Viewing the Version of Win School without starting Win School

1  In Windows 95, double-click the My Computer icon and open the
Winschl\Modules folder.

2 Right-click details.exe and choose Properties.

3 Click the Version tab and see the version number next to File version.

Win School reports don’t print properly

Win School uses Window’s Print Manager to print reports. Therefore, if
Win School reports are not printing correctly, try changing the printer
driver you are using, for example, try changing an HP4 or HPS printer
driver to the HP II Series driver.

If your report looks fine onscreen but has problems printing, then it is likely
a printer driver issue. Win School uses Print Manager to control its print
jobs because some jobs can get quite large. By sending the print job to Print
Manager, system control returns to the user much faster, allowing you to
continue working in Win School instead of having to wait for the print job
to finish.
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Index

A

Access Level, 6, 33, 47, 58, 59, 68, 70, 83, 84,

91
defined, 45
setting, 7, 44

Accessing, next year’s data, 29, 101, 104, 105,

108, 146

Administrator. See System Administrator
Allowable Potential Conflicts, 124, 126, 128

Archive files, 133

creating, 134

merging, 140

naming and storing, 61
viewing, 90, 91

Assigning

attendance code, 39, 65
homerooms, 70, 71, 89
incomplete marks, 93

IP address, 23

requested courses, 59, 118
required courses, 59, 118, 122
Status Codes, 70, 72

student requests, 118
students, 39, 40, 116, 127, 139
study halls, 40, 127, 129

teacher’s classes, 60, 90

Attendance

clerks, 5

codes, 37, 56, 57, 63, 65

daily attendance, 37, 39, 48
entering, 37, 39

entering into Report Cards, 97

entering off-track attendance, 144

intersession, 141, 144
period attendance, 37, 39, 48
setting up, 56, 63

statistics, 49
twice daily, 39

viewing off-track attendance, 144

Automatic scheduling

assigning requested courses, 118

assigning required courses, 59, 118

Backtracking, 128

Class Combining, 122

Load Teachers, 120
Lookahead, 125

Pre-Check, 125

prioritizing students, 127
scrambling periods, 121
setting Class Overfilling, 128
study halls, 119, 127

Teams and Clusters, 122

Backing up and maintaining
NT, 22
Backtracking, 128

Backup, 13, 15, 28, 29, 38, 62, 87, 101, 102,

135, 137, 138, 139, 140
policy, 40, 41

Bin Marks, 94

Bins, 55
bin information, 88
Consolidating Bin Marks, 94
in District Extract files, 88
In Use, 88, 133
Missing Bin Marks, 63, 81, 96
names, 61

Block, 51, 52

C
Class Combining, 121, 122, 130
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Class Rank
establishing criteria, 34, 60, 61
for Promotion Status, 131
generating, 97
Class rosters
deleting in Report Cards, 106
generating, 83
history, 49
printing, 73
rebuilding, 82
writing in Report Cards, 39
Classes
assigning to teacher, 90
editing student timetables, 82
manually scheduling, 126
Clear/Set Bin Information, 7, 88, 89
Comment files, 61
Conduct Codes, clearing, 71
Consolidating Bin Marks, 94
Contacting Technical Support, 4
Counselors, Win School responsibilities, 6
Course requests
deleting, 85
Courses
assigning required, 59, 118, 122
assigning tracks, 143
deleting duplicated requests, 119
setting up sections, 114
teacher course load, 54
Creating
Archive files, 134
Bin files, 67
Marks files, 83
Current Users report, 33
Current/Next Year Merge
fixing problems, 138
Custom templates, 78

Failure List report, 80
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mailing labels, 78

marks verification report, 81

D

Daily attendance, 39, 63

Data
accessing next year’s, 108
editing next year's data, 139
fixing problems in next year's, 138
globally changing, 89
more than one data directory, 108
preparing for next year, 29, 101
setting up next year’ s, 109
standardizing, 47
viewing student data, 90
viewing teacher data, 90
Year End, 135

Databases, switching, 26

Day, 51

Day cycle
changing Relative days, 87

Deleting
classes in Report Cards, 106
course requests, 85
duplicate course requests, 119
empty classes, 74
students, 89

Details
changing next year's data, 112
running multi-user, 7
Select/Replace/Assign, 89
User-Defined information, 58

District Extract, 88

E
Earned Credit calculations, 95
Earned Credits, 95
Edit Classes, 39

deleting class rosters, 106
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Editing

next year's data, 139

student timetables, 82

teachers on School Timetable, 90
Electives, assigning, 118
Electronic mail

for comments to Chancery, 4
Email

for Technical Support, 4
Empty classes

deleting, 74
Enrolling students, 72
Entering

attendance, 39

student requests, 118

Win School data, 38

F

Failure List report
creating template, 80
printing, 100
Fax for Technical Support, 4
Feedback for documentation, 4
Fields
User-Defined, 58
File sharing, 7
Fixed Day, 51
Flags, User-Defined, 58

Form letters, designing templates for, 78

G

Generating

Class Rank, 97

final report cards, 132

Honor Roll, 97
Grade level, advancing students’, 107
Graduated students, 132

printing transcripts, 92

viewing student data, 91

H
Hardware requirements
NT, 9, 11, 16, 17
Help

identifying Win School information, 32, 146

other Win School guides, 3
release notes, 4
Historical files
setting up bins, 55
updating, 133
Homerooms, assigning to students, 70
Honor Roll
establishing criteria, 34, 60, 61
generating, 97

I
Identifying Win School information, 146

Implementation strategies, 37
Importing data

Win School data, 38
Inactive classes, Preferences, 34
Incomplete marks, assigning, 93
INI file, editing, 26
Initialization (.INI) file, 41
Installing

creating a diskette, 25

NLM, 25

NT, 11, 17, 18
IP address, 10, 23, 103, 105, 147

assigning for NT, 16
IPX, 9, 10, 13, 23, 26

L

Labels
designing templates, 78
mailing labels, 78
Lookahead, 125
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designing templates, 78
printing, 99

Main window, NT status and configuration, 14,
21

Manually promoting students, 131
Manually scheduling, 114

rooms, 115

school timetable, 115

sections, 114

setting up, 114

student timetables, 116

teachers, 115

Marking schema, setting up Points and Credits
tables, 56

Marks

assigning incompletes, 93
Marks files, 62

creating and updating, 83
Marks module

setting up, 60

uploading marks, 93
Marks verification, 96
Marks verification, custom reports, 62
Merging

Archive files, 140
Multi-user, 7

N

Next Year Prep, 29, 31, 49, 70, 101, 111, 112,
146

advancing grade levels, 107
deleting classes, 106

deleting Scheduler information, 105
running, 101, 103

setting up, 102

working with more than one data directory,
108
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NLM
loading and unloading, 26
optimizing the server, 22

NT
configuring, 12, 19
optimizing the server, 9, 16
starting, stopping and quitting, 12, 19
status and configuration, 14, 21

Nurses, Win School responsibilities, 6

(0]
Off-track, 144

P

Passwords
changing, 33
setting up, 44
Period attendance, 39
codes, 63
Period to Daily Link, 63
Periods
scramblings, 121
setting up, 51
Phone number, Technical Support, 4
Points and Credits tables, 55
Policies, backup, 40, 41
Potential Credits, 96
Pre-Check, 125
Preferences
inactive classes, 34
setting up, 34
Principals, Win School responsibilities, 6
Printing
Attendance reports, 99
class rosters, 73
Current/Next Year Merge report, 137
Failure List report, 100
final report cards, 132

mailing labels, 99
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Marks Verification report, 96

report cards, 98

State/Prov reports, 99

timetables, 73

transcripts, 91
Promoting students

manually, 131

using Class Rank, 131
Promotion Status, 131
Protocols

adding, 9

verifying, 16, 23

Q

Query, 90

R

Relative Day
changing, 87

Relative Day, 51

Release notes, 4

Report Card Bins, 55
Consolidating Bin Marks, 94

Report Cards
changing next year's data, 112
Clear/Set Bin Information, 89
clerks, 5
Consolidating Bin Marks, 94
custom marks verification report, 81
deleting class rosters, 106
designing template for, 75
Edit Classes, 39
entering attendance, 97
generating final report cards, 132
generating report cards, 93
Marks Verification Report, 81, 96
printing report cards, 98
running multi-user, 7

setting up, 60

setting up in School Setup, 55
verifying marks, 96
Report Manager
report cards template, 75
setting up, 65
templates, 78
Reports
designing templates for, 78
failure list, 80
Requested courses
assigning, 118
deleting duplicates, 119
Required courses, assigning, 59, 118, 122
Requirements to install
NT, 9, 11, 16, 17
Resource mapping, 73, 111, 120, 129
Rooms
manually scheduling, 115, 126
setting up, 49
Running
Next Year Prep, 101, 103

S

SAP Agent, 9
Scheduler
Assign Students, 116
Backtracking, 128
changing next year's data, 112
Class Combining, 122
Class Overfilling, 128
deleting information, 105
editing student timetables, 82
Load Teachers, 120
Lookahead, 125
Pre-Check, 125
running multi-user, 7
running with other modules, 7
See also Automatic Scheduling, 113
See also Manually Scheduling, 113

Index e 155



Set Sections, 119
setting up in Details, 59
setting up in School Setup, 50
validating Timetables, 88
Scheduler blocks, 52
Scheduling
students to tracks, 143
teachers to tracks, 143
tracks, 142
School schedule, 114
School Setup
changing next year's data, 110
running with other modules, 7
setting up Report Cards, 55
setting up Scheduler, 50
standardizing data, 48
School Timetable
editing teachers, 90
manually scheduling, 115
Scrambling periods, 121
Sections
setting for automatic scheduling, 119
setting for manual scheduling, 114
Select/Replace/Assign, described, 89
Server patches for NetWare, 23
Set Scheduler Terms, 50
Set Sections, 119
Setting up
Access Level, 44
Attendance, 63
automatic scheduling, 118
Class Overfilling, 128
manual scheduling, 114
Marks, 60
Next Year Prep, 102
next year’ s data, 109
passwords, 44
periods, 51

Preferences, 34
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Report Card bins, 55
Report Cards, 60
Report Manager, 65
Scheduler, 50
sections for automatic scheduling, 119
sections for manual scheduling, 114
study halls, 119, 127
tracks, 141
Transfer Recording, 84
Win School users, 45
Sharing files, 7
Shell, accessing next year’s data, 104
Shell, accessing next year's data, 105
Single user, defined, 7
Smart Items, 77
Software requirements
NT, 9, 11, 16, 17

Solving problems in Win School. See
Troubleshooting

Standardizing data, 47
Status Codes
assigning, 72

Student requests, deleting in Scheduler, 105

Student timetables, 116
Students
advancing one grade, 107
assigning required courses, 59, 118, 122
assigning study halls, 129
assigning tracks, 143
deleting, 89
deleting duplicated requests, 119
editing timetables, 82
entering off-track attendance, 144
graduating, 132
manually scheduling, 116, 129
printing transcripts, 91
prioritizing scheduling order, 127
Promotion Status, 131

viewing Archive files, 91
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viewing off-track attendance., 144 intersession attendance, 144
Study halls scheduling, 142, 143

assigning, 129 scheduling students, 143

setting up, 119, 127 scheduling year, 143
System Administrator setting up, 141

defined, 6 Training, Win School users, 37

setting up in Win School, 44 Transcript files

See Archive files., 61
T Transcripts

TCP/IP, 10, 13, 22, 23, 24, 26 designing templates for, 77

setting up for NT, 12, 16, 17, 19 printing, 91

setting up workstations, 13, 20 Transfer Recording, 84
Teachers Troubleshooting

assigning tracks, 143 identifying information, 32, 146

course load, 54 Twice daily attendance, 39

editing on School Timetable, 90

loading in Scheduler, 120 U

manually scheduling, 115, 126 Updating

Win School responsibilities, 5 Historical files, 133
Teachers Marks file, 62 Marks files, 83
Teams and Clusters, 122 User Defined information, setting up, 58
Technical Support report, 32, 146 Users
Technical Support, contacting, 4 responsibilities, 5
Templates (Report Manager) setting up in Win School, 45

transcripts, 77 who is logged on, 33
Templates (Report Manager) Utilities, Year End, 136

failure list report, 80

marks verification report, 81 \"/

report card, 75 Verifying marks, 96

setting up, 65 Vice principals, Win School responsibilities, 6
Timetables

deleting Scheduler timetables, 105 w

printing, 73 Website for Chancery, 4

validating, 88 Who is logged on, 33
tracks Win School

assigning to courses, 143 implementing, 37

assigning to students, 143 INT file, 41

assigning to teachers, 143 multi-user. 7

creating, 141
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other sources of information, 2 NLM, 26

single user, 7 NT, 14, 22

standardizing data, 47 Win School System Administrator. See System

upgrades, 4 Administrator

version numbers, 4 Win School users, responsibilities, 5
Win School data

accessing next year’s, 108 Y

editing next year's, 139 Year End, 135

entering, 38 Year round schools

fixing problems in next year's, 138 assigning courses to tracks, 143

globally changing, 89 assigning students to tracks, 143

importing, 38 assigning teachers to tracks, 143

more than one directory, 108 entering off-track attendance, 144

preparing next year, 29, 101 setting up tracks, 141

setting up for next year, 109 Transfer Recording, 85

Year End, 135 viewing off-track attendance, 144

Win School data directory
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